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Laboratory organization

1. To minimize the potential for carry-over contamination, the laboratory is organized so
that the areas for DNA extraction, PCR set-up, and handling amplified DNA are
physically isolated from each other. Each of the three areasisin a separ@m.

2. Based on need, microcentrifuge tube racks have been placed in sa ndling areas.
These racks should only leave their designated area to transport a\e to the next
designated area. Immediately after transporting samples, the r T@@ ould be cleaned and
returned to their designated area. ®

3. Dedicated equipment such as pipetters should not leave th&esignated areas. Only the
samples in designated racks should move between areQ.

4. Analysts in each work area must wear@priat sNSOnaI protective equipment (PPE).
Contamination preventive equipment ) m@ worn where available. All PPE and
CPE shall be donned in the bio-vestibdles. 6

Required PPE and CPE for e%ﬁhbor@ are posted conspicuously in each bio-

vestibule. v C)

Work Place Preparation <>\

1. Apply 10% bleach followe ater and/or 70% Ethanol to the entire work surface, cap
opener, pipettes, andg@ ter keyboard/mouse (when appropriate).

2. Obtain clean racks)Qg cap openers, and irradiated microcentrifuge tubes, and irradiated
water from stor rrange work place to minimize crossover.

3. Position g nearby with 10% Bleach/70% Ethanol/water in order to facilitate frequent
glove c s and cleaning of equipment.

Microce@uge tube and pipette handling

1. Microcentrifuge tubes, Microcon collection tubes, Dolphin tubes, and M48 tubes must be
irradiated prior to use.

2. Avoid splashes and aerosols. Centrifuge all liquid to the bottom of a closed
microcentrifuge tube before opening it.
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Sample handling

1.

Avoid touching the inside surface of the tube caps with pipetters, gloves, or lab coat
sleeves.

Use the correct pipetter for the volume to be pipetted. For pipetters with a maximum

volume of 20pL or over, the range begins at 10% of its maximum volume (i®e.] a 100uL
pipette can be used for volumes of 10-100uL). For pipetters with a maxi olume of
10pL or under, the range begins at 5% of its maximum volume (i.e., pipette can
be used for volumes of 0.5-10uL).

Filter pipette tips must be used when pipetting DNA and they é@d be used, whenever
possible, for other reagents. Use the appropriate size filter r the different pipetters;
the tip of the pipette should never touch the filter.

Always change pipette tips between hangg each @e.
a

Never “blow out” the last bit of sampl;%m pX . Blowing out increases the
potential for aerosols, this may co ’l\ inate Q ple with DNA from other samples. The
accuracy of liquid volume deIivet’% not critical enough to justify blowing out.

Discard pipette tips if they %ent@glch the bench paper or any other surface.

Wipe the outside of the pipette @\10% bleach solution followed by a 70% ethanol
solution if the barrel goes ins'@s tube.

OOQ

the amplified work area. Samples that have been amplified should never come in
contact wit ipment in the unamplified work area.

O

QO

Samples that hg@not yet been amplified should never come in contact with equipment in
p
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The DNA extraction and PCR setup of evidence samples should be performed at a
separate time from the DNA extraction and PCR setup of exemplars. This precaution
helps to prevent potential cross-contamination between evidence samples and exemplars.

work surfaces. 10% bleach followed by 70% ethanol should always be

Use disposable bench paper to prevent the accumulation of human DNA r(?manent
decontaminate all work surfaces before and after each procedure. 6&

precaution will reduce the risk of sample mix-up and the pote r sample-to-sample

Limit the quantity of samples handled in a single run to a mana gbénumber. This
contamination. s

Change gloves frequently to avoid sample-to-sample ccﬁtamination. Change them
whenever they might have been contamigted With@ and whenever exiting a sample

handling area.
o .0

Make sure the necessary docume ’@%n IS c@rg\etely filled out, and that the analyst’'s ID
is properly associated with the ns. K

?3

Body fluid identification O\

1.

The general laboratory pol \S to identify the stain type (i.e., blood, semen, or saliva)
before individualization, i€ attempted on serious cases such as sexual assaults, homicides,
robberies, and assaulis.) However, circumstances may exist when this will not be
possible. For example, on most property crime cases when a swab of an item is
submitted for te , the analyst will cut the swab directly for individualization rather

than testing ab for body fluid identification.

reening test for blood followed by the detection of a real-time PCR
ibn value greater than or equal to 0.1 pg/uL is indicative of the presence of
blood.
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3.

DNA Extraction Guidelines \Q

Hgh Copy Number (HCN) testing is performed when the samples have a quantitation
value >/.5 pg/uL for YM1 (at least 195 pg per amp20>pg/pL for Identifiler 28 cycles

(at least 100 pg per amp)18 pg/ulL for Minifiler (at least 100pg per amp), & pg/ulL

for PowerPlex Y (at least 100pg per amp).

High Sensitivity DNA testing (Identifiler 31 cycles) can be performed if (J{have a
guantitation value of less than 7.5 pg/pL (or 20 pg/pL) and greater th‘aci/ g/uL

N

Slightly different extraction procedures may be required for each%&of specimen. Due to the
varied nature of evidence samples, the user may need to modi(z procedures.

1.

All tube set-ups must be witnessed/confi@dr to sS‘ting the extractioNQOTE:
For differential extractions, the tube 3 she witnessed after the incubation step.)

N\
Use Kimwipes or a tube opener, \en %gontaining samples; only one tube should
be uncapped at a time.

When pouring or pipetting Xel sgdions, the resin beads must be distributed evenly in
solution. This can be achievedéﬂshaking or vortexing the tubes containing the Chelex
stock solution before aliquot

For pipetting Chelex, @%tte tip used must have a relatively large bore — 1 mL pipette
tips are adequate.

Be aware of sr@articles of fabric, which may cling to the outside of tubes.

With the e ion of the Mitochondrial DNA Team, two extraction negative controls (E-
included with each batch of extractions to demonstrate extraction integrity.
-Neg will typically be subjected to a micro-con and will be consumed to

hat an E-neg associated with each extraction set will be extracted concurrently
he samples, and run using the same instrument model and under the same or more
sensitive injection conditions as the samples. The second E-Neg will ensure that the
samples in that extraction set can be sent on for further testing in another team or in a
future kit. In the Mitochondrial DNA Team, only one extraction negative control is

needed.

Refer to the end of this section for flow charts.
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The etraction negative control contains all solutions used in the extraction process but
no biological fluid or sample. For samples that will be amplified in YM1, the associated
extraction negative control should be re-quantified to confirm any quantitation value of

1.00 pg/uL or greater. For samples that will be amplified in Identifiler (28 or 31 cycles),
PowerPlex Y, or MiniFiler, the associated extraction negative should be r -(fuvtified to
confirm any quantitation value of 0.2 pg/uL or greater. Qe'\

7. If a sample is found to contain less than 7.5 pg/uL of DNA, then the (aLple should not
be amplified in YM1. If a sample is found to contain less than L of DNA, then
the sample should nbe amplified in Identifiler (28 cycles); if a le is found to
contain less than 5 pg/uL of DNA, then the sample Shﬂﬂiﬂ?@ lified in PowerPlex
Y; if a sample is found to contain less than 10 pg/uL of Dl‘h\ en the sample should not
be amplified in MiniFiler.

Samples that cannot be amplified may extr reported as containing insufficient
DNA, concentrated using a Mlcroco & (see ?c on 3 of the STR manual), or possibly
submitted for High Sensitivity testi g;s he i t

supervisor to determine how to
and purified using a Microconﬁ if th
inhibition or background flu en
20pg/puL may be submitted for hi({

eting analyst shall consult with a
DNA samples may also be concentrated
A is suspected of being degraded or shows
ing quantitation. Samples that are 1 pg/pL to
sitivity testing with a supervisor’s permission.

8. After extraction, the tubes csﬁ ing the unamplified DNA should be transferred to a
box and stored in the appr e refrigerator or freezer. The tubes should not be stored
in the extraction rack

9. All tubes must have the complete case number, sample identifier and IA initials on the
side of the tube Qﬁis includes aliquots submitted for quantitation.

%
&
&

QO
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HSC and PC — EXTRACTION NEGATIVE FLOW
AUTOSOMAL STR TESTING

All Extractions for

Autosomal STR
Testing to start
with an \

“ENeg1”and an
“ENeg2"

A

"ENeg1” to be aliquotted \Q

for quantitation, amp’ed, All Samples fail.
and run alongside the "ENeg1" Fails——» Samples to be re-
samples in “ID28 extracted.
Normal.”

"ENeg1" Passes

All Samples pass.

‘ O
"ENeg1" to be \g

Microconned to 20ulL. Q

‘

Run the Microddgn xtracion set cannot

NoEn'\:zl‘cp iers FAIL be microconned for
& Identifiler.
NN

O PASS
Q

e  Samples in same set IMPORTANT NOTE:
can be microconned
and run in “ID28 If samples need to be tested for Y-STR’s, they should be
Normal” Parameters. recut, re-extracted, and processed in accordance to the Y-
e  "ENeg2" will be used if STR flowchart. ENeg2 can be used under certain
additional testing using circumstances for Y-STR Testing. Consult with your
another methodology or supervisor or manager who will ensure that the additional
kit is required. testing will not conflict with the other samples within the

same extraction set.
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HYBRID — EXTRACTION NEGATIVE FLOW
AUTOSOMAL STR TESTING

All Extractions for

Autosomal STR
Testing to start
with an "ENeg1"
and an "ENeg2" (LQ
: Q
e  "ENeg2"to remain
untouched.
e "ENeg1"tobe \

aliquotted for All Samples fail.
quantitation, "ENeg1" Fails——» Samples to bg re-

amp’ed, and run extra
alongside the
samples in “ID28
High.” @
Q" .
* A \
"ENeg1" Passes Q\ K

All Samples pass!

A ‘\K
"ENeg1" N
Microc?ed;@u_l..

\/
&

. Refer to the STR
Run the Microconned Results Interpretation
0 "ENeg1" in “ID31 High” ——FAIL———» P

Parameters procedure for

guidance
Q

e  Samples in same set
can be microconned
and run in “ID31 High”
Parameters.

. If any extract needs to
go to Y-STR, "ENeg2"
will be used as per Y-
STR protocols.
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Y-STR TESTING (HSC, PC, and HYBRID)
EXTRACTION NEGATIVE FLOW
e "ENeg2" to remain
] :.mtouctled. (L
¢I]S%I2(£?I'(:3ir:12f?or ) alﬁzlugt:edt fobr All Samples fail. \
start with an quantitation, "ENeg1" Fails—————» Samples to be re-

"ENeg1" and an
"ENeg2"

A
O Run the Microconned

"ENeg1"in “Y-STR ———FAIL——» can be microconned

amp’ed, and run
alongside the
samples in
“Normal.”

"ENeg1" Passes

5uL of "ENeg1"
amp’ed and run in
“ID Normal”

"ENeg1" Passes Q:

J \
?3 ) C)OO

-\W
\

Re-run” Parameters

PASS

. Samples in same set
can be microconned
and run in any Y-STR
Parameter.

o "ENeg2"is left
untouched and can be
used under certain
circumstances (ex: If
"ENeg1" Microcon Re-
run fails, then "ENeg2"
can be run Microcon in
“Normal” to determine
pass or fail).

"ENeg1" Fails in ID2:

-
‘A
Any s: &
be run irID!

>

extracted.

QO
N

N

AJ
No samples in the

same extraction set
O can be sent to ID

No samples in the
same extraction set

and run in “Y-STR Re-
run” parameters

Q
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X-TEAM — EXTRACTION NEGATIVE FLOW

AUTOSOMAL STR TESTING

All Extractions for
Autosomal STR
Testing to start

with an
“ENeg1”and an
“ENeg2"

A

untouched.

e "ENeg1”to be
aliquotted for
quantitation,
amp’ed, and run
alongside the
samples in “ID28
Normal.”

e "ENeg2’ to remain

All Samples fail.
Samples to be re-
extracted; No
samples withi&
this set m. 3
micro@

~
4

"ENeg1" Fails——p

"ENeg1" Passes

If a sample needs to

All Samples pass.

be Microconned

traction set canno
be microconned for
Identifiler.

ples in the same

A

"ENeg1" to be
Microconned to 20uL.

A

Run the Microconned
"ENeg1"in “ID28
Normal” Parameters

t —FAIL

PASS

NO

. Samples in same set
can be microconned
and run in “ID28
Normal” Parameters.

. "ENeg2" will be used if
a sample from the
same extraction set is
going to High
Sensitivity Testing.

S
N
N\

©
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X-TEAM — EXTRACTION NEGATIVE FLOW

Y-STR TESTING

“ENeg2" to be amp’ed,
and run “High.”

"ENeg2" Fails

Run “ENeg2” in
“Normal”; No
samples within this
set may be
microconned.

"ENeg2" Fails

No samples in the
same extraction s

STRs

e K
can be sent to Y-§>~

—"ENeg2" Passes—p|

———"ENeg2" Passes—

o

A

Samples in s \‘

extraction tma
microconnediand fun in Y-
STR “‘Normaksand/or

AR
S
<§‘\Samples in same

extraction set can only be
Microconned and run in Y-
STR “Normal”

O

QO

——

"ENeg2" Passes

——"ENeg2" Passes

IMPORTANT NOTE:

X-Team samples from the same extractio
run in autosomal and Y-STR or Mini-STR

extract sample for the appropriate kit.

If both Y-STR and Mini-STR testing is needed, re-

n set may be
only, not both.

Samples in same
extraction set can be run
in Y-STR “Normal” and/or

“High”; Additionally,
samples from the within
the same set may be
microconned.

N

Q

©

NS
Samples in saye
extraction

&
N

can only be
runin g “Normal”

If sample(s) need to be
microconned, then
“ENeg2” to be
Microconned to 20uL

A

Microconned “ENeg2" to
be amp’ed, and run
“High.”

"ENeg2" Fails

Run Microconned
“ENeg2” in “Normal’;

"ENeg2" Fails

No samples in the
same extraction set
can be microconned

for Y-STRs
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X-TEAM — EXTRACTION NEGATIVE FLOW
MINI-STR TESTING

Samples in same \(L

"ENeg2" to be amp'ed, I "ENeg2" Passes—® extraction set can be run

and run. in Mini-STR. (19
"ENeg2" Fails \\
¢ \

A
No samples in the If sample(s) n e
same extraction set microconneN
can be sent to Mini- “ENeg2’ to b
STRs Microco to 20uL
K N
< . Qa
Q\A A\ vy

Samples in same P\
extraction set can be " Microconned “ENeg2" to
: . g2" Pas ,
microconned and run in be amp’ed and run.

Mini-STR.

O\ "ENeg?2" Fails

i

No samples in the

QO same extraction set

can be microconned

\' for Mini-STRs

0 IMPORTANT NOTE:

Q X-Team samples from the same extraction set may be

run in autosomal and Y-STR or Mini-STR only, not both.
If both Y-STR and Mini-STR testing is needed, re-
extract sample for the appropriate kit.
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Controls for PCR analysis
The following controls must be processed alongside the sample analysis:

1. A positive control is a DNA sample where the STR alleles for the relevant S oci are
known. The positive control tests the success and the specificity of the ification, and
during the detection and analysis stage the correct allele calling by t)—kel/ ware.

2. An extraction negative control consists of all reagents used in t N\eaction process and
is necessary to detect DNA contamination of these reagents. the Y STR
system only detects male DNA, one cannot infer from a cl TR extraction negative
the absence of female DNA. Therefore, an extraction neéﬂv control originally typed in
Y STRs must be retested if the samples are amped in IQntifiler.

3. Samples that were extracted together sh@d allb plified together, so that every
sample is run parallel to its associate& racti gative control.
*

4, An amplification negative contr \gg\sists gy amplification reagents without the
addition of DNA, and is used t{ tect contamination of the amplification reagents.
Failure of any of the controls does not st tically invalidate the test. Under certain

circumstances it is acceptable to rete ative and positive coe@STR Results
Interpretation Procedure for rules o;(f'@ sting of control samples.

\

Concordant analyses and “duplicate rule”

The general Iaboratchy is to confirm DNA results either by having concordant DNA

results within a cas (for 28-cycle systems) by duplicating the DNA results with a separate
aliquot, amplificat&&nd electrophoresis plate. The most common situations are confirmation
of a match or lon within a case and confirming DNA results when less than the optimal
amount of s amplified. Concordant and duplicate analyses are also used to detect sample
mix-up @ firm the presence of DNA mixtures.

1. For evidence samples, the following guidelines apply:
a. Identical DNA profiles among at least two items (two evidence samples or one

evidence sample plus an exemplar) within a case are considered internally
concordant results (“duplicate rule”).
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b. If a sample does not match any other sample in the case, it must be duplicated by

a second amplification. If the only result was obtained using Y-STRs, this must

be duplicated in the Y system.
ﬁ}?ts of a
S steps

your supervisor
examples:

C. If after the first DNA analysis there is an indication that the sample
mixture of DNA, several scenarios must be considered. Further
have to be decided based on the nature of each case. Consu
if you encounter a situation that is not represented in the fo}\\x

1) If all alleles in a mixture are consistent with comn\l m any of the
known or unknown samples in the case, e.g m and a semen source,
no further concordance testing is needed. Fm r testing could be
performed if needed (e.g., to obtain a COEQS profile).

2) If two or more mixtures ir@se ar s\15istent with each other and
display the same aIIeIeA in @ hey are considered duplicated.

3) If one or more alle& counted for by other contributors in the
case, the pres fth gn component must be confirmed by a
second ampll

4) If there is only onﬁmple in a case and this happens to be a mixed
sample, the re eed to be confirmed by a second amplification.

5) Inconcl \@? mples (as defined in the STR Results Interpretation
Procedyre) that cannot be used for comparison do not require duplication.

d. Another r@'n for duplication is to confirm results when a low amount of DNA
is obt l@ rom an evidence sample and/or less than optimal amounts of DNA
are &ified to account for possible stochastic effects.

icate Identifiler 28 amplifications are required when there is less than 1000
g of DNA in the total extraction volume (e.g., calculate total yield by
multiplying DNA concentration by the 200 uL in a Chelex extraction); any
duplicate amplification done for this reason should be performed as soon as
possible after extraction to minimize loss of DNA in the extract.
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Another method to satisfy this policy is if two different kits with overlapping loci
are used. At least two (2) autosomal loci must be duplicated to confirm results.
(For example, using Cofiler/Profiler Plus or Identifiler/MiniFiler on the same

evidence sample.) r\(l/

e. Automatic duplications designed to streamline testing of any eécil e samples is

also permitted.
N

2. For exemplar samples, duplication is designed to rule out fals lusions based on
sample mix-up, and also to streamline testing. Duplication Start with a second
independent extraction, with the exemplar cut and submit extraction at a different

time. The two resulting extracts must be aliquotted for gmplification separately at
different times, and aliquotted for electrophoresis s @ ly and run on separate plates.
If there is no additional exemplar materia%vailabl extraction, the duplication may
begin at the amplification stage. @ .
S

To streamline testing, all suspec%@victi mplars may be duplicated.

The following guidelines a;?&)r r@@j duplications:

a. If the DNA profile of avictj exemplar does not match any of the DNA
profiles of evidence s% s in the case, including mixtures, the victim’s
exemplar must be ted to eliminate the possibility of an exemplar mix-up.
Thisis because it i&y likely that an exemplar mix-up would generate a false
exclusion.

b. Duplicatioé&'a victim’s DNA profile is not necessary in a negative case (no
alleles dgtetted in evidence samples).

C. Si duplicate exemplar analyses are performed to confirm the exclusion, a
ﬁaj al DNA profile (at least one complete locus) that demonstrates an exclusion

Q& sufficient.

d. If the DNA profile of avictim’s exemplar matches any of the DNA profiles of
evidence in the case, or is present in a mixture, the exemplar does not have to be
duplicated. Thisis becauseit is highly unlikely that a sample mix-up would
generate a falseinclusion.
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e. If the DNA profile of asuspect’'s exemplai(or other non-victim elimination

exemplar) does not match any of the DNA profiles in the case, or in the local
database, the exemplar does not have to be duplicabesi.s meant to
streamline the process similar to convicted offender testing.

f. If the DNA profile of a suspect’'s exemplanatches any of the DN %Q(k in
the case, or in the local database, the suspect’s exemplar has % duplicated to
eliminate the possibility of an exemplar mix-uphisis meant to sk\ line the
process similar to convicted offender testing. '\

g. Pseudo exemplarglo not have to be duplicated, reg r@s if the DNA profile
matches any of the DNA profiles in the case. ?\

3. For evidence samples or exemplar samp& analyz X)NA systems containing

overlapping loci, the DNA results for the rlappi ci must be consistent. If no or
partial results were obtained for som plng loci, this amplification is still

valid if consistent results were obt for one overlapping locus (Amelogenin is
not considered an overlapping I&m th ext) If the partial amplification confirms

a match or an exclusion of an a@nother evidence sample, it does not have to be
repeated.

4, Partial profiles can satisfy the d@catlon policy. Consistent DNA typing results from at
least one overlapping locus i fferent amplification is considered a concordant

analysis. Q

5. For Y-STR testing, t mple does not have to be reamplified if the internal duplication
rule applies or if th\ TR results are concordant with the autosomal results: confirming
an exclusion or sion, confirming the presence of male DNA, confirming the number

of semen do Based on the case scenario it might be necessary to reamplify in order
to confirm xact Y-STR allele calls. There might not be sufficient autosomal data to
establis cordance.
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Exogenous DNA Policy

Exogenous DNA is defined as the addition of DNA/biological fluid to evidence or controls
subsequent to the crime. Sources of exogenous DNA could be first responders, EMT’s, crime
scene technicians, MLI's, ME’s, ADA’s, NYPD personnel, or laboratory personne}{l/

1.

Medical treatment and decontamination of hazardous materials are %t priority.
Steps should be taken to minimize exogenous DNA as much as p 5\‘\| .

The source of any exogenous DNA should be identified so tha@wples can be properly
interpreted. It may be possible to identify the source by:

a. Examining other samples from the same batch f@(similar occurrences.

b. Examining samples from diﬁerent@(ches,@dled or processed at approximately
the same time for possible sirﬂ ccu‘rr@: s (such as from dirty equipment or
surfaces). ’\

C. Processing eliminationﬁegﬂpleséa)k for exogenous DNA occurring in the field
or by laboratory per I C)

Samples should be routinely c red to case specific elimination samples, personnel
databases, and the local C atabase for possible matches. Mixtures may have to be

manually compared. Q

If a negative or positi@ontrol contains exogenous DNA, all the associated samples are
deemed inconclusie and their alleles are not listed in the report. The samples should be
re-extracted or @@mplified, if possible.

If a clean @ cannot be obtained or the sample cannot be repeated then the summary
section reports should statde following sample(s) can not be used for
compahisbn due to quality control reasons.”

@e exogenous DNA has been discovered, the first step is to try to find an alternate
sample.
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a. As appropriate, a new extraction, amplification, or electrophoresis of the same

sample can serve as an alternate for the affected sample. For this type of alternate
sample the discovery of exogenous DNA is not noted in the report. However all
case notes related to the discovery of exogenous DNA are retained in_the case file
for review by the quality assurance group, forensic biology staff, at&Q and

outside experts. A form is created that identifies the source of t enous
DNA by Lab Type ID Number, if known, and stating which sa ere
affected. '\\

b. If there are other samples from the crime scene which \x serve the same
purpose, they could be used as an alternate sampl @ example, in a blood trail
or a blood spatter, another sample from the same r€e should be used. Another
swab or underwear cutting should be used for a €exual assault. In this scenario,
the sample containing the exogenqus DNA be listed in the summary
section of the report as followsth mple] not be used for comparison
because it appears to contajn C(%\ with a {NYPD member, OCME

[laboratory] member, medic »Instead please see [alternate
sample] for comparison”. -No*ham the possible source(s) of the
exogenous DNA are li n th rt. All case notes related to the event are
retained in the case r rm y attorneys and their experts. A form is

0

created that identifies*the of the exogenous DNA by Lab Type ID Number,
if known, and stating th amples were affected.

5. If an alternate sample can@be found then only samples containing a partial profile of
the exogenous DNA r@ interpreted. Interpreting samples containing a full profile of
the exogenous DNA@? lead to erroneous conclusions due to the masking effect of
significant amou%of NA.

a. Ifas has a single source of DNA and this DNA appears to be exogenous
DN the following should be listed in the summary section of the report:
) sample] will not be used for comparison because it appears to contain
&NA consistent with a {NYPD member, OCME [laboratory] member,
edical responder}.” No names for the possible source(s) of exogenous DNA
Q are listed in the report. All case notes related to the event are retained in the case
file for review by the quality assurance group, forensic biology staff, attorneys,
and outside experts. A form is created that identifies the source of the exogenous
DNA by Lab Type ID Number and stating which samples were contaminated.
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b. If a sample contains a mixture of DNA aAdL of the alleles from the source of

the exogenous DNA appear in the mixture then the following should be listed in
the summary section of the repoff.he [sample] contains a mixture of DNA.

The mixture is consistent with a {NYPD member, OCME [laboratory]
member, medical responder} and at least [#] other individual(s).” T erl/
[sample] will not be used for comparison.” No names for the possi Ibe urce(s)

of exogenous DNA are listed in the report. All case notes rel the event are
retained in the case file for review by the quality assurance 7 forensic
biology staff, attorneys, and outside experts. A formis c that identifies the
source of the exogenous DNA by Lab Type ID Number@stating which
samples were affected. '\

Unresolved discrepancies \OK

Legitimate differences of opinions or disput ncem&e interpretation of results may
occur. If differences of opinion cannot be’ Ived @he analyst, supervisor, and/or manager,
then the appropriate Technical Leader@)e th arbiter.

DNA storage E C)

1. Store evidence and unampli‘%@NA in a separate refrigerator or freezer from the
amplified DNA. Q

2. During analysis, all e@énce, unamplified DNA, and amplified DNA should be stored
refrigerated or froz%& reezing is generally better for long term storage.

3. Amplified D&@) iscarded after the Genotyper analysis is completed.

4. DNA e
stor

Q

Revision History:
March 24, 2010 — Initial version of procedure.
September 27, 2010 — Added X-Team Extraction Negative Flow Charts (Pages 9, 10, and 11) to reflect practice.
October 28, 2010 — Added section on “Unresolved Discrepancies.”
February 2, 2012 — HSC and PC Extraction Negative Flowchart for Autosomal STR Testing modified to allow for the use of
Extraction Negative #2 in Y-STR Testing.
July 16, 2012 — Specific worksheets were removed and replaced with generic terminology to accommodate LIMS.

are retained refrigerated for a period of time, then frozen for long-term
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Sample sizes for Chelex extraction should be approximaielyd liquid blood or saliva, 1/3 of
a svab, or a 3x3mm cutting of a bloodstain.

1. Remove the extraction rack from the refrigerator. Extract either evidence or exemplars.
Obtain two tubes for the extraction negatives and label them. (1/

2. Have a witness confirm the names and order of the samples. '\

3. Obtain reagents and record lot numbers. '\\(1/

4, Pipet 1 mL of sterile deionized water into each of the tubes i@@xtraction rack.

5. Mix the tubes by inversion or vortexing. '\

6. Incubate in a shaker (at approx. 1000 rprg) at roomﬁ@)erature for 15 to 30 minutes.

7. Spin in a microcentrifuge for 2 to 3 rm@é 0 to 15,000 x g (13,200 rpm).

8. Carefully remove supernatant j@t 306&0. (f the sample is a bloodstain or swab,
leave the substrate in the t pel@

9. Add 175 |L of 5% Chelex (from as(eq)resuspended Chelex sat)tusing a P10001u
Pipetman . &O

10. Incubate at 56°C for 15 6®minutes.

11.  Vortex at high speea@S to 10 seconds.

12. Incubate at 10%@or 8 minutes using a screw-down rack.

13.  Vortex a@\speed for 5 to 10 seconds.

14. S ir"@gmicrocentrifuge for 2 to 3 minutes at 10,000 to 15,000 x g (13,200 rpm).
Qt aliquots of neat and/or diluted extract (using) Tio microcentrifuge tubes for

real-time PCR analysis to determine human DNA concentration (refer to Section 4 of the
STR manual).

15.

16. Store the extracts at 2 to 8°C or frozen.
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17. In the LIMS system, navigate to the Data Entry page, assign the samples to a storage unit
(cryobox), and indicate which samples are completed.

18. Have a supervisor review the assay.

Revision History:
March 24, 2010 — Initial version of procedure.

July 16, 2012 — Information added to accommodate LIMS.
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Sample sizes for this Chelex extraction should be approximately a 3x3mm cutting of tissue.

1. Remove the extraction rack from the refrigerator. Extract either evidence or exemplars.
Obtain tubes for the extraction negatives and label them. Have a witness confirm the
order of the samples.

2. Obtain reagents and record lot numbers. (1/

3. Pipet 1 mL of sterile deionized water into each of the tubes in the extra@‘lack. Mix
the tubes by inversion or vortexing.

4. Incubate at room temperature for 15 to 30 minutes. Mix occasion&h\ inversion or
vortexing.

5. Spin in a microcentrifuge for 2 to 3 minutes at 10,000 to 15,00 (13,200 rpm).

6. Carefully remove supernatant (all but 30 to 5. 6

7. To each tube add: 200 of 5% Chelex (from a well-resus'p%nded Chelex samtio

1pL of 20 mg/mL Proteinase K

8. Mix using pipette tip. \O

9. Incubate at 56°C for 60 minutes.

10.  Vortex at high speed for 5 to 10 sec @

12.  Vortex at high speed for 5to 1 ond
13. Spin in a microcentrifuge f at 10,000 to 15,000 x g (13,200 rpm).
14.  As needed, pipet allquots 0 eat( 1/ dilution and a 1/10,000 dilution (u3ing TE

into microcentrifuge tubes for reaktinte PCR analysis to determine human DNA
concentration (refer to Sectlo he STR manual).
15. Store the extracts at 2 to 8° rozen.

16. In the LIMS system, nawto the Data Entry page, assign the samples to a storage unit
h samples are completed.

(cryobox), and indicm
17. Have a superwsor’r\' the assay.

QO

11. Incubate at 100°C for 8 mlnute§ a sc own rack.

Revision History:
March 24, 2010 — Initial version of procedure.
July 16, 2012 — Revised procedure to accommodate LIMS.
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(FOR AMYLASE POSITIVE STAINSOR SWABS, CIGARETTE BUTTS, SCRAPINGYS)

Sample sizes for this Chelex extraction should be approximately a 5x5mm cutting or 50% of the
scrapings recovered from an item.

1.

2.
3.

HOoO~NOOA

11.
12.

13.

Remove the extraction rack from the refrigerator. Extract either evidence &rayemplars
Obtain tubes for the extraction negatives and label them.
Have a witness confirm the order of the samples.
To each tube add: 2@ of 5% Chelex (from a well-resuspended }(L& sarhyti
1ul of 20 mg/mL Proteinase K

(Note: For very large cuttings, the reaction can be scaled @l times this amount. This
must be documented. Scaling up any higher reqw permission from the
supervisor and/or IA of the case. The final extralt may need to be Microcon

concentrated.) 6 (8\'

Mix using pipette tip. . AQ ‘\(\
Incubate at 56°C for 60 minutes, AN\ 6
Vortex at high speed for 5 to 1(§mds K
Incubate at 100°C for 8 mi sin ew down rack.

Vortex at high speed for 5 t seg¢ongls.

Spin in a microcentrifuge for 2 t fhutes at 10,000 to 15,000 x g (13,200 rpm).

As needed, pipet neat and a dilution (usin) o microcentrifuge tubes for

Red-Time PCR analysis to (Ng(mine human DNA concentration (refer to Section 4 of

the STR manual).

Store the remalnderg@supernatant at 2 to 8°C or frozen.

In the LIMS system gate to the Data Entry page, assign the samples to a storage unit
(cryobox), and indiCate which samples are completed.

Have a superv} eview the assay.

00(0

QO

Revision History:

March 24, 2010 — Initial version of procedure.
Juy 16, 2012 — Information added to accommodate LIMS.
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NOTE: For very large cuttings 200 uL of Chelex might not be enough to provide enough
suspension of the sample. Thereaction can be scaled up and reconcentrated
using Microcon concentrators.

Sample sizes for non-differential Chelex extractions depend on the circumstances gf the case.
Regularly 1/3 of a swab or a 3x3mm cutting of a stain should be used. For case
present but no sperm cells were detected, the sample size can be mcreased

1. Remove the extraction rack from the refrigerator. Obtain tubes fo;\?\gbdractlon
negatives and label them.

2. Have a witness confirm the order of the samples. \
3. Obtain reagents and record lot numbers.
4 To each tube add: 2@Q of 5% Chelex (from a WeII-resusﬁanded Chelex soiiti

1w of 20 mg/mL Proteinase K
7pLof 1 MDTT O

\.
5. Use the pipette tip when adding theQ;Q th mix the contents of the tubes.
6. Incubate at 56°C for approxima ours, 6
7. Vortex at high speed for 10 to
8. Incubate at 100°C for 8 mi tﬁ? sin ew down rack.
9. Vortex at high speed for 10 0 s€cofds.
10. Spin in a microcentrifuge for 2 to\érU utes at 10,000 to 15,000 x g (13,200 rpm).
11. tion (usingf)TiBto microcentrifuge tubes for real-

Pipet aliquots of neat and 1/1 %‘?
time PCR analysis to detern#?q'

manual).
12. Store the extracts até;t) C or frozen.
13. In the LIMS syste i

(cryobox), and indi
14. Have a supervj

e which samples are completed.
eview the assay.

Revision History:
March 24, 2010 — Initial version of procedure.
Juy 16, 2012 — Information added to accommodate LIMS.
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Approximately 1/3 of a swab or a 3x3mm cutting of a stain should be used for this type of

extraction.

1. Remove the extraction rack from the refrigerator.

2. Pipet 1 mL of PBS into each tube, including tubes for extraction negativ Jaals in the
extraction rack.

3. Mix by inversion or vortexing.

4. Incubate at room temperature overnight or for a minimum of using a shaking
platform (at approx. 1000 rpm). 0

5. Have a witness confirm the order of the samples.

6. Vortex or sonicate the substrate or swﬁ? at minutes to agitate the cells off of
the substrate or swab. At this pomt tion negative controls with the date
and time. \Q

7. Label new tubes to hold th sﬁgJor Sy ate remains. Sterilize tweezers with 10%
bleach, distilled water, and?% etfane¥efore the removal of each sample. Remove the
swab or other substrate from th pple tube, one tube at a time, using sterile tweezers
and close tube. Place swab trate in the sterile labeled substrate remains fraction
tube.

8. Spinin a r@entr 5 minutes at 10,000 to 15,000 x g (13,200 rpm).

13.

Wlth

Incubate at 56°C for about 60 minutes to lyse epithelial cells, but for no more than 75
minutes, to minimize sperm lysis.
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14.

15.

16.

17.

18.

19.

20.

During the incubation step do the following:

a. Label a new tube for each sample, including an epithelial cell extraction negative
control. Mark each tube as an epithelial cell fraction.

b. Add 50uL of 20% Chelex (from a well-resuspended Chelex smtjtto e
epithelial cell fraction tube.

C. Close tubes.

Spin the extract in a microcentrifuge at 10,000 to 15,000 x g (13 ) for 5 minutes.

Add 15QuL of the supernatant from each sample and the e tives to its
respective epithelial cell fraction sample tube. Store at 4° ice until step 20.

Wash the sperm pellet with Digest Buffer as follows:

a. Resuspend the pellet in 0.5 mL Digest Buff

b. Vortex briefly to resuspend pell

C. Spinin a mlcrocentrlfuge at 1@ to X g (13,200 rpm) for 5 minutes.
d Remove all but 50L of th d discard the supernatant.

e Repeat steps a-d for a t 5 i

Wash the sperm pellet onthh s@k&s follows:
a. Resuspend the pelletin 1 eril
Vortex briefly to resu ellet.

b
C. Spin in a microcentry at 10,000 to 15,000 x g (13,200 rpm) for 5 minutes.
d Remove all but 5 he supernatant and discard the supernatant.

Resusr@! pw&'
Tayt \pro &

stirring with a sterile pipette tip.

y 50 resuspended sperm fraction and to the tubes comggiihe
and the sperm fraction extraction negative, addl ®56% Chelex, 1
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23.  Vortex at high speed for 5 to 10 seconds.

24. Incubate at 100°C for 8 minutes using a screw down rack.

25.  Vortex at high speed for 5 to 10 seconds. %

26. Spin in a microcentrifuge for 2 to 3 minutes at 10,000 to 15,000 x g ( m).

27. Pipet aliquots of neat and a 1/100 dilution (using)Ti&to microcenttj es for
real-time PCR analysis to determine human DNA concentratio 0 Section 4 of the
STR manual).

28. Store the extracts at 2 to 8°C or frozen.

o

29. In the LIMS system, navigate to the DataEntry p sign the samples to a storage unit

(cryobox), and indicate which samples m .

- )
30. Have a supervisor review the a&s&
C O
“
S
QA
S
&

Revision History:
March 24, 2010 — Initial version of procedure.
Juy 16, 2012 — Information added to accommodate LIMS.
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Refer to the following sections of the Protocols for Forensic Mitochondrial DNA Analysis:

Hair Examination
Mitochondrial and Nuclear DNA Hair Extraction
Mideo Macro/Microscopic Digital Imaging

Revision History:
March 24, 2010 — Initial version of procedure.
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A. Sample Preparation

Liguid/dry blood, bone marrow, oral swab and tissue sample preparation

Stained substrates and oral swabs should be cut into small pieces (3 x 3 mm). Tissues
should be minced into small pieces in a weigh boat using a sterile scalpel ortazor blade.
Place samples in 1.5mL microcentrifuge tubes or conical tubes when appropriate. See
table below for various sample types.

Proceed to Section B: Sample Incubation '\\(1/

Sample type Amount
Liquid blood 1000500 L.~ '\
Bone marrow 0.5x0.5cmt 1.5cm
Oral swab 1/ &a

Blood stain :\‘
Soft tissue (}‘&\ 0.5 (@&'gm to 1.5 x 1.5¢cm
7 "4
Paraffin embed@d&issw ‘Q.B x0.3cmto1.0x1.dcm
» \\J
Bone preparation \\bo

Before extraction, a bone th specimen should be cleaned entirely of soft tissue and
dirt using a range of @O s, such as scraping, rinsing and sonication. A combination of
t

sterile scalpels, steril thbrushes and running water should be used to clean the
specimen. Fora %(y'cation bath, the sample is placed in a conical tube and covered with
a 5% Terg-a-z olution. For additional cleaning, the sonication step may be repeated
multiple time, decanting the liquid and replacing with fresh Terg-a-zyme solution.
After cleaQiRgds the sample is usually rinsed with distilled water and dried usirig¢a 56
incubaf?)&rying time may vary from a few hours to overnight).

I)@ erg-a-zyme is an enzyme-active powdered detergent. A 5% solution should

be made fresh prior to bone preparation and cleaning. Refer to Appendix A
in the Quality Assurance Manual. Once prepared, the reagent will only be
effective for up to 16 hours.
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1. Photograph bone or tooth sample after cleaning. Measure and weigh specimen

prior to sampling.

2. If several bones are available, generally compact bone is preferred, such as

humerus, femur, or tibia. (1/

*WARNING**
Protective eyewear, lab coats, cut resistant gloves, sleeve pro(et%s, and
0

HEPA-filtered facial masks should be worn when cutting b id
breathing bone dust. All cutting of bone must be done u biological
hood.

3. Using an autopsy saw or a Dremel tool equipped W{ﬁg409 or 420 cutting wheel,
cut the bone specimen into approximately 5x5 &m size pieces. Take enough
cuttings for an end weight of approximately 2g\For older or compromised bones,
several aliquots of 2g can be ex@d an bined during the Microcon step.
For tooth samples, the whoLe%] ho aken. Note: The cutting wheel

S

should be disposed of after, u the Dremel and hood should be
completely wiped down v Ieacgq ethanol

4. Place bone cuttings?ém\.ﬁcﬁal tubes labeled with the FB case number,
ME#, PM item #, initials, a&d e.

5. Cover bone cuttings \hq'ﬂ Yo Terg-a-zyme solution and sonicate samples for 30-
45 minutes. Note: I@ure water level in the sonicator is 1-2 inches from the
top.

6. Decant the *Qrg-a-zyme and wash with distilled water until no detergent bubbles

remain.go

7. If @aw, repeat with fresh changes of 5% Terg-a-zyme and water washes until
&) irt has been removed.

QQ’Iace the clean cuttings in a weigh boat on a small Kim Wipe. Cover with
another weigh boat. Label the weight boat with the FB case number, ME#, PM
item #, initials, and date.

9. Seal with evidence tape.

10. Dryin a 56C incubator for a few hours or overnight. After sufficient drying,
weigh bone cuttings. The bone sample must be completely dry before milling.
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Sample milling with the SPEX Certiprep 6750 Freezer Mill

All freezer mill parts that come into contact with bone specimens, such as the cylinders,
metal end plugs and impactors, should be cleaned, dried and sterilized prior to use. See
Step 22 for appropriate cleaning procedure.

1. Assemble specimen vials in the following order: metal bottom, pIas@nder
impactor, and metal top.

2. Place under UV light for a minimum of 15 minutes. '\\(1/

3. Label metal bottoms with a case identifier using a blu \Qharple

4. Add bone cuttings to specimen vial around mpacto'\smg decontaminated
forceps. Cover with metal top. Note: Shake sp imen vial and ensure that the
impactor can move back and forthé

5. Wipe down inside of mill wﬂha& pag@weﬂ)o not use bleach or ethanol.

6. Plug in mill and switch O&)

7. Obtain liquid mtroge?@m tgﬁfllllng transfer container. Be aware that the
liquid nitrogen tank ty when the detector level reads anywhere from

“I/4” to “empty”. \O

**WARNING** \

Liquid Nitroge @)e hazardous. Use cryogenic gloves, protective

eyewear/face @Id and lab coats when handling. Avoid liquid nitrogen

splashes t& e and hands.

8. Open @Preezer mill lid. Add liquid nitrogen slowly into the mill up to the FILL

LI avoid splashing and boiling over.

9. &Ce the specimen vial into the round chamber. If processing more than one
o]

Q ne sample it is possible to save pre-cooling time by placing up to two vials in
the mesh container inside the mill.

10. Change cycle number to match total number of samples plus two (n + 2).
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11.  Adjust mill settings as follows:

Cycle set to # of samples + 2
Time T1 (milling) 2.0 min
T2 (pause) 2.0 min
T3 (pre-cool) 15.0 min ?\(1/
Rate Bones — 8-10 Q
Teeth — 6-8 \(1/
12.  Close cover slowly to avoid any liquid nitrogen splashe press RUN to start

the mill. Pre-cooling will begin followed by the mHImg@

13.  During the 2-minute pause phase, it is now poss&{e to open the mill and remove
the finished sample using cryogenic gloves

14.  Place one of the pre-cooled s@‘nensv@@é} in the dock in the round chamber.

thEI , refill. A loud noise during
n|tr veI |s low. If liquid nitrogen is not
ill, ts, and cylinder can occur.

15.  If liquid nitrogen level is
milling means that the |}
refilled, damage to t

16.  Close the lid and preﬁU ain. Repeat from Step 11 until all samples are
processed. \

17. Inspect each s fter removal from the mill. If sample is sufficiently
pulverized, refpove the metal top using the Spex Certi-Prep opening device.
Note: Samples may be reinserted into the mill for additional grinding.

18.  Using @ontaminated tweezers, remove impactor from vial and submerge in 10%
ble
€9%y bone dust into labeled 50mL Falcon tube. Ensure complete dust transfer

Q y tapping bottom of cylinder. Weigh bone dust and document.

20. Soak metal end parts and plastic cylinder in 10% Bleach.
21.  When milling is complete, switch mill to OF&nd unplug. Leave cover open for

liquid nitrogen to evaporate. The next day, lower cover and place in storage until
next use.
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22. Mill Parts -Clean Up: Mill parts must be cleaned immediately after processing.
If this is not possible, steps a-b must be completed before leaving overnight.

Rinse off with 10% bleach.

Soak all parts in 0.1% SDS.

Brush parts with a new toothbrush to remove any residual bong dust.

Rinse with water.

Soak parts in 10% bleach and brush each part in bleach i@'\hdually.

Rinse with water.

Separate the plastic cylinders from the metal parts. (1/

Rinse in 100% ethanol. ONLY the metal top, me m, and

compactor can be rinsed in 100% ethanol. DO the plastic

cylinder in ethanol as it will cause the plasti er to break.

I. Use isopropanol to remove any identifying s made with a Sharpie on
the tops or bottoms of the cylinders.

J- Dry and expose the parts to\UV ligh inimum of 2 hours. The UV
light in a biological hood tratal_&r can be used.

23.  Proceed to Section B: Sa@cub@‘

Laser Microdissection of Pr“hcts ﬁ' Cgceptlon

Se@~ooo0oTp

1. Initial processing \<>\

The product of cone@tlon (POC) can be received in different stages of

preparation: O

a) PO&grapings in saline buffer:

ove tissue from liquid either by filtration or centrifugation:
= Transfer liquid to 50mL falcon tube
00 = Spin sample in a bench top Eppendorf or IEC Centra CL3R at
1000 RPM for 5 minutes

QO = Discard liquid supernatant

Submit sample to the Histology department for tissue processing
according to the OCME Histology Procedure Manual section E. Then
proceed as for b).
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b) POC fixated and embedded in paraffin blocks:

Contact histology department and ask them to prepare microscope slides
from the paraffin block using the following precautions:

= Use disposable blades for the microtome and disc@ﬁer each

case.

= Clean working surface on microtome by wipin&\i 10% bleach
ard alcohol before and after each case.

= Use individual floating chambers for ea @

= Use uncharged microscope slides '\

Theslides then should be stained with h toxylin and eosin-phloxine
(H&E technique) as described in the Histology Procedure Manual.
But again during the staini roced@, separate sets of jars have to be

used for each case. . (\
Q7N

C) Stained or unstai@icroéve slides from POC blocks:
If the slides a@nsta@ﬁsk the histology department to stain them as
described above. gth ise proceed with the microdissedetbnique.

Attention: for slid t were prepared by a histology laboratory outside

of the OCME, Ign DNA not from the mother and the fetus might be
present on t Ide.

2. PixCell lle Lagr):apture Microdissection

A traine@wologist has to be present to distinguish decidual tissue from
chori illi and operate the laser. After the slide has been placed on the
m@pe platform the pathologist will visually identify the area of interest,
this area for the laser, and activate the laser. The laser setting is specified in
&é Arcturus instrument manual. The Forensic Biology Criminalist needs to be
Q resent during the complete procedure to maintain chain of custody of the
evidence.

An area of chorionic villi and an area of maternal tissue should be collected on
separate CapSure caps. The caps can be stored and transported in 50 ml Falcon
tubes. A third unused CapSure cap should be extracted as an extraction negative
control.
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Use new scalpel and clean forceps to remove the film from the cap and transfer
the film to a fresh 1.5mL microcentrifuge tube containing8006f organic
extraction buffer, DTT, SDS and Proteinase K as described below.

B. Sample Incubation ,\(1/
1. Process an extraction negative with every batch of extractionfl/g

2. Prepare the master mix in microcentrifuge tube or comc@ and mix
thoroughly by swirling or vortexing very briefly. Q

For liquid blood, dry blood and bone marrow samples:

1 Sample | 5 Samp ('3\10 Samplgs 15 Samples
Organic extraction buffer | 400 pL % % 4.0 mL 6.0 mL
20% SDS 10PL S ) 5N 100uL 150 pL
Proteinase K (20 mg/mL) 1§(3‘§|_ \:u_ 136 pL 204 uL
Total Incubation Volume perwle (‘ 0 400 pL
For bone samples:
<§§one 1 sample 3 samples | 5 samples
_ (OP(=2gdust) | (N+2) (N+2) (N+ 2)
Organic Extractlok&de‘: 2370 L 7.11mL 11.&mL 16.59 mL
20% SDS . 300 1L 900 1L 1.5m 2.1mL
1.0 M DTT(QU 120 4 360uL 600 1L 840 1L
Proteig@k (20 mg/mL) | 210 4. 630 L 1.05mL | 1.47mL
‘c’ubation Volume per sample 3000 (4
A4
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For teeth samples:
1 sample 3 samples | 5 samples
Per tooth (N+ 2) (N+ 2) (N+ 2)
Organic Extraction Buffer | 790 L 2.37mL 3.95 mL 5.53 pl.
20% SDS 100 W 300 pl 500 70,0\Q\V
1.0 M DTT 40 WL 120|200 {QBOLL
Proteinase K (20 mg/mL) | 70 uL 210 W 350 L (\'\&190 uL
Total Incubation Volume per sample Q) 1000 (L

For tissues and paraffin embedded tissu

section) samples:

%.g. mi i
1ls e

3. Add the appr

Per ti§sAu€® 3 (3Ns+ar2r;ples
Organic extraction buffer 39%’&‘ .(‘ 185 pL 1975 pL
20% SDS ab&rf‘ (\O‘ 150 pL 250 pL
1.0MDTT 20 L | 60 pL 100 pL
Proteinase K (20 mg/mL) 3;@_\ 105 pL 175 pL
Total Incubation Volume pe(sq\ple 500 pL

rigte incubation volume of master mix to each sample tube and

eneg tube. X(ortex tubes briefly. Make certain the substrate, tissue, or swab is
totally s rgedNote: Reagent volumes may be adjusted in order to
acco ate the size or nature of a particular sample.

4, E;@ tubes in a shaking 56°C heat block and incubate overnight.

QQ’roceed to Section C: Phenol Chloroform Extraction and Micfoctanup.
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C. Phenol Chloroform and Microcon Clean up
Set Up

Remove the Phenol:Chloroform:Isoamyl Alcohol (25:24:1) (PCIA) from the rF.irEerator.
Obtain organic waste jug for disposal of any tubes or pipette tips that c {e\n contact
with PCIA. (1/
*WARNING** '\\

Phenol Chloroform is toxic. Protective eyewear, mask, lab c é& d nitrile gloves
should be worn when handling. All work must be conduct@ er a chemical fume

hood.
A\

For samples possibly needing mtDNA or Hligh Sens&@/ DNA testing: Place one
Microcon® YM100 collection tube and o '5 mL @ ocentrifuge tube for each sample,
including the extraction negative, in t rat i@er for at least 15 minutes. Note:
Irradiate multiple tubes (4-6) per@e am i&accommodate the total volume of

incubation buffer. C) O

1. Vortex and centrifug?k in(ﬁz d microcentrifuge tube samples at high speed
for 1 minute. Vortex and egntrifuge bone dust, incubated in 50 mL conical tubes,

for 5-10 minutes at 100 éi\/\ in Eppendorf Centrifuge Model 5810.

2. Obtain and label on@repared Eppendorf Phase Lock Gel (PLG) tube per sample,
including the on negative. PLG tubes make phase separation easier and
are optional.

NOTE: %f bone samples, label as many tubes to accommodate the total
Q/olume of incubation buffer per sample. For example, if you
incubated 2g of bone dust with 3 mL of incubation buffer, you will
00 need 6 PLG tubes.

QQIOTE: See section D for PLG tube preparation instructions.
3. Centrifuge PLG tubes at maximum speed for 30 seconds.
4, Label Microcoff YM100 filters for each sample. Prepare the MicrGc¥iM100

concentrators by adding 10Q jof TE*to the filter side (top) of each
concentrator. Set aside until step 11.
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5. Add a volume of Phenol:Chloroform:lsoamyl Alcohol 25:24:1 (PCIA) to the PLG
tube which is equal to the volume of incubation buffer (typically 400q@ be
added from the sampleNote: When pipetting PCIA, you must penetrate the
top buffer layer and only aliquot the desired amount from the lower, clear
organic layer. Place used pipette tips in the organic waste bottle. (}

6. Have someone witness your sample tubes, PLG tubes, and M%
tubes.

7. Pipet the sample supernatant (typically 409 to the PLG t \eady
cortaining PCIA. For bone dust samples, pipet sever s of the supernatant
into multiple PLG tubes. Note: Do not disturb bone

emulsion. Note: Do NOT vortex the PLG tu
9. Centrifuge samples for 2 minute axim peed to achieve phase separation.
(On Eppendorf Centrifuge Mo 41 Iﬂ\@in at 16.1 RCF or 13.2 RPM).

8. Shake the PLG tube vigorously by hand or b@rsmn to form a milky colored

10.  If the sample is discolor \%ntal rticles in the aqueous phase, or contains a
lot of fatty tissue, tr e to r (agueous phase) to a new PLG tube and
repeat Steps 7-9. a@ agyreous layer from bone and teeth will usually be
discolored. Only repeat t nol-chloroform clean-up steps if any dust or
particles are present in équeous layer. If it is not necessary to repeat the clean-
up step, go to Step 11\

11.  Carefully tran @3 aqueous phase (top layer) to the prepared Mi®rocon
YM100 conce or. Be careful not to let the pipette tip touch theNgeé:
Discard us LG tubes into the organic waste bottle.

12.  Spin icrocofi YM100 concentrators for 15-30 minutes at 500 x g, which is
ately 2500 RPM. (On Eppendorf Centrifuge Model 5415D, spin at 0.6
r 2600 RPM). Note: Ensure that all fluid has passed through filter. If
as not, spin for additional time, in 10-minute increments. If fluid still

emains, transfer sample to a new filter and microcon again.
13. Discard the wash tubes and place the concentrators into a new collection tube.

14.  Add 400uL of TE™ to the filter side of each Microc8rYM100 concentrator.
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15. Spin again for 15 minutes at 500 x g for 15 minutes. (On Eppendorf Centrifuge

Model 5415D, spin at 0.6 RCF or 2600 RPNNote: Ensure that all fluid has
passed through filter. If it has not, spin for additional time, in 10-minute
increments. If fluid still remains, transfer sample to a new filter and

microcon again. (1/

16.  Add 40puL of TE™ to the filter side of each Microc8rYM100 conce
Note: For bone samples, add only 10-26L of TE “to each filter

ensure smallest elution volume. '\\
17. Invert sample reservoir and place into a new labeled @on (Ebe.
samples possibly needing mtDNA or High Sensitivi

reservoirs into irradiated collection tubesppin at 10 g, which is
approximately 3500 RPM, for 3 minutes. (On endorf Centrifuge Model
5415D, spin at 1.2 RCF or 3600 RRM). \

18. Measure the approximate vgl&ec v, and record the \Ndue:
Combine bone elutants b eas volume.

amount and expecte A donterit as follows using. THote: Samples may

19. Discard sample reseivﬁg&d agjustsample volume depending on the starting
be microcon’ed again to fugther’'concentrate low DNA content samples.

Sample type {s\\j Final Volume
. \)

High DNA co @

(Large amou@f blood, fresh tissue, bone marrow, orad00 L

swabs, a ied bloodstains)

Medi \IA content

(S mounts of blood, fresh tissue, bone marrow, or@200 L

s, and dried bloodstains); differential lysis sampleg

ow DNA content
Q (Formalin fixed tissue, dried bone, teeth, samples from| 100 (L
decomposed or degraded remains, some reference samples)
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20.  Transfer samples to newly labeled 1.5mL microcentrifuge tubes for storage. (For

samples possibly needing mtDNA or High Sensitivity DNA testing, transfer
samples to irradiated 1.5 mL microcentrifuge tubdlgcord the approximate
final volume.

21.  As needed, pipet aliquots of neat and/or diluted extract (usifAgifite (l/
microcentrifuge tubes for real-time PCR analysis to determine h '\ NA
concentration (refer to Section 4 of the STR manual). (1/

22. Store the extracts at 2 to 8°C or frozen. \

23. In the LIMS system, navigate to the Data Entry pa e@gn the samples to a
storage unit (cryobox), and indicate which samplesiam complete.

24. Have a supervisor review the ass%

manual) as ne

Preparation of Phase Lock g I (Kg‘?ubes

Make sure the plasticware b’cég used is resistant to phenol and chloroform.

NOTE:  See Mlcrocoﬁw hoo{ the appropriate section of the STR

1. Without puttin @sure on the plunger, twist off the orangearapdiscard.
Attach thegra;@pensing tip(supplied) to the syringe and tighten securely.

(NOTE: U gray tip is optional for a smoother application of PLG. Less force
is nece hen gray tip is NOT used.)
2. Ap irm pressure on the plunger to dispense PLG until it reaches the end of

ip. Add heavy PLG based on Table below. NOTEuB253.25 cc
responds to 3 lines on the syringe

Tube size PLG heavy Tube size PLG heavy
0.5mL 100uL 15mL 3mL

1.5mL 325uL 50mL 5mL

2.0mL 325uL
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3. Pellet the PLG by spinning the tubes prior to use. See table below.

Tube size | Centrifuge model | Speed Time
0.5to Eppendorf 5415C | 14 x 1000 RPM 3
2.0mL Eppendorf 5415D | 13.2 x 1000RPM/16.1 x 1000RC N
15and | Sigma 4-15 C 1500 RCF Q)zr\n
50mL )

Revision History:
March 24, 2010 — Initial version of procedure.
July 16, 2012 — Revised procedure to accommodate LIMS.
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A. Preparation

1. Extraction sets consist of 9 samples and one or two extraction negatives.
Additional extractions may continue sequentially during incubations.

2. Name the extraction set by its date and time using the following for
“082010.1000". An “E” may precede the date and time of the ex@

3. The documentation will automatically calculate the requi5|t %nt of reagents
needed for the extraction.

4, Follow the procedures for Work Place Preparation s@o the General

Guidelines Procedure of this manual).

D \0‘

Self-Witnessing Step: Cor% es names and their order on the
documentation with the es on sample tubes.
Obtain reagents an re§ lot ers.

Prepare digestion buffer i ag/ irradiated tube (1.5 mL, 2.0 mL Dolphin, or 15
mL).

Prepare the digesti uffer according to the calculated volumes on the
documentatio volume for one sample is shown below.

lution Concentration 1 sample

Yo SDS when 0.05%
Poly A RNA at (or 0.01%)
ter step)
“Proteinase K

192 pL
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5. Vortex solution well. Add 200 pbf the digestion buffer to each sample. Open

10.

11.

1.

2.

Q

only one sample tube at a time using the cap opener. Ensure that the swabs are
submerged in the digestion fluid. If necessary, add an additional 200 pL of the
digest buffer (including the Proteinase K) to the sample in order to submerge a
large sample, and be sure to document the deviation.

Record the temperatures of the heat shakers. Temperatures m hikmin +
of the set temperature. (1/

Incubate on the heat shaker at 56°C for 30 minutes with @&g at 1400 rpm.
Incubate on the heat shaker at 99°C for 10 minutes'@ﬁo shaking (0 rpm).

Place sample in cold block at 4°C for 10 minutes\vith no shaking (O rpm).

Centrifuge the samples at full s@brie%b

During the digestion peri%@l the@b aand elution tubes, and print
labels for storage tubes. C) O

Purification and Concentratign \C)

Prepare Microcoh 100($'bes and label the membrane tube and filtratedap.

Witness step: the sample names and order on the documentation with
the names on sample and Micrdtames.

Pre-coa icrocohmembrane with Fish Sperm DNA or a 1/1000 dilution of
Poly prepared as follows in an irradiated microcentrifuge tube or 15 mL
tub

é) Fish Sperm DNA Preparation

I. Add 1 uL of stock Fish Sperm DNA solution (Img/mL) to 199uL
of water for each sample on the test batch.

il. Aliquot 200 uL of this Fish Sperm DNA solution to each
Microcor” tube. Avoid touching the membrane. The volume for
one sample is shown below. Refer to the documentation for
calculated value.
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b. Poly A RNA Preparation

I. Make a 1/10 dilution of 2Img/mL of Poly A RNA as follows: add 2
puL of Poly A RNA to 18 uL of irradiated water and mix the
solution well. This is a final concentration of 100ug/mL(1/

il. Using the 1/10 dilution, make a 1/100 dilution with %\t
100ug/mL Poly A RNA in 198 uL of irradiated W d mix the
solution well. The solution has a final concen of 1 ng/uL.

iii. Add 1 uL of the 1ng/uL Poly A RNA sol &@ 199uL of water
for each sample on the test batch. %

iv. Aliquot 200 uL of this Poly A RN?§utlon to each Microon
tube. Avoid touchinognthe memb\tj . The volume fasample
is shown below. @o the@c mentation for calculated value.

Réggent 6\ 1 sample
Water (N (\\ 199 pL

Fish n D @Yg/mL)
or PoﬁgN gﬁg/uL) Lut

NOTE: For samples wj QOO pL of digest solution, make a 20 pL solution of
1 uL of Fis m DNA (Img/mL) or 1 uL of Poly A RNA (1
ng/uL) wi uL of water. Mix well and add this solution to the
membifranes Ensure that the entirety of the membrane is covered.
In thisYwanner, all of the digest may be added to the Microcdh
rane for a total volume of 420 uL.
%,

4, Hltr@s

Add the entirety of each extract to its pretreated Micr8cormbrane. If

O this is a purification/concentration assay of a sample that has already been
Q extracted and the sample volume is lower than 200ul, raise the sample
volume to 200ul with dH20. Aspirate all of the solution from the sample
tube by placing the pipet within the swab. The sample tubes may be
discarded.
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b. Centrifuge the Microcof tube at 2400 rpm for 15 minutes. An

5.

Q

additional 5 minutes may be required to ensure that all the liquid is
filtered. However, do not centrifuge too long such that the membrane is
dry. If the filtrate does not appear to be moving through the membrane,
elute the filtrate and continue centrifuging the eluant into a fresh microcon
with a pretreated membrane. '\

If indicated on the evidence examination schedule or b gpervisor, or if
the filtrate is not clear, perform a second wash step \I) g 400 pL of
water onto the membrane and centrifuging again &O rpm for 15
minutes or until the all the liquid is filtered. Ho 0 not centrifuge to
dryness. This process may be repeated, as ary. Document the
additional washes. \&

All samples undergoing extraction wit % SDS must be purified and
concentrated a second ti@/ repe@ this section (Section C).

C. Visually inspect e ‘ﬂérocg rane tube. If it appears that more
than 5 pL remain e th mbrane, centrifuge that tube for 5 more
minutes at 24& : O

Elution \C)

a. Open only one&@crocé%tube and its fresh collection tube at a time.

b. Add 20 @?/o Trehalose in 0.1X TE or irradiated water to the
Microcdg®And invert the Microcdhover the new collection tube. Avoid
touc the membrane.

c trifuge at 3400 rpm for 3 minutes.

3
Ob

e.

Transfer the eluant to an irradiated and labeled 1.5 mL tube. Measure and
record the approximate volume. The total volume should not exceed 30
uL and should not be less than 20 uL. Adjust the final volume to 20 uL
using or 3% Trehalose in 0.1X TE or irradiated water (if less). Discard the
Microcon® membrane.

If the eluant appears to be a dark color or is not clear, it may be necessary
to purify the sample again. Prepare a fresh MicrB¢ohe and repeat
steps 4-5.
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f. Store the extracts at 2 t6® or frozen.
g. In the LIMS system, navigate to the Data Entry page, assign the samples

to a storage unit (cryobox), and indicate which samples are completed.

h. Have a supervisor review the assay. '\(1/

Revision History:
March 24, 2010 — Initial version of procedure.
September 27, 2010 — Added language to Step 4 of Section C — Purification and Concentration.
January 30, 2012 — Added the use of 3% Trehalose in 0.1X TE as an elution buffer during the concentration/purification
step.
July 16, 2012 — Revised procedure to accommodate LIMS.
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A. Preparation
1. Extraction sets consist of 10 samples and two Extraction Negatives. Additional

extractions may continue sequentially during incubations.

2. Follow the procedures for Work Place Preparation in the General G'ng}}nes
Section of this manual.

B. Digestion '\\(19

1. From evidence exam, each nail (or group of nails) sh L}®e placed in an
irradiated tube. '\6

2. Add 200 pL of irradiated 25 mM EDTA/PBS scgpn to each sample.

3. Sonicate the samples for one h(@roo@berature.

>

4, Label a new set of irradia@roci@ge tubes with the sample identifiers.

5. Remove the supern taﬁ{g-?rom @amples and place in the labeled irradiated
microcentrifuge tub&” C)
C. Extraction <>\

1. Prepare the digesti uffer according to the calculated volumes. The volumes
for one sampl hown below:

Solution Concentration| 1 sample
) SDS 1.0% (0.96%) | 2.3 (2.25

G s
0 Proteinase K 0.80 mg/mL 9 uL

20 mg/mL
Q°

Irradiated water N/A 13.7 uL
2. Prepare Microc$h100 tubes and label the membrane tube and filtraeedap
with the sample identifiers. Prepare and label the Micfdcotiection tubes,
sanple storage microcentrifuge tubes as well as post-sonication nail collection
tubes. The identifier for the post sonication nail collection tubes should include
“PS” as a suffix. For example, the post sonication tube for left nail ring finger
could be “nail L4 PS”.
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3. Witness step:Confirm the sample names on the documentation with the names

on all labeled tubes.

4, Vortex solution well. Add 25 pL of the nail digestion buffer to each sample.
Open only one sample tube at a time using the cap opener.

5. Record the temperatures of the heat shakers. Temperatures mv@'\ ithin +
of the set temperature.

6. Incubate on the heat shaker at 56°C for 30 minutes with &g at 1400 rpm.

7. Incubate on the heat shaker at 99°C for 10 minute v@ﬁo shaking (O rpm).

8. After removing from the shaker, centrifuge the ples at full speed, briefly.
Allow the samples to cool for a fevgmutes preparing for next steps or
chill for 10 minutes at 4C.

9. During the digestion peri |Is using clean tweezers and dry them in
a hood. When dry, plac nall e labeled, post-sonication nail collection
tubes.

D. Purification and Concentratlon \

1. Self-witness stepCon‘h'@%e sample names on the documentation with the
names on the sa nd Micro@dnbes.

2. Pre-coat the !@co% membrane with Fish Sperm DNA or a 1/1000 dilution of
Poly A RN pared as follows in an irradiated microcentrifuge tube or 15 mL

tube: @
a.@sh Sperm DNA Preparation

OO I. Add 1 uL of stock Fish Sperm DNA solution (Img/mL) to 199uL
Q of water for each sample on the test batch.

il. Aliquot 200 uL of this Fish Sperm DNA solution to each
Microcor” tube. Avoid touching the membrane. The volume for
onesample is shown below. Refer to the extraction documentation
for calculated value.

b. Poly A RNA Preparation
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Make a 1/10 dilution of Img/mL of Poly A RNA as follows: add 2
puL of Poly A RNA to 18 uL of irradiated water and mix the
solution well. This is a final concentration of 100pg/mL.

Using the 1/10 dilution, make a 1/100 dilution with 2 uL
100ug/mL Poly A RNA in 198 uL of irradiated water a& X the
solution well. The solution has a final concentratiop~Qf » ng/uL.

Add 1 uL of the 1ng/uL Poly A RNA solution ty\}\%ldL of water
for each sample on the test batch. Q

O
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Aliquot 200 uL of this Poly A RNA solution to each Micro€on
tube. Avoid touching the membrane. The volume fasample
is shown below. Refer to the extraction documentation for
calculated value.

Water 199 pL

Reagent 1 sample ,\(1/

Fish Sperm DNA (1mg/mL) 1L

or Poly A RNA (1ngjuL) y\\(l/

NOTE: For samples with 400 pL of digest solution, ﬁ 20 pL solution of

membrane. Ensure that the entirety o

1 uL of Fish Sperm DNA (Img/mL) or 1

y ARNA (1

membrane is covered.

ng/pL) with 19 pL of water. Mix well anga this solution to the
d

In this manner, all of the st ma

ded to the Microcdh

membrane for a total Y )

3. Fltration

~0 @\

discarded.

a.  Add the entir & ea@@act to its pretreated MicrBaormbrane.
b

Thesample tubges ma

b. Centrifuge the\"r\@oc?l tube at 2400 rpm for 15 minutes.

C. Repeat thi
the me

a totqQ

&

sh step two more times applying 400uL of water onto
e and centrifuging again at 2400 rpm for 15 minutes for
ree washes to remove any residual EDTA.

lly inspect each Microc6rmembrane tube after the third wash. If it
ars that more than 5 pL remains above the membrane, centrifuge that

0 ube for 5 more minutes at 2400 rpm.
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4, Elution
a. Open only one Microcdhtube and its fresh collection tube at a time.

b. Add 20 pL of irradiated water to the Microéoand invert the Micgqcdh
ove the new collection tube. Avoid touching the membrane.'\PL

C. Centrifuge at 3400 rpm for 3 minutes. Q

d. Transfer the eluant to an irradiated and labeled 1.5 I_\X1 . Measure and
record the approximate volume. The total volumﬁr&u not exceed 30
uL and should not be less than 20 uL. Adjust the | volume to 20 uL (if
necessary) with irradiated water. Discard th;\ Samembrane.

e. If the eluant appears to be a dark color g"@ not clear, it may be necessary

to purify the sample again. &epare a Micr8¢obe and repeat
steps 3-4.

f. As needed, pipet ali 0 \é of n d/or diluted extracts (usifpifi®
microcentrifuge t or regdtyme PCR analysis to determine human
DNA concentgatiQr=(refer, ction 4 of the STR manual).

g. Store the extracts a\zqgsor frozen.

h. In the LIMS syx§m, navigate to the Data Entry page, assign the samples
to a storage @‘ cryobox), and indicate which samples are completed.

. Have a@ﬂervisor review the assay.

Revision History:
March 24, 2010 — Initial version of procedure.
Juy 16, 2012 — Revised procedure to accommodate LIMS.
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Sanple size for the extraction should be approximately 1/3 of a swab or a 3x3 mm cutting of the
stain. This extraction is not applicable to cigarette butts.

All bloodstain and exemplar cuttings should be placed in 2.0mL screw cap sample tubes.

A. Setting up M48 Test Batch and Saving Sample Name List '\(1/

1.

5.

Open file on the M48 computer. Save this document by gom %a\fé As
and save the document to the “SampleName” folder on thegs p with “File
Name” in MMDDYY.HHMM format and the “Save As Ty t'to CSV

(comma delimited)(*.csv).
,@\

A window stating “The selected file,type doe\@ support workbooks that contain
multiple sheets” will open. C|IC@

A second window asking {E@u Wi@?eep the workbook in this format?”

opens. Click “Yes”.

Close the Excel Wo%ﬁeet C)O

Click “Save”.

B. Sample Preparation and Inagéeg%n

1. Remove the e @on rack from the refrigerator. Extract either evidence or
exemplars. D t extract both together.

2. Sampleﬁaratlon should be performed under a hood.

3. OE ivtwo empty 2.0 mL screw top sample tubes for the extraction negatives and
;c ally label one as Extraction Negative 1 and the other as Extraction Negative

4, Have a witness verify your samples. This will be your “Extraction” witness.

5. For large runs, prepare master mix for N+2 samples as follows, vortex briefly, and

add 200uL to each of the tubes in the extraction rack and the pre-prepared
extraction negative tubes. For smaller runs, you may add Proteinase K and G2
Buffer to each tube individually:
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R 1 6 12 18 24
eagent sample | samples | samples| samples| samples
Digestion Buffer (Buffer G2) | 190 WL | 1520 (L | 2660 (L | 3800 (L | 4940 L
QIAgen Proteinase K 10 L 80 L 140 L | 200 o Zﬁ uL

6.

C. BioRobot M48 Software and Platform Set-Up

1.

2.

9.

Shake at 1000 rpm at 5€ for a minimum of 30 minutes. Reco(@

\Q

Double click on the “BioRobot M48" icon on the %%op.

Themomixer temperature.

Click the “Start” button. Note: Tkédoor qgg)ntainer interlock must be
closed to proceed.

“F Trace MTL" protocol S@d be%
middle of the screen en

MTL”. C)

Click on the “select” butt@@nd select “1.5 ml” for the size of the elution tubes.

cted If not, click on the arrow in the
t “New Dev*gDNA” - and “F Trace

Select the number @wples 6, 12, 18, 24, 30, 36, 42, or 48.

Set sample v@ to 200 uL (cannot and should not change).

Set eIutio@Mme to 200 uL.

The prompt asks to ensure the drop catcher is clean.
C|LQ n “manual operation” and select “Drop Catcher Cleaning”. The arm of the
will move to the front of the machine, and the drop catcher (a small plastic
ay) will be right in front of you. Remove and clean with 70% ethanol. When
the catcher is clean, replace the tray, close the door, and click “OK” in the
window.

In order to check this,

Make sure that the chute to the sharps container bin is clear for the tips to be
discarded. Click “Next”.
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10. The next prompt has software that calculates the number of tips necessary for the
run and asks, “Do you want to reset any of the tip racks?” Click “Yes tip rack ...”
for all tip racks and ensure that the tips were actually replaced and that the
pipette tips are correctly seated in the rack and flush with the robotic
platform. If no tip racks need to be reset, click “No”.

NV

# Samples 6 12 18 24 3( 36 AZ‘F\\ V4 8
# Tips 30 42 54 66 78 90 \‘i& 114

Tips needed for a run:

N

After you are finished, click “Next” K

11. Obtain stock bottles of reagents recor mbédl the reagent
reservoirs as stated below. All nts ored in their respective plastic
reservoirs in the metal rack, a@ d V\& e lot number of the reagent that they
contain, and covered with@s\film, Rfie magnetic resin. The resin is
stored between runs in{v iginal@ k bottle to prevent evaporation. Vortex the
magnetic resin soluti ell, the stock bottle and in the reservoir, before
adding it to the metaVa‘ck. notice crystallization in any of the solutions,

discard the solution, rinse\e container out with distilled water, and start again
with fresh reagent. \

12. Remove the Pargfi nd lids from the reagents, and fill the reservoirs to the
appropriate leye ng solutions from the working solution bottles using the same
lot as label e reservoir. If not enough of the same lot of a solution
remains, dh d the remaining solution from the reservoir, rinse and re-label the
reservoi h the new lot number. When filling the reservoirs add
appr tely 10% to the volumes recommended below to account for the

e large bore pipette tips:

ote: Bottles of MW1 require the addition of ethanol prior to use. See
Q bottle for confirmation of ethanol addition and instructions for
preparation if needed.

Controlled versions of Department of Forensic Biology Manuals only exist electronically on the
Forensic Biology network. All printed versions are non-controlled copies.



FORENSIC BIOLOGY PROTOCOLS FOR FORENSIC STR ANALYSIS

MA GATTRACT DNA EXTRACTION FROM BLOODSTAINS AND EXEMPLARS

DATE EFFECTIVE APPROVED BY PAGE
07-16-2012 EUGENE LIEN 40F 11
# o Large Large Large Large Small Elution Small

samples| reservoir | reservoir | reservoir | reservoir | reservoir | buffer | reservoir
Sterilized | Ethanol Buffer Buffer Buffer (TE® | Magnetic

Water (mL) MW1 MTL MW2 (mL) qur/
(m) (mb) | my | ) _ L
6 10.0 11.8 7.2 5.9 3.5 2.§q\) 15
Vl
12 18.4 22.6 12.9 10.3 5.9 r\'ssz\ 17
18 26.9 33.4 18.6 14.7 8.4 (\\\%.9 1.9
NI
24 35.3 44.2 24.3 19.0 108N 6.1 2.1
30 43.7 55.0 300 | 234 Q§~3 7.3 2.3
36 52.2 65.8 35.7 Q’ (b 15.7 8.5 2.5
42 60.6 76.6 41.,{‘ 3@;}‘ 18.2 9.7 2.7
O P -

48 69.0 87.4 / _@\.5 20.6 10.9 2.9

Place each reservoir nto theMaetal rack in the following locations. The plastic
reservoirs only fit into th k one way. Check the directions of the notches

which should point inq@ bot:

Size reservoir Rmo\ Software Tag Reagent
Largereservoir OQL4 Rea 4 Sterilized Water
Largereservoir ({}U L3 Rea_3 Ethanol (100%)
Largereservqﬁo\ L2 Rea_2 Wash Buffer 1 (Buffer MW1)
Larger ir L1 Rea_1 Lysis and Binding Buffer (Buffer

MTL)
Small reservoir S6 ReaS6 (empty)
Small reservoir S5 ReaS5 (empty)
Small reservoir S4 ReaS4 (empty)
Small reservoir S3 ReaS3 Wash Buffer 2 (Buffer MW2)
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Size reservoir Rack Software Tag Reagent
Position
Small reservoir S2 ReaS2 Elution Buffer (TH
Small reservoir S1 ReaS1 Magnetic Particle Resin : l ;

13. Flip up the “container interlocks” and place the metal reservoir@r onto the
left side of the robotic platform in the proper position. DO O\S rce the
holder into place and be careful not to hit the robotic ar correctly
seating the metal holder, flip down the “container inte and press “next”.

14. Click “Next” when you are prompted to write a men!bs

15. Place the sample preparation tray&n the r@ One tray for every 6 samples.
Click “Next". @ (\

16. Place empty, unlabeled *Iuti@es in the 65 degree (back) hot block,
located on the right side robes platform. Click “Next”.

17. Print labels for 1.5 crev@tﬁlbes for final sample collection in the robot.

18. Place labeledempty 1.5 Q}Sample collection tubes in the 8 degree (front) cold
block for collection of ﬂa samples.

19. At this point, @nples should be near the end of the incubation period (From
Section B, St . Spin all tubes in a microcentrifuge for 1 minute at 10,000 to
15,000 x %\,

20. Have #ness confirm the order and labels of both the sample tubes and the

210

22.

lab 1.5 mL final sample collection tubes. The robot setup witness should
é&/erify that all plasticware is in the correct position and correctly seated

&‘Yhe platform. This will be your “Robot Setup” witness.

Remove caps and place the samples for extraction on the robot. Discard the caps.
For empty positions, add a 2.0 mL sample tube filled with 200 uL of sterile
water.

Click “Yes” when asked to input sample names.
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D. Importing Sample Names

1. At the sample input page, click “Import”.

2. The Open window will appear. “Look in:” should automatically be sgsltba

default of “SampleName”. If not, the correct pathway to the foldens
Computer\C:\Program Files\GenoM-48\Export\SampleName. K&S

folder on the desktop is a shortcut to this file.) '\

ampleName

3. Select your sample name file and click “Open”. Verif t\a our sample names

have imported correctly. Do not be concerned if a &

completely displayed in the small window available'fox each sample.

4. Manually type in the word “Blank” fgr all emp!@nte fields.

5. Click “Next”. . @ *
S

mple name is not
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E. Verifying Robot Set-Up and Starting the Purification
1. In addition to confirming thposition of all plasticware and samples, check the

following conditions before proceeding:

robotic platform

All plasticware (tips, sample plates, tubes) is seated properly in tH

O
A3
Metal reservoir rack is seated properly, UNDER the interlokl}\ l/

Interlocks are down

Q"

a

N
(4
v

Sample tubes, elution tubes and sample collectior}@ have be
added to the platform in multiples of 6 as follows;

2.0 mL sample tube
HO are in empty

lons gfXke sample rack

2. After confirming the

-3

-

4. Click “Go” to start the,%@ction.

5. The screen wil @

y the start time, remaining time, and the completion time.

NS

@up of the plasticware click “Confirm”.

3. Click “OK” after closigg thi .

6. Monitor thedextraction until the transfer of DNA sample from the sample tubes to
the first ro@ sample plate wells to ensure proper mixing of magnetic resin and

DNA safdple.

7. At the end of the extraction, a results page will be displayed indicating the
s/fail status of each set of six samples.

Q
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F. Saving Extraction Report Page
1. At the results page click the “Export” button at the bottom center of the screen.

The Save As window will appear. “Save In:” should be set to the “Report” folder
on the desktop. This is a shortcut to the following larger pathway: My
Computer\C:\Program Files\GenoM-48\Export\Report. '\

In “File Name:", name the report in the format, MMDDYY.HW@ Set “Save
As Type:” to Result Files (*.csv). For instance an extractio ﬁir rmed at 4:30pm
on 5/14/06 would be saved as 051406.1630.csv.

O
Click “Save”. '\Q\

Drag a copy of the result file into the appropriateN.IMS SHARE folder.

Proceed with clean-up and ster@n. (\(8\'

S
G. Post-Extraction Clean Up and l@erilizé@n

1.

Remove samples (f? he gtﬁee (front) cold block) from the robotic platform
and cap with newly la eIeQ W caps.

Discard used pipetteﬁée, sample tubes, and sample preparation plate(s). Remove
reservoir rack.

Replace the Q)on the magnetic resin reservoir and vortex remaining resin
thoroughly \Uansfer the Magnetic resin to the stock bottle immediately with a
1000uL eman. Rinse the reagent container with de-ionized water followed
by et and store to dry.

r all other reagents and seal with Parafilm for storage. MAKE SURE
SERVOIRS ARE LABELED WITH THE LOT NUMBER OF THE
EAGENT THEY CONTAIN and that the lot numbers have been recorded.

Wipe down the robotic platform and waste chute with 70% ethdd@.NOT
USE SPRAY BOTTLES.

Replace tips on the instrument that were used during run. There are three racks,
and all racks should be full. Ensure that the pipette tips are correctly seated in the
rack and flush with the robotic platform.
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1. Click “Next”.

8. When prompted, “Do you want to perform a UV sterilization of the worktable?”,

click “Yes”.

9. Select 1 Hour for the time of “UV sterilization” then click “yes” }o\(ayse the
software upon completion.

10. Store the extracts at 2 to 8°C or frozen. '\\(1/

11. In the LIMS system, navigate to the Data Entry p@%&gn the samples to a

storage unit (cryobox), and import instrument data.

NA concentration (refer to

12.  As needed, pipet aliquots of neat and/or dilute @ tract into microcentrifuge tubes

for real-time PCR analysis to detesnine hum
Section 4 of the STR manual) 6

13. Have a supervisor reV|e 6\

14. COMPLETE THE M {%AGE WITH THE PURPOSE, PROGRAM,
PLATE, AND ANY RISING FROM THE RUN.

\.
OOQ
x
Q}\
&
0\‘»

QO
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H. BioRobot M48 Platform Diagram

A-1 Cc-1 C-2 C-3 (L
—* ("\
A3 {L'\)
o D5 D-6 D7 D-8 '\
| | \
\\
NYY

L ]
- \k :
I D-1 D-2 (¥ S:;
A\

— ’@“e‘@‘

(WaN

Figure 1. Diagram of ?ﬁ&% Pla of the QIAGEN BioRobot M48.

e Reagent Reservoir Positions
B (1@ mall Reagent Reservoir Positions
C Tube Racks 1, 2, and 3
D ) Sample Plate Holders
E)O Hot Elution Block (65 degrees)
Cold Final Elution Block (8 degrees)
\G (1-2) Sample Tube Racks
Q H Waste Disposal Chute

O

QO
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Troubleshooting
ERROR CAUSE/REMEDY

Resin/sample is being drawn up into
pipette tips unequally

Report problem to QA. Resin buffer has
evaporated. O-rings are leaking and need serv

Crystallization around®irow of wells in
sample plate

Forgot to fill empty sample tubes with Zi@lu,of
sterile HO. AN

BioRobot M48 cannot be switched on

BioRobot M48 is not receivin

Check that the power cord i &q\wcted to the
workstation and to the wal}

Computer cannot be switched on

B \ w7
Computer is not rec power.

Check that the po r'é‘rd is connected to the
computer and to, wall power outlet.

BioRobot M48 shows no movement wh
a protocol is started

bBigRobot M48g 10t switched on.
ioRobot M48 is switched on.

BioRobot M48 shows abnormal .
movement when a protocol is stargﬁ\\

pi ‘head may have lost its home posit

In <Q Asoft M software, select “dhual
@pskation/ Home”.

S
i?’s‘abl

Aspirated liquid drips from d
tips.

fpping is acceptable when ethanol is being
syringe pump.

Report problem to QA. O-rings require
replacement or greasing.

If the problem persists, contact QIAGEN

andled. For other liquids: air is leaking from the

Technical Services

ice.

on.

Revision History:
March 24, 2010 — Initial version of procedure.

July 16, 2012 — Revised procedure to accommodate LIMS.
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Sample size for the extraction should be approximately 1/3 of a swab or a 3x3 mm cutting of the
stain. This extraction is applicable for alcasework samples EXCEPT semen samples.

All bloodstain cuttings should be placed in 2.0mL screw cap sample tubes. (1/
A. Setting up M48 Test Batchand Saving Sample Name List

1. Open file on the M48 computer. Save this document by g(¥ X( ave As

andsave the document to the “SampleName” folder on t top with “File
Name” in MMDDYY.HHMM format and the “Save As T etto CSV
(comma delimited)(*.csv). '\

2. Click “Save”. OK
3. A window stating “The selected fi pe d ot support workbooks that contain
multiple sheets” will open. CI K.+

4. A second window askin o you b“q o keep the workbook in this format?”
opens. Click “Yes”.

Y‘ P
5. Close the Excel Wo
B. Sample Preparation and Inm@%n

1. Remove the t@%ﬂ rack from the refrigerator. Extract either evidence or
exemplars. D extract both together.

2. Sampleﬁaration should be performed under a hood.

3. Ob @wo empty 2.0 mL screw top sample tubes for the extraction negatives and
g ally label one as Extraction Negative 1 and the other as Extraction Negative

4. Have a witness verify your samples. This will be your “Extraction” witness.
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5. For large runs, prepare master mix for N+2 samples as follows, vortex briefly, and

add 200uL to each of the tubes in the extraction rack and the pre-prepared
extraction negative tubes. For smaller runs, you may add Proteinase K and G2

Buffer to each tube individually:

Reagent 1 6 12 18

sample | samples | samples | sampies mples
Digestion Buffer 190 W | 1520 L | 2660 (L 36 > 4940 L
(Buffer G2) AN
QIAgen Proteinase K | 10u |80uL | 140 pII\\'éOO WL | 260 1

6. Shake at 1000 rpm at 56C for minimu@f 30 minutes. Record the
thermomixer temperature. (b.

C. BioRobot M48 Software and Platf % {b\

Double click on the ‘i% @ot con on the desktop.
ut on

2. Click the “Start” b
closed to proceed.

=

he door and container interlock must be

3. “Trace TD v1.1C1* s\dtocol should be selected for casework samples. If not
selected, click @ arrow in the middle of the screen and then select “Forensic”
- “gDNA” - aG])Trace TDv1.1C1”

4. Click on&elect” button and select “1.5 mL” for the size of the elution tubes.

5. S%@le number of samples: 6, 12, 18, 24, 30, 36, 42, or 48.

6. Ogét sample volume to 20Q (cannot and should not change).

7. Set elution volume to 50L.
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8. The next prompt asks to ensure the drop catcher is clean. In order to check this

10.

11.

12.

click on “manual operation” and select “Drop Catcher Cleaning”. The arm of the
robot will move to the front of the machine, and the drop catcher (a small plastic
tray) will be right in front of you. Remove and clean with ethanol. When the
catcher is clean, replace the tray, close the door, and click “OK” in g&ndow.

Confirm that there is a means of collection for the tips that wil carded
during the run. Click “Next”. '\\

The next prompt has software that calculates the numb\@ tips necessary for the
run and asks, “Do you want to reset any of the tip r Click “Yes tip rack ...”
for all tip racks and ensure that the tips were actual??(eplaced and that the

pipette tips are correctly seated in the rack and flish with the robotic

platform. If no tip racks need to be reset, cli 0".

Tips needed for a run: AQ 0\(\(0

>

# samples QG: 12 § 24 30 36 42 49

# tips N 54 66 78 90 102] 114
)

v <
After you are finished, \Next”
QO

Obtain stock bo f reagents aedord lot numbers. Fill the reagent
reservoirs as below. All reagents are stored in their respective plastic
reservoirs ip, t etal rack, labeled with the lot number of the reagent that they

vered with ParafillBXCEPT the magnetic resin. The resin is
after every extraction. Vortex the magnetic resin solution well, both in
ottle and in the reservoir, before adding it to the metal rack (see step 13
aration of MagAttract Resin). If you notice crystallization in any of the

gent.

for
Q}ons, discard the solution, rinse the container out, and start again with fresh

Remove the Parafilm and lids from the reagents, and fill the reservoirs to the
appropriate level using solutions from the working solution bottles, using the
same lot as labeled on the reservoir. If not enough of the same lot of a solution
remains, discard the remaining solution from the reservoir, rinse and re-label the
reservoir with the new lot number. When filling the reservoirdd a
approximately 10% to the volumes recommended below to account for the

use of the large bore pipette tips.
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d%

# of Large Large Large Large Small El Small
samples| reservoir | reservoir | reservoir | reservoir | reservoir reservoir
%)

Sterilized | Ethanol Buffer Buffer Sterile Poly A

Water (mL) MW1 MTL Wate Q) (mL) RNA -
(mL) (mL) (mL) @ Magnetic

Resin

< (mL)

6 10.0 11.8 7.2 59%M 35 1.6 15
12 18.4 22.6 ‘1\Q) 5.9 1.9 1.7

N\
-
18 26.9 334 .6 (614.7 8.4 2.2 1.9

£ N —N
24 35.3 44.2‘?‘$\) ;4@') 19.0 10.8 2.5 2.1

30 43.7 55.0 V| Sab 23.4 13.3 2.8 2.3
36 52.2 65.8 4(0\35.7 27.8 15.7 3.1 2.5
42 60.6 76.8 414 32.1 18.2 3.4 2.7
48 69.0 Cs}fzf 47.0 36.5 20.6 3.7 2.9

bottle fo irmation of ethanol addition and instructions for preparation if
neet'j&

Note: Boté!@q’o'f MW1 require the addition of ethanol prior to use. See
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13 Refer to the table below for amounts of 1000ng/uL Poly A RNA stock solution to

14.

add for resin preparation:

Volume of Volume of Total Volume of
Samples 1000ng/uL stoqk Untreated RNA T&:‘agd '
PolyA RNA solution MagAttract MagA@;: esin
added to resin (uL) Resin (uL) Na)
6 samples 4.4 1497.8 A\ $502.2
12 samples 5.0 1697.5 \(b N 1702.5
18 samples 5.6 1897.2 Q\v 1902.8
24 samples 6.2 2096.9\ 2103.1
30 samples 6.8 2206.6 2303.4
36 samples 74 O\ 3296.3 2503.7
42 samples 79,2y .| \“2696.0 2703.9
48 samples 2895.7 2904.2

&
The treated resin mgé gb@@directly in the reservoir or in a 15mL conical

tube and then adde e dp riate reservoir for addition to the platform in the
amount dictated by the prQQ :

Place reservoirs int &e metal rack in the following locations. The plastic
reservoirs only fit i e rack one way. Check the directions of the notches

which shoukjg'n)@]’%he robot:
Size Reservoi(\ Rack Software Tag Reagent
@ Position
A\

Large re ir L4 Rea_4 Sterilized Water

N
Larggce!servow L3 Rea_3 Ethanol (100%)

\J
@e reservoir L2 Rea_2 Wash Buffer 1 (Buffer MW1)
Large reservoir L1 Rea 1 Lysis and Binding Buffer (Buffer
MTL)

Small reservoir S6 ReaS6 (empty)
Small reservoir S5 ReaS5 (empty)
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Small reservoir S4 ReaS4 (empty)
Small reservoir S3 ReaS3 Sterilized Water
Small reservoir S2 ReaS2 Elution Buffer (9E N
Small reservoir S1 ReaSl1 Magnetic Particle '}1

(

15. Flip up the “container interlocks” and place the metal resﬁs%.;r holder onto the
left side of the robotic platform in the proper positi NOT force the
holder into place and be careful not to hit the roboh . After correctly
seating the metal holder, flip down the “container i ks” and press “next”.

16. Click “Next” when you are prompted to Write@no.
& Q@obot. One tray for every 6 samples.

on
O
18. Place empty, unIabeIe{(})?nL e n tubes in the 65 degree (back) hot block,

located on the right VQ fti@@)tic platform. Click “Next”.

19. Print labels for 1.5 mL 584/ top tubes for final sample collection in the robot.

17. Place the sample preparation
Click “Next”. \A

20. Placdabeled, empt;&o L sample collection tubes in the 8 degree (front) cold
block for colIectioG final samples.

Section p 6). After incubation, spin the samples down briefly and pretreat
with Po RNA prior to placing on the robot. To each sample lysate add 250ng
of P@& RNA. A dilution of the stock Poly A RNA solution may be prepared
f inal concentration of 250ng/uL and 1uL of this dilution should be added to
sample lysate. Prepare the 250ng/uL solution by adding 15uL of the stock
QOOOOng/uL Poly A RNA solution to 45uL of irradiated water.

21. At this poig the samples should be near the end of the incubation period (From

NOTE: For cigarette butts, if the sample submitted is a strip of the filter
paper, the lysate must be transferred to a new labeled 2.0mL screw cap tube
prior to adding the Poly A RNA. Discard the cigarette strip. This is
important to avoid the clogging of the M48 tips.
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22.  Spin all tubes in a microcentrifuge for 1 minute at 10,000 to 15,000 \W/gen
they are ready, have a witness confirm the order and labels of both the
sample tubes and the labeled 1.5 mL final sample collection tubes. e robot
setup witness should also verify that all plasticware is in the corre t&)ipition
and correctly seated in the platform. This will be your “R i\e tup”

witness. (1/
23. Remove caps and place the samples for extraction on t 'rbbbt. Discard the caps.
For empty positions, add a 2.0 mL sample tube filled 200 uL of sterile

water.
N

24. Click “Yes” when asked to input sample namesoﬁ

> &
Importing Sample Names ‘AQ .\(\
1. At the sample input pagt\j%\k Ing{é

2. The Open window?‘hap arO“Look in:” should automatically be set to a
default of “SampleN me”\G not, the correct pathway to the folder is My
Computer\C:\Program FQ

folder on the desktops’é@ ortcut to this file.)
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3. Select your sample name file and click “Open”. Verify that your sample names

have imported correctly. Do not be concerned if a long sample name is not
completely displayed in the small window available for each sample.

4, Manually type in the word “Blank” for all empty white fields. '\(1/

5. Click “Next". \(I/Q

E. Verifying Robot Set-Up and Starting the Purification \Q

1. In addition to confirming thposition of all plasticwa(?&and samples, check the
following conditions before proceeding:

All plasticware (tips, sample Ké}tub (&ated properly |L1 the

robotic platform

AN

Metal reservoir rack is s@@d propéﬂy, UNDER the interlocks
Interlocks are dow K ol O 4

Sample tubes, elutlon tubes and sample collection tubes have
added to the platform i tiples of 6 as follows:

Empty 1.5 mL@S are filling empty positions for both sets
of elution tulEy n the cold and hot blocks

2.0 mL,eGS le tubes filled with 200uL of sterile H20 are in
empt(ﬂ itions of the sample rack

2. Aﬁe@firming the position and set-up of the plasticware click “Confirm”.

3. Gl)c “OK” after closing the door.

O

4 Click “Go” to start the extraction.

5. The screen will display the start time, remaining time, and the completion time.
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6. Monitor the extraction until the transfer of DNA sample from the sample tubes to

F. Saving Extraction Report Page

1.

4.
5.

1.

3.

the first row of sample plate wells to ensure proper mixing of magnetic resin and
DNA sample.

At the end of the extraction, a results page will be displayed ting the
pass/fail status of each set of six samples.

At the results page click the “Export” button at th \)m center of the screen.
The Save As window will appear. “Save In:” shoul set to the “Report” folder
on the desktop. This is a shortcut to the_dpollowing larger pathway: My

Computer\C:\Program Flles\Genong\Expo@port

In “File Name:”, name the re@n t at MMDDYY.HHMM. Set “Save
As Type:” to Result F|I Instance, an extraction performed at
4:30pm on 5/14/06 woul 51406.1630.csv.

Click “Save". v C)O

Drag a copy of the resul@unto the appropriate LIMS SHARE folder.

Proceed with clean@ nd sterilization.

Post-Extraction CIea()) and UV Sterilization

Remove ﬁq les (from the 8 degree (front) cold block) from the robotic platform
newly labeled screw caps.

and @
\Nig own the robotic platform and waste chute with Ethabsdh NOT USE

AY BOTTLES. Discard used pipette tips, sample tubes, and sample

Qreparatlon plate(s).

Replace the lid on the magnetic resin reservoir and vortex remaining resin
thoroughly. Discard the Magnetic resin immediately with a 1000uL pipetteman.

Rinse the reagent container with de-ionized water followed by ethanol and store
to dry.
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4. Cover all other reagents and seal with Parafilm for storspeKE SURE

10.

11.

12.

QO

RESERVOIRS ARE LABELED WITH THE LOT NUMBER OF THE
REAGENT THEY CONTAIN and that the lot numbers have been rec?T/ed.

and all racks should be full. Ensure that the pipette tips are ¢ y seated in the
rack and flush with the robotic platform. '\\

Click “Next”. \Q

When prompted, “Do you want to perform a UV s@ﬂization of the worktable?”,
click “Yes”.

Select 1 Hour for the time of @sterllll@‘n then click “yes” to close the

software upon completion. ‘

Store the extracts at 2 t@roze&

In the LIMS syste ?{awgﬁfthe Data Entry page, assign the samples to a
storage unit (cryobox rt instrument data.

Have a supervisor a%% the run, and submit samples at 1/10 and/or 1/100

dilutions, as need r real-time PCR analysis to determine human DNA
concentration I@ Section 4 of the STR manual).

Replace tips on the instrument that were used during run. T?h’i}g'&e three racks,

PLATE ANY COMMENTS ARISING FROM THE RUN.

&

O

COMPLE@HE M48 USAGE LOG WITH THE PURPOSE, PROGRAM,
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H. BioRobot M48 Platform Diagram
L ]
|—Ar-1—| C-1 C-2 C-3 \(L
A2 \(
A3 \
A4 '\\ I
D5 D.g§ D.7 D 3 \Q
| LI
A4
G-2
N
—e & @ F
[ 7" 1 i S i
B-3 | ’QA
I A Q)
. P NIPAN
\v \4

Figure 1. Diagram of R

B
ffboa.'g

E
PO
0\‘»

QO

(1-2)

otic F@lyorm of the QIAGEN BioRobot M48.

1- ()\arge Reagent Reservoir Positions
) Small Reagent Reservoir Positions

A (
é) Tube Racks 1, 2, and 3
)

Sample Plate Holders
Hot Elution Block (65 degrees)

Cold Final Elution Block (8 degrees)

Sample Tube Racks

Waste Disposal Chute
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Troubleshooting

Error Cause/ Remedy
Resin/sample is being drawn up into Report problem to QA. Resin buff%ﬁ
pipette tips unequally evaporated. O-rings are Ieakm@i 4d
service.
Crystallization around®irow of wells in | Forgot to fill empty samq@{&és with
sanple plate 200uL of sterile HO
BioRobot M48 cannot be switched on BioRobot M48 \'}recelvmg power.
Check that the cord is connected {o
the workstatioQ and to the wall
Computer cannot be switched on Q Com S not receiving power.
Q ec he power cord is connected {o
‘A th uter and to the wall power outlef.

BioRobot M48 shows no move@ﬁ Wh(& obot M48 is not switched on.
a protocol is started K C eck that the BioRobot M48 is switcheq
"adll

BioRobot M48 shows abnorm \ The pipettor head may have lost its hom
movement when a protocol { ted | position.
In the QIlAsoft M software, select “dhual

v

(-\Q Operation/ Home”.
Aspirated liquid drip m disposable | Dripping is acceptable when ethanol is
tips. \, being handled. For other liquids: air is
Q leaking from the syringe pump.
Report problem to QA. O-rings require
@ replacement or greasing.
0 If the problem persists, contact QIAGEN

FO Technical Services

Revision History:
March 24, 2010 — Initial version of procedure.
September 24, 2010 — “Total Volume of RNA Treated MagAttract Resin (uL)” in table on Page 5 (in Step C.12) were
corrected.
July 16, 2012 — Revised procedure to accommodate LIMS.
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Note: The High Sensitivity/Hybrid Team must follow the Microcon YM100 procedure in
Section C of the High Sensitivity DNA Extraction procedure.

pL. See Table 1 for minimum sample concentration requents. Refer to the LIM

In order to allow for duplicate amplifications, the final volume should be betwegh 2’-2%]
al
for Forensic Biology for specific procedures within the LIMS system.

1. Fill out the Microcon documentation. Label a sufficient number of.b (elmcrocon
YM100 sample reservoirs and insert each into a labeled collectj S.

A. Pipet 100 (L of TE™ solution into each labeled samq@rvow includimeg

Microcon negative control.

B. Alternatively, pre-coat the Microc6mmembran @n Fish Sperm DNA or a
1/1000 dilution of Poly A RNA in &adlaté&ﬁcrocentrifuge tube or 15 mL
tube:

a. Fish Sperm DNA \%rati6ﬁ
I. Add 1 @ stﬁfgh Sperm DNA solution (Img/mL) to 199uL
of irradiated for each sample on the microcon sheet.
i Aliquot % of this Fish Sperm DNA solution to each
Mlcro ube. Avoid touching the membrane. The volume for

ple is shown below. Refer to the microcon documentation
me calculated value.

b. Fw RNA Preparation

@ Make a 1/10 dilution of Img/mL of Poly A RNA as follows: add 2
0 puL of Poly A RNA to 18 uL of irradiated water and mix the
C) solution well. This is a final concentration of 100ug/mL.

Q il. Using the 1/10 dilution, make a 1/100 dilution with 2 uL of
100ug/mL Poly A RNA in 198 uL of irradiated water and mix the
solution well. The solution has a final concentration of 1 ng/uL.

iii. Add 1 uL of the 1ng/uL Poly A RNA solution to 199uL of water
for each sample on the microcon set.
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iv.  Aliquot 200 uL of this Poly A RNA solution to each Micro€on
tube. Avoid touching the membrane. The volume fasample
is shown below. Refer to the microcon documentation for

calculated value. (1/

Reagent 1 sample

Water 199 pL (1/
Fish Sperm DNA (1mg/mL) \

or Poly A RNA (1ng/ul) Lutb Q\

NOTE: For samples with 400 pL of digest solution,@e a 20 pL solution of
1 uL of Fish Sperm DNA (Img/mL) or 1 yL ofPoly A RNA (1

ng/pL) with 19 pL of water. Mix weII dd this solution to the
membrane. Ensure that entlret e membrane is covered.
In this manner, all of th added to the Microcdh
membrane for a total@

2. Process 50 |1 of TE* soluti d&g) ater as a Microcon negatwetiol. Make

sure to use the same lot tha€will beLusgd to dilute the samples, and don'’t forget to label
the final negative control tube Wlﬂ\he Microcon date and time.

3. Spin each DNA sample br@&Have a witness confirm the order of the samples and

Microcons. O

4. Add each sample (0. maximum volume) to the buffer in the reservoir. Don’t
transfer any Che eads, or in case of an organic extraction sample, any organic
solvent! Seal witivattached capvoid touching the membrane with the pipette tip!

6. Return t% inal extraction tubes to their storage location. Do not discard the empty
tubes.

7. he Microcon assembly into a variable speed microcentrifuge. Make sure all tubes
are"balancedTo prevent failure of device, do not exceed recommended g-forces.

8. Spin at 500 x g (2400 RPM, Eppendorf) for 15 minutes at room temperature.

** FOR CONCENTRATION ONLY, SKIP STEP 9 AND PROCEED TO STEP 10 **
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10.

11.

12.

13.

14.

15.

**FOR CONCENTRATION ONLY, SKIP STEP 9 AND PROCEED TO STEP 10 **

FOR PURIFICATION of the DNA sample add 2Q€L of TE* solution or irradiated

water and repeat Steps 7-8. Do this as often as necessary to generate a clear extract, and
then continue with Step 10. When performing multiple wash steps it is ne y to
empty the bottom collection tube intermittently. i\

NOTE: When purifying samples with a low DNA concentration it @ advantageous
to use several wash steps and to also reduce the volu R; chieve both, a
cleaner sample and an increased DNA concentration.{@

Remove assembly from centrifuge. Visually inspect each'microcon 100 membrane tube.
If it appears that more than 20 pL remains above the mémbrane, centrifuge that tube for 5
more minutes at 2400 rpm. This processymay be ra@ed as necessary.

Open the attached cap using a tube er gd. Avoid touching the

>

membrane with the pipette tip! Sepanate colle tube from sample reservoir.

Place sample reservoir upsid &\Nn i leed collection tube, then spin for 3
minutes at 1000 x g (3400 Eppendorf). Make sure all tubes are balanced!

Remove from centrifuge and s@ete sample reservoir. Measure resulting volume using
an adjustable Micropipette, m-éQ volume on worksheet; adjust volume to desired level
using TE* or irradiated watén

O

A. Clean-up for hGU)DNA concentrations: reconstitute to starting volume.

B. Low DNWI% (clean-up and/or concentration): adjust to 20-50

(dependi amplification system)

Transfer A extracts and the Microcon negative control to newly labeled 1.5mL

@ulate resulting concentration or submit to real-time PCR analysis to find the new
DNA concentration.

ATTENTION: Do not store the DNA in the Microcon vials! The lids are not tight
enough to prevent evaporation
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Troubleshooting:

Lint, bone dust and other particles can clog the membrane. If the liquid does not go down,
collect the sample from the filter and redistribute the supernatant to multiple filters or a new
filter. Pipet off the clear supernatant without disturbing the particle pellet. Microco %gatlve
controls should be treated accordingly. C’\

If the problem persists, the specific Microcon lot number might be faulty. N{bthe QA Unit
and try a different lot number. Q

TABLE 1: '%
Identifiler O | Ide

28 cycles {ycles

Minimum Desired Template @DO%@' 720.00 pg
- N

Template volume for amQ:,\\s 5 é\ 5uL

Minimum Sample O (?E‘

Concentration in Z(ﬁ (' @ g/uL MMpg/uL

v f

Minimum Sample

Concentration in 200 &“q 5 pg/uL N/A

to Microconning* to &

Minimum Sampl .
Concentratio O uL prior | 2 pg/pL 0-“;0:_0 0.10
to Mlcrocow to 20 pL Pa/H

For LCN?&YpIes. Minimum 4.00to ~1.00
@ ncentration in 20 U 20.00 pg/pL pg/uL

Sam
* &)mple concentratioprior to processing with a Microcon 100 and elution to 50 pL
**0 Sample concentratioprior to processing with a Microcon 100 and elution to 20 pL
C) Samples with less than 20 pg per amplification may be amplified upon referral with the

O LCN supervisor

—

Revision History:
March 24, 2010 — Initial version of procedure.
September 27, 2010 — Inserted note to direct the High Sensitivity/Hybrid Team to follow the Microcon YM100 procedure in
Section C of the High Sensitivity DNA Extraction procedure.
July 16, 2012 — Specific worksheets were removed and replaced with generic terminology to accommodate LIMS.
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A. Work Place Preparation
1. Retrieve clean racks, cap openers, Rotorgene 0.1 mL tubes and caps,

microcentrifuge tubes, and irradiated GIBCQLTRA PURHI distilled er
from storage or the Stratalinker. ?ﬁ/

2. Apply 10% bleach followed by water and/or 70% Ethanol to thg@e work
[

surface. Cap openers, racks, and pipettes may be cleane lar manner.
For LCN samples, all Rotorgene setup steps should be out under a
hood.

a. For LCN samples, the 1.5 mL mlcrocentrlfug@\%es and water aliquots in
1.5 mL tubes must be irradiated for 30 and 45 minutes, respectively.
b. Rotorgene tubes and caps g used a\;@: aged.

<
B. Sample Dilution A 6\(\
If necessary, dilute the san&

g(lract |th HCN samples).
1. Label microcentrifuge’di @oes with sample name and dilution.
2. Place each dilution t%@ectly behind the corresponding extract tube in a rack.

3. Add the appro @ mount of diluant (irradiated water or TE) to each dilution
according to 1&3} 1

a. Sexudl] assault semen and saliva samples, scrapings and other samples that
a racted with the “Chelex other” or M48 method, and bone samples
Id be measured with a neat and a 1/100 dilution.
b. ood and buccal samples and all burglary samples may be measured with

0 a 1/10 dilution only. This will capture most concentrations. If necessary,
C) a second measurement may be taken with either a neat or a 1/100 dilution.
QQ LCN samples should be measured with a neat dilution. If necessary, a
1/10 dilution may be made if one suspects inhibition.
d. Pipet tips do not need to be changed to add water/TE to empty tubes.
Close all caps.

4, Open only one sample and its corresponding dilution tube at one time.
5. Thoroughly mix each extract, prior to aliquotting.
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6. Immediately following each dilution, return the original sample extract tube to its

cryobox. Return the original samples &C4torage.

7. Once the dilutions are completed, evidentiary samples may join exe

dilutions on the benchtop.

y

TABLE 1: (LQ
\
Submission 1 Submigsjon2
L Water | . .. N Water
Dilution 1 | Sample | ~-TF | Dilution 2 \\ mple | [ TE
HCN N
Semen and saliva
(amylase posiive) | Neat 5uL |0 1/1c6§ 2 uL 198 pll
samples A (;\'
HCN 2 O\Y
Scrapings or Neat 5 uI:\A 0 6\(}/100 2 uL 198 pUl
“other” extractions NN | L
HCN exemplars N ﬁ)‘
Bone Neat v;&\p’l_ ~ 1/100 2uL | 198pll
HCN exemplars 1/10 ) 5 | 18 yL | 1/100 or neat | 2 ul or | 198 L
Blood or Saliva H (if necessary) | N/A or N/A
HCN ~ 1/100 or Neat| 2 pL or | 198 uL
Blood Samples 1/10 ON WL 18l (if necessary) | N/A or N/A
Touched objects Q)
and/or LCN N@ N/A N/A %lﬁlnoecessar ) 2 pL 18 pL
Samples X y
W\
In order to c ve, neat LCN samples may be taken from the extract tube and added to
the quantitatidn tube directly (no neat submission tube is necessary). However, 1/10
dilutio uld be prepared in advance as specified above.

O

R

ove reagents for the master mix from the reagent freezer/refrigerator

1. Retrieve MgC}, 10X PCR buffer, BSA, dNTPs, TAQ GOLD, unlabeled “EB1”
and “EB2” primers, and SYBR Green | from the freezer, irradiated GIBCO
ULTRA PURH] distilled water from the refrigerator, and DMSO from the

cabinet.

Controlled versions of Department of Forensic Biology Manuals only exist electronically on the
Forensic Biology network. All printed versions are non-controlled copies.



FORENSIC BIOLOGY PROTOCOLS FOR FORENSIC STR ANALYSIS

ESTIMATION OF DNA QUANTITY USING THE ROTORGENE ™

DATE EFFECTIVE APPROVED BY PAGE
07-16-2012 EUGENE LIEN 30F 19

2. Store reagents, except DMSO and water, in a Nalgene cooler on the bench.

3. Record lot numbers of reagents.

4, Just before initiating “sample preparation”, place MgC0X PCR b NBSA,
dNTPs, and unlabeled “EB1” and “EB2” primers on a 48-positi
microcentrifuge rack in order to thaw these reagents. '\\ i/

D. Standard Curve Preparation Q\

1. Retrieve 1600 pg/pL standard DNA from the free(er and record lot #.

2. Ensure that the contents of the é@ g/u dard DNA tube are thawed and
removed from the cap, by cem ing th

3. Labeltubes as follows: 4@ 6‘@ , 1.56, 0.39, and NTC (no template
control or O pg/uL). K O

4. Add 15 pL of |rrad|atz~w teNe’'tubes 400, 100, 25, 6.25, 1.56, 0.39, and the
NTC. Pipet tips do not néto be changed to add water to empty tubes. Close all
caps.

5. 0.25 Serial dil OQ

In order to rHix each dilution thoroughly, either pipet the dilution up and down

several tj or vortex each dilution and subsequently centrifuge the tube at no

mor% 000 rpm for 3 seconds.

%)0 Open only two consecutive standard DNA tubes at once starting with the
1600 and the 400 pg/uL tubes.

QQ Mix the DNA solution in the 1600 pg/puL. Take 5 pL of standard DNA at

1600 pg/pL and add to the 400 pg/uL tube, and thoroughly mix the
contents.

C. With a new pipet tip, take 5 pL of standard DNA at 400 pg/pL and add to
the 100 pg/pL tube, and thoroughly mix the contents.

d. With a new pipet tip, take 5 pL of standard DNA at 100 pg/pL and add to
the 25 pg/uL tube, and thoroughly mix the contents.

e. With a new pipet tip, take 5 puL of standard DNA at 25 pg/uL and add to
the 6.25 pg/pL tube, and thoroughly mix the contents.
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f. With a new pipet tip, take 5 pL of standard DNA at 6.25 pg/pL and add to

the 1.56 pg/uL tube, and thoroughly mix the contents.
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g. With a new pipet tip, take 5 pL of standard DNA at 1.56 pg/pL and add to
the 0.39 pg/uL tube, and thoroughly mix the contents.
h. Do not add anything to the NTC tube.

E. Sample Preparation '\(1/

1. Remove 1500 pg/uL calibrator from freezer and record lot nu

a. Vortex the calibrator thoroughly and centrifuge th l!be\at 3000 rpm for
approximately 3 seconds. %

b. Make three 0.166 dilution (1/6) of the cahbratb&th 4 uL of the
calibrator and 20 pL of irradiated water

2. Vortex all samples including the @dards@é calibrator, and the dilution
and/or extract tubes. é

3. Centrifuge all samples brj r3 ds at no greater than 3000 rpm; this will
prevent the DNA from gat@ the bottom of the tube.

4, Witness Step:
Arrange samples in ordeéscordlng to the sample documentation in a 96 well

rack

a. Place sampl@'exactly the same place on the rack as they will appear
verticall jttoned in the rotor.

b. Label tRe tbp of the sample tubes with rotor well identifier or tube labels.
Havéq'wnness confirm the sample locations.

2

F. Master Mi aration

1. éﬂmove the SYBR Green | from the Nalgene cooler and prepare a 1/100 dilution.
ake 2 uL of SYBR Green | in 198 pL of irradiated water, vortex, and tap the
tube on the bench to consolidate the reagent at the bottom of the tube.

2. Mix each reagent before adding.
a. After each reagent has thawed, vortex each reagent, with the exception of
TAQ GOLD.
b. Centrifuge reagents in the table top centrifuge at 3000rpm for

approximately 3 seconds.
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Add each reagent in the order as it appears on the documentation. Thoroughly
mix each tube reagent by pipetting up and down, or vortexing briefly. If
vortexing, afterwards tap the tube on the bench to prevent the reagent from being
trapped in the cap.

For total reagent volumes above 20 uL, use a P200 even for multi spenses as
opposed to one dispense with a P1000. To ensure accurate pi g, aspirate and
dispense the reagent as specified on the run sheet. '\\ '/

After adding each reagent, place the reagent back in th @Igene cooler, or for
water and DMSQO, in the opposite corner of the 48 w icrocentrifuge rack.

Thoroughly mix the master mix by vortexing. the tube on the bench to
prevent the reagent from being tra edin th and/or centrifuge briefly for
approximately 3 seconds.

Add 23 pL of master mix to k\appro@ number of Rotorgene tubes. Fill
tubes in a vertical faShIO@SItIO or Al to A8, and B1-B8 in older rotors).
After adding master mi 6 re-vortex the master mix and ensure all of
the master mix is co@dat apping the tube on the bench and centrifuging
briefly for approximately 3§e ds. Use a new pipette tip.

See Table 2 below f &Qent concentrations; calculated amounts for n+10%n
samples will display&hded values for pipetting

C)O
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TABLE 2:
Reagent Concentration uL*for 1 Rx
Irradiated GIBCO O ULTRA
PURED distilled water 8.3 (8'2?\
10X PCR Buffer 10mM Tris/5SomM KCL | 25 N V'
25 mM MgCl, 275 UM 2(8)(215)
5 mg/mL BSA 0.525ug/pL N M\-OV
2.5 mM dNTPs 200 ypM each Q» 2.0
DMSO 8% A [2.0(1.96)
. . \
1/100 dilution of 10,000X SYBR 100X K 0.3 (0.28)
Green | Fa
O
20 pmol/uL Primer EB1 é)4 M ()\\ 0.5
: (%
20 pmol/uL Primer EB2 . \<P0.4uNN 0.5
\‘ N
5U/UL ABI Tag Gold N\ 1(@ 0.3 (0.25)
N \)
Total volume (0 ,..O 23.00

*Reagent amounts ar

e?ﬁ?ula g two significant figures. However, for the
purposes of manual additio ne significant digit is shown.

G. Sample Addition

1. In order to avoi tqg? ation of aerosols, thoroughly mix the contents of each
tube by pipettiog up and down repeatedly.

2. Add 2 pL \5ch sample, including the standards, NTC, the calibrator dilution,

a. ecessary,

in order to conserve sample, only 1 pL of sample may be

and tgi@nple dilutions and/or extracts, to each tube with master mix.
m

easured. Note this on the sample documentation and double the
resultant value to accurately reflect the sample’s concentration per

O microliter.
Q b. Every four reaction tubes, place caps on the tubes. (The caps are attached
in sets of four.)
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C. Number the first cap in every set of four as they will appear in the rotor.

(1 for 1, 2 for 2, etc. For the older rotors, 1 for Al, 5 for A5, 9 for B1 etc.)
DO NOT label the tube itself, as this may interfere with fluorescent

detection.
3. Create an Excel sheet and save it in the appropriate folder on th rk.
4. Enter run information in the Rotorgene usage log. '\\(1/
5. Open the machine. Remove the circular rotor from the \ ment by either
pressing in the middle silver stem in the RG6000 or ewing the center piece
in the RG3000. Remove either the silver clip from G6000 rotor or the silver

ring from the RG3000 rotor. Add tubes to the rog. Ensure that tube 1 is in
position 1, etc. or in older rotors, 18in posit@ etc.

6. Ensure that all positions on tk&@br are@ (using blanks if necessary).
0\ \

7. In the RG6000, add the si clip &V’%Qotor, lock into the Rotorgene, and close
machine. In the RG30 ddt er ring and screw the rotor into the
Rotorgene, locking t torgpe. Ensure the silver ring is in place and sitting
securely in the rotor oh alksides. Close machine.

H.  Software Operation \&O
1. Open Excel and.t levant sample sheet, and then collapse the window.
2. Open Rotorgene 6 software on the desktop.

3. Click Ei ew, Casework, and click “new”

4. I wizard
Ensure that the “Rotorgene 72 well rotor” is highlighted

Make sure that the box next to “locking ring attached”, is checked.
Q c Click “Next.”

d Type initials for Operator and add any notes (extraction date/time)
e. Reaction volume should be “25 pL”

f Sample layout should be “1, 2, 3...”

g Click “Next.”
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h. In the RG3000s, click “Calibrate”. In the RG6000, click “gain
optimisation”.
I. “Perform Calibration before®lacquisition”

ii. Click on “calibrate acquiring” (RG3000) or “optimize acquiring”
(RG6000). ?'L/

iii. “This will remove your existing setting for auto gair@ﬁr tion?”
The window appears, click YES. A green gain will open.
Click “ok”, then “close”.

Iv. Note selecting “calibrate all” will attempt to te for all
channels known by the software Whereas b ate acquiring” will
instead only calibrate those that have b sed in the thermal
profile defined in the run such as FA reen.

V. Click next in wizard and “start run”.

5. “Save as” the RG#, date and tim @( exam&“RGlQllZQM.MOO” for a run on
RG1 on Nov 29, 2004 at 2: oo@m LOK Ive folder
6. Sample sheet window

a. Expand the Exc(gampleogaet window. Copy all of the control and

Rotorgene sampl dow by right clicking and selecting paste.
C. Settings:
I. Give entration format: 123,456.78 unit pg/pL
il T egory
Standards: std
2) Zero standard: NTC
) Samples and calibrator: unk
&Q In all wells with standard, calibrator or sample, select “YES”

%) Hit “Finish”

sample name%
b. Paste the control a§d ple names in the appropriate rows in the

Q See below for cycling parameters that should not be changed:
95°C 10 min
94°C 15 sec
o 35
68°C 60 sec cycles
72°C 30 sec
72°C 15 sec
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Therun will approximately require 1 hour and 40 minutes for completion.

7. Following the initial heating to activate the TAQ and the gain calibration, the raw
data will appear on the screen. With this information, one can monitor the
progress of the run. Fluorescence for the highest standard should fipparent
from ~ cycle 15.

8. Previous run files may be examined while the computer is cio\Ng%'mg data.

a. Collapse the window.

b. Double click on the Rotorgene icon on the deskt

C. The computer will prompt that another version e software is running
and ask if you want to run an analysis versi&w y. Click yes.

Clean Up 6 5\'<>K

1. Return water, dNTPs, Mgﬂl%@tR bu@ls SA, DMSO, EB1 primer, EB2
primer, TAQ GOLD and wa’eg bes v@a y remaining reagents to the working
reagents box. C) OK

2. Dispose of all dilutio@es g?standard, calibrator, and SYBR Green |.
Sample aliguots may be SQ ntil assay success is confirmed.
J. Sample and Data Storage \go

1 Store extracts | %box in the DNA refrigerator. For LCN, the extracts should
be stored int A refrigerator in the pre-amp room in the designated area.

2. Ensure thdt the data from the assay is in the folder labeled “RG data” under the
appro Rotorgene folder.

3. T@ sfer over the Rotorgene data to the network:
After the run is done, save and exit out of the Rotorgene software.
Q). In the Log Archive, go to the appropriate run folder.
Q C. Copy the run into the appropriate Rotorgene “RG data” folder on the
network.
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K. Analysis
1. Analysis may be performed on the instrument computer or any computer that has

access to the software.

2. Open Rotorgene software on the desktop. If the computer is nected to an
instrument, when the software indicates that the computer \ connect to the
instrument on serial port COM1, select “run in virtual mo

3. Click “Open” and click on the run to be analyzed in t?‘@\G data” folder

4. Click “Analysis” on the toolbar. K
a. Select “Quantitation”, “Show”

I. Three wmdows WI|| W|th tandard curve, the samples, and
fluorescence.

il If a “Calculate at| hold" window opens up, click ok.

iii. Ensure th aml and “slope correct” are selected on
the tool

iv. Select§ 1 settings”.

suke the NTC threshold is set to 10%.
2) The under the “reaction efficiency threshold” should
e selected however.

3) “OK”

V. If the settings need to be corrected, “auto find threshold”

ust be performed again. (“Auto find threshold” can be found in
the lower right corner of the screen if the “Quantitation Analysis”
@ graph is selected.)
b. eck if any sample curve crosses the threshold at an early cycle due to
background fluorescence. The sample in question would have no value,
C) but the normalized data would display a curve that crosses the threshold
QO both at an early and at a later cycle.

Controlled versions of Department of Forensic Biology Manuals only exist electronically on the
Forensic Biology network. All printed versions are non-controlled copies.



FORENSIC BIOLOGY PROTOCOLS FOR FORENSIC STR ANALYSIS

ESTIMATION OF DNA QUANTITY USING THE ROTORGENE ™

DATE EFFECTIVE APPROVED BY PAGE
07-16-2012 EUGENE LIEN 12 OF 19

In order to avoid disabling the dynamic tube normalization setting, move
the threshold to the right, ignoring the first few cycles, so that the sample
does not cross the threshold. This can be achieved by the following:

I. In the normalized data windowpane, on the lower rig t%, under
CT calculation, change the number for “Eliminate efore:”
from O to 1-5. Chose the smallest number wher hreshold
does not cross the data curve in question. x

il. Alternatively, select the grid immediately to N ht of “Eliminate
cycles before”. This allows manual mani on of the starting
cycle number of the threshold.

iii. Reanalyze the data by selecting “autoh%q threshold”.

C. One may also manually magipulate tf@cal position of the threshold
on the standard curves. 6

I. Select the grid to

the red thresh¢

vertically wij

right threshold value and then click on
ne a ust the line. Moving this line
different

et % shold cross the standards’ curves at
S an@s will change the efficiency, Ct, and sample
values. QJ
il. Position*thedin optimize the distance between the Ct values of

the standa@ nd thus the calibrator values, while maintaining a
passings@ ncy value.

5. Save the RG @(D’?ject.
N
L. Report
)

1. On l@uam results” screen, (by right clicking the table heading with the mouse
a@ -checking certain columns) only pick the following columns: No., Name,
O , and Calc. Conc.

2. If the No. column shows the well location instead of the number, select
“Samples” from toolbar. Under “format”, select “Toggle Sample ID Display”.
Click “OK”.

Controlled versions of Department of Forensic Biology Manuals only exist electronically on the
Forensic Biology network. All printed versions are non-controlled copies.



FORENSIC BIOLOGY PROTOCOLS FOR FORENSIC STR ANALYSIS

ESTIMATION OF DNA QUANTITY USING THE ROTORGENE ™

DATE EFFECTIVE APPROVED BY PAGE
07-16-2012 EUGENE LIEN 13 OF 19

3. Select “Reports” from toolbar
a. Select “Quantitation, cycling A FAM”
b. Select “full report” double click
C. Generate report

4, Supervisors must initial all pages of the report after reviewing th Q(aksmd
incorporate them into the case record. %

M. Assay Interpretation Q’\\(l/
Standards and Controls Q\

1. Check the raw data for cycling. (If the raw data graph is not seen, click on
“Cycling A.FAM” in the tool bar and then “Ar@) If the fluorescence is
below 80 RFUSs, yet the reaction iency | eptable (see 5), determine if the
SYBR Green | was thawed mo @han e@ f not, notify QC in order to test
stock. The assay still pass ’s\ Ionié nditions 2b and 3 are fulfilled.

2. Confirm that the followi géettinbge correct:

a. standard cur or

b. Start normalizihg fr. le “1”

C. noise slope correé& “yes”

d. reaction effici reshold “disabled”

e. normalizatio od “dynamic tube normalization”
f.

g.

digital fi t’
no template control threshold “10%”

3. Slope o%@s}m: 3.322
4, R%@optimum: 0.999

5. &éaction efficiencies should range from 0.80 to 1.15. Efficiencies svended
Q own. (For example, 0.799 fails.)

6. Two of the three calibrator values must be between 400 pg/uL and 100
pg/uL.
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7. No template controls or zero standards should be < 0.1 pg/uL.

10.

11.

12.

13.

If the no template control is > 0.1/pd., LCN samples may be amplified since
there may not be sufficient sample to retest. However, HCN samples must be re-

guantitated. '\

The difference between the average Ct values of each conse uplicate
standard concentration should be approximately two cycles’\\

(“clicked on”). (If #10 is exercised, at least one of ea plicate standard
concentration should be apparent for 5 of the 7 remainihg standardslj one
duplicate of a standard does not yield the expectﬂd Ct value, but the other
duplicate is within the expected range, the a t standard may be excluded
from the standard curve calculatié&nsel% e sample on the right side of the

screen, and reanalyze. . (\
’ ‘Q N

are not within the expected range, they
ard curve calculation, and if all the other
ctory, the assay passes. However, no more
absent.

At least one of each duplicate standard concentration SS@ be apparent

Similarly, if both replicat \@a sta
may both be excluded t& the
parameters of the a are
than two standard pairs mQ
The assay fails if the on efficiency, calibrator and/or non-template control
values are unacce .

For LCN samp@g In order to preserve sample, if the quantitation assay fails
twice, procé@l' to amplification without a third quantitation.

Initiat @ksting of all samples in a failed run. Although a quantitation assay may
falil @esultant values may be used to estimate the need for further dilutions for

?}v}-quantitation assay.

QO
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TABLE 3:
Required Settings Required Results
Parameter Value Parameter | Value
Start normalizing .
from cycle 1 NTC < 0.10 pg/uL X q .
Noise slope . NY
correction yes Calibrator 100 to 400 pg/‘;Q
Reaction Efficiency | . Reaction \ 3
threshold Disabled Efficiency 08010 1'& l/
Normalization Dynamic tube | Ctvaluesof | ~2c¢ etween each
Method Normalization | standards cogrceitration
- . . Standards Mre than 2 pairs may
Digital Filter Light analyzed ¢ lmbsent
No template control . ()} <1000 pg/uL or dilute and
threshold 10% ehSampleri\' re-quantitate
U
1 *

* May change if a sample curve ct sthet Id early (refer to Section M.4.b.ii. of this
section).

N. Creating a Rotorgene Sumv&%a&@gMS Import

1. On the Rotorgene Soft @ (main screen after analysis), go to the “Quant.
Results - Cycling F@lee (lower left window).

2. Maximize the @9 By right-clicking the table heading with the mouse and un-
checking c%a' olumns, eliminate all columns except the following:

N
Namge

ﬁ Conc.

3. Oqeen, right-click mouse and select “Export to Excel”.

hY

Save the data with the run name in the appropriate folder on the network.
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0. LIMS import

1. Inthe Data Entry screen for the LIMS system, import the associated .csv file that was
previously created and saved to the network. '\(1/

2. Have a supervisor review the imported results.
3. The interpretation value for each sample will be manually er@é@\by the reviewer.
P. Sample Interpretation Q\

1. Samples that are 1000 pg/uL and above should {Qe requantitated at a 1/100 or a
1/1000 dilution.

2. For amplification with Identifile @Powﬁ@{ or MiniFiler, if the extraction
negative is > 0.2 ggL it shol re- tated. If it fails again, the sample set
must be re-extracted pri% mplifi n.

3. For the YM1 system?&e e@@on negative is > 1 pg/uL it will need to be re-

guantitated.
o

TABLE 4: IR\

e . Sensitivity of Extraction Negative
A TEEEIE ’S_y @ Amplification Control Threshold
YM1 U 20 pg 1.00 pg/uL in 20 pL
Identifile&/Sl cycles 1 pg 0.20 pg/uLin 5puL
Powerlix Y 1 pg 0.20 pg/uL in 5L
MinfFi/er 1 pg 0.20 pg/uL in 5 pL

N

O

QO
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4. If a sample appears to be inhibited, i.e. the curve initially increases and then
plateaus, note this in the interpretation column.

5. If a sample displays background fluorescence, indicate such samples_in the

interpretation column.

N

6. If a sample displays low background fluorescence, i.e. approxss y 10% or less
of the total fluorescence, indicate this in the interpretation col\ %

7. The neat and the value calculated from the 1/100 diIuti@f the samples should

differ by no more than a factor of 2.5. If the dilutions%

2.5, the samples should be re-quantitated. '\

8. Table 5 (next page) summarizes v&ich conc

for amplification.

:&Q’ O

O

ot within a factor of

e@on should be selected, if any,

TABLE 5:
Samples A Resolution
N = x pg/uL \J \JJ
1/100 = within +/- 2@ C p Select neat value
N = x pg/uL N \V
1/100 = +/- >2.5x

fluorescence

No indication of inhib@n or backgroun

)

Re-quant samples.

N = >1000 pgfal)

Select dilution

1/100 = <10 /uL
N =>100 uL ]
Dilution<4000 pg/uL Requant sample at a greater diluti

on

g/uL, NO inhibition or

ion within +/- 2.5 fold

Not suitable for amplification with
Identifiler 28

fluoresence

= < 10 pg/uL, NO inhibition or

: dilution within +/- 2.5 fold

Not suitable for amplification with
MiniFiler

fluoresence

N = <7.5 pg/uL, NO inhibition or

Dilution within +/- 2.5 fold

Not suitable for amplification with
YM1

fluoresence

N = < 5 pg/uL, NO inhibition or

dilution within +/- 2.5 fold

Not suitable for amplification with
PowerPlex Y
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Samples Resolution

N = <1 pg/uL, NO inhibition or
fluoresence
dilution within +/- 2.5 fold

Not suitable for amplification with
Identifiler 31

N="%* * orA
Dilution NO *, ** or A and yields
sufficient DNA for HCN amplification

Xz
Select dilution Q\

(N

N = ** dilution **

Select dilution  p \ V'
v \‘

N=*orA
dilution * or A

Serd to analys\Q

(

Not swta efor amplification with

—_ * %%
g.‘ <7.5 pg/uL_, NO *, ™, or A YM1, Identifiler 28, MiniFiler, or

ilution not within 2.5 fold Pow X Y, no further testing
N ="or A 6 P%ﬁantitate at 1/10 dilution
1/100 Dilution <0.1 pg/uL ) ‘Q

A\ "4 N

1/10 dilution only = ** . A mplify if sufficient DNA for HCN

I DNA testing.

1/10 dilution only = % C)O

If sample quant dictates a greater
than 1/10 dilution factor for amp,
proceed with amp.

Otherwise, send to analyst.

Any value less than O.@‘ﬂ@/uL

Do not interpret

N: neat

X: quantitation value \(
A: sample appearsto b ibited

*. sample displays ba@g ound fluorescence
**: sample display@»v background fluorescence

O

Q°

. N4
Table 5 Key:
QO
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References:

Nicklas, J. A., Buel, E. Development of Alu-based, Real-Time PCR Method for Quantitation
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Nicklas, J. A., Buel, E. Development of Alu-based, QSY 7-Labeled Primer ethod for
Quantitation of Human DNA in Forensic Samples

Revision History:
March 24, 2010 — Initial version of procedure.
July 16, 2012 — Paperwork Preparation section was removed and LIMS Import section was inserted.
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Batch processing

1.

Exemplars and evidence samples must be handled separately at all times. These samples
must never be together on the same sample tray.

For the ABI 31381, an exemplar and evidence plate may be in the same. ent. Two
separate plates are the equivalent of two consecutive runs.

Samples from one amplification set should be processed toget \that the samples are
accompanied by the appropriate controls.

Use the correct documentation for the specific sample typé‘q% make sure the sample
preparation set-up is witnessed properly. K

@nent and under the same, or more
les ¢ re that no exogenous DNA is
be r igher injection parameters must have an
ith t ples or have previously passed under the
par r

Controls must be run using the same in
sensitive, injection conditions as the

&
present. Therefore, samples that
associated control run concurre,

same, or more sensitive, in s. Controls do not have to be run at the same
injection parameters as the pIe reviously passed at a higher injection parameter.
NOTE: Eachrunthatis perf d must have at least one correct positive control.

Sample handling C)Q

1.

Prior to loading onXQ'e capillary, the amplified samples are stored at 4°C in the amplified
DNA area. The t@es containing the amplified product must never leave the amplified

<

DNA area

Amplifi §ples that have been loaded on an instrument should be stored until the
resis results are known. After it has been determined that the amplified
do not require repeated testing, they may be discarded.
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I nstrument and computer maintenance

1. Be gentle with all instrument parts and instruments. Keep everything clean.
2. It is good practice to monitor initial instrument performance. This enables tl(ely;er to
detect problems such as leaks, air bubbles or calibration issues. Q'\

3. Hard disks should be regularly defragmented to improve system p'e\l’fg%nce.

4. Data files and other non-essential files from the computer hard\®< should be deleted at

least once a week to improve performance. '\Q

5. Notify the Quality Assurance Unit if any problems are nQed.

Revision History:
March 24, 2010 — Initial version of procedure.
July 16, 2012 — Specific worksheets were removed and replaced with generic terminology to accommodate LIMS.
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GENERAL INFORMATION

The Identifiler Kit is a PCR Amplification Kit manufactured, sold, and trademarked by Applied
Biosystems (ABI). The YM1 Kit is a PCR Amplification Kit manufactured in-house that test for

four (4) Y-STR Logi. '\q/
Target DNA template amounts are as follows: (19
* Identifiler, 28 amplification cycles (ID28) — 500 pg in sample a@S pL

* Identifiler, 31 amplification cycles (ID31) — 100 pg in sample of 5 uL
* YM1 - 2000 pg in sample aliquot of 26 pL '\6

To calculate the amount of template DNA and diluant to add following formula is used:

Amt of DNA extract (L) =  ---------mm-qfip 5N

The amount of diluant to add reactioh) (uL) =
Volume of sample al§ (0 -@munt of DNA extract (uL)

AN

GENERATION OF AMPLIFICATIO\ ETS

To determine the appropriate s@ for amplification of samples, refer to Table 1.

TABLE 1: PCR amplificabp%r:“q&ut based on Rotorgene values

RG value at 1:10| R e neat pguL | Amplification Sheet |  Dilution
dilution pg/pL (
LCN extraction {\.* Amplify with 1D for _
>0.4 Dgﬂlro‘\ = 4.0°10 20 pghl p31ycycles* Neat =1
LCN/H Amplify with ID for As
ex 220 pgil 28 cycles appropriate
> 2. (L
Amplify with YM1
HSC extraction ~75 L or As
> 0.7 pgpL 275 pght Microcon and appropriate
amplify with 1D 28

* Samples providing less than 20 pg per amplification can only be amplified with the
permission of a supervisor.
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A. HSC Team Amp Macro (Evidence samples) for paperwork preparation for

amplification with Identifiler 28 Cycles and YM1

1. Open the “RGAMP Macro HSC” and the “RG summary sheet” Excel files for
samples ready to be amplified. The “RG summary sheet” is saved &(be assay

name.

a. If a window opens stating “ “...RGAmp Macro HSC.xIs” INS macros.
Macros may contain viruses...”, click “Enable Macro x

b. If a window opens stating “Macros are disabled b jbﬁ the security level
is set to High...”, do the following: Select Tools i % toolbar. Click

Macro, Security, and set the level to Low. Tp\ must be closed and

reopened.
2. Copy the sample information (withQut the st s or calibrators) from the
“summary sheet” of the “RG sum she including the tube label, sample

name, Ct value, the calculated centrafl

special as values into the@ pon{@s

“RGAMP Macro HSC” f”t) O
3. In the last column, egéd “@ﬁenter the type of amplification according to
the following abbreviations néxt'to the samples to be amplified:
a. “V” for ID28 Evidepde
b. “Y”for YM1 Evi@e

Selecting neafisainples versus diluted samples can be done here.

the target date, and the 1A, and paste
lumns of the “RG value” sheet of the

4, Check t@mple names to ensure that commas are only located after the full
e and before the dilution value (i.e. FB01-1234 vag_SF, 0.1).

sam&
@b& [+R or click the “Split dilutions & sample info” button to run the dilution

o

cro. A window asking “Do you want to replace the contents of the destination
Q ell?” will appear. Click “OK”.

The dilution macro will separate the dilution factors from the samples names to
facilitate the calculation of the neat concentration of the samples.

a. If the dilution column does not contain the correct dilutions, the file must
be closed and reopened. Check for commas in the wrong location in the
sample names.
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b. If the macro will not run, follow the instructions in the box and select

tools, macro, security, and low. The file must be closed and reopened.

6. Hit Ctrl+G or click the “Sort samples” button to run the sample sorting_ macro.
a. The macro will filter and eliminate all values that are less pg/uL
or 7.5 pg/uL for Identifiler 28 or YML1, respectively. Th o will also
sort the samples by system/type and sample concer}tr\b{i in the “Sort”
sheet.

b. Inspect the samples sorted in the appropriate co@s according to
system/type and sample concentration.

For Identifiler 28 samples, procéed to Step 7.
For YM1 san&les, prooq@?) Step 8.

S
a. Samples with c@aﬁo ﬁ een or equal to 20 pg/pL and 100 pg/pL
5

(less than or eq 0 mplified) may be automatically amplified in
duplicate; se co t analysis policy (section 1).

7. For Identifiler 28 samples: AQ

If you have not d \so already, select the samples that require
amplification n v&@ amplifying neat sample versus diluted sample).

appropfjaté columns on the “Sort” sheet to the associated columns on the

b. Copy a@@ Special as values all samples to be amplified from the
“Sarﬁp@s’ sheet.

&amples <100pg/uL will be sorted into a different section. Copy them
into the amp sheet as well.

C) = |f applicable, copy the Identifiler duplication samples (for samples
O <100pg/pL) to the “Identifiler 28 Evidence Dup” sections. This
Q amplification sheet may be used for automatic duplication of samples,
depending on the team.

Proceed to step 9.
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8. For YM1 samples:
a. Copy and Paste Special as values all samples to be amplified from the

appropriate columns on the “Sort” sheet to the associated columns on the

“Samples” sheet.

b. For samples being sent on for YM1 amplification from P
“Samples” sheet, change the Calculated Values coI

Iues on the
he appropriate

letter associated with the P30 value and sample t

For Non-Differential semen or differential swal@\bstrate remain samples:

concentrations m

Orifice swab Stalns N
e, G e
2ng subtract 0. 05 btra
HIGH \Q IGI—)\\\ ) A
1.1-3.0 ap‘ 1.1£'80 B
>0- 1.0 0310 C
U
For vaginal swab s

ngeg sent for Amylase Positive Extractions, two

e sent for amplification:

A\
Amounts to amplification Type this letter in the
= - Iculated Val lumn
ONA PGF@ TE? Calculated Value colu
o) 16 B
,\’\26 0 C

>
Q)

DUP2” or “YM1 27).

C. ﬁsamples being sent on for YM1 amplification from Quantification
alues, the amplification sheet should calculate the appropriate DNA and
TE* target amount on the amplification sheet.

f there are more than 28 samples for amplification, the overflow samples will
automatically be transferred into a second amplification sheet (i.e. “ID2”, “ID
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10.

11.

Saving Amplification Sheets on the Network for Additional @Ies

1.

When all samples to be amplified have been organized on the “Samples” sheet,
click on the appropriate amplification sheet(s) and check all entries for errors.

All changes, except for the amount of extract submitted during low and high
sample submission, should be made in the “Samples” sheet. '\

Save the entire macro workbook in the appropriate folder. (19

N

Partially full or completed amplification sheets mdy be saved as independent

sheets for subsequent sample additions by oli the “Samples” and amp sheet
tab (via holding the ctrl button do Both@, ts should now be highlighted
white. Right click and select or c

In this window, select “(r(@ook)” “to book” window and check “create a
copy”. Click “OK”. le, S s and save into the appropriate folder.

the Aliquot Request for opied and Paste Special from re-quantification
sheets or consolidat additional amplification sheets of the same type at the
end of each Rotorg@ un.

Samples may be ma aIIE d to these sheets by the rotation supervisor from

If any sample@d to be submitted to amplification with a DNA amount other
than the optignal amount, the rotation supervisor can change the amount of DNA
submitte changing the value in the DNA column in the amplification sheet.

Be a@ that once the DNA amount is manually added to the amplification sheet,
t eet will not be able to calculate the value from the quantification value.

QQ” other changes should be done in the “Samples” sheet.

5.

When a macro amplification sheet is full the rotation supervisor will add tube
labels and fill in the amplification date and time in the appropriate blue cell in the
“Samples” sheet. This should automatically populate the appropriate cells in the
Amplification sheet.

Any changes to the amplification sheet should be done in the “Samples” sheet.
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6. Save the sheet as the time and date of the amplification as follows:

“ID041207.1100" for Identifiler28 amplifications, or “YV041207.1100” for YM1
amplifications, performed on April 12, 2007 at 11:00am in the appropriate folder.

7. A supervisor should review all entries were entered correctly befor fﬂgﬂng the
Amplification sheet. ?\

B. RG Amp Macro X (exemplar samples) for Paperwork Preparat@\\r

Amplification with Identifiler 28 and YM1 Q\

2. For ID 28 samples, open the “RG summary @&Excel file for samples ready to
be amped. Copy the information lén the ary sheet” of the “RG summary
sheet” file including the tube la sa me, Ct value, the calculated
concentration, the target d e\ d th »and paste special as values into the
corresponding columns ‘RG " sheet of the “RGAmpMacro X” file.

1. Open the “RGAmpMacro X”.

3. In the last column, e?éd “@Qhe following information is already added:

“IDX” for ID28 ex lars

4, Click the “Separate@ﬂons and sample info” button to run the dilution macro.
A window aski @) you want to replace the contents of the destination cell?”
will appear. (@“OK".

a. h&wacro will not run, follow the instructions in the box and select

, macro, security, and low. The file must be closed and reopened.
b e dilution macro will separate the dilution factors from the sample

names to facilitate the calculation of the neat concentration of the samples.
QQ:Iick the “Sort samples” button to run the sample sorting macro.

a. The macro will filter and eliminate all values that are less than 20.pg/
for Identifiler 28.
b. Inspect the samples sorted in the appropriate columns and select the

samples that require amp. For instance, determine whether you will be
using the calculated concentration derived from the neat sample or the
dilution.
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C. Samples may be added or deleted to or from the columns following the

macro’s execution.

To delete a sample do the following:

I. On the “sort” sheet in the “RGAmpMacro X” file, locat %
columns relevant to the amplification system and s@’e ype.

il Select the cells relevant to the sample you woul delete.

iii Select edit and clear contents. :

Iv. Do not simply delete, always use the “clear, 6 ts” function.

To add a sample, do the following:

I. Copy sample info from the “RG value ed” sheet in the
“RGAmpMacro X” f|Ie the tube Iab sample name, Ct value, the
calculated concentr , the t ate and the IA.

il Paste special these es in appropriate columns of the
“sort” sheet in tt& Am o X" file.

6. Copy and paste all sam;&\) d from the appropriate column on the
“sort” sheet to the ass dco on the “samples” sheet. This is the sheet on
which you are bU|Id|$§ur

7. Ensure that all samples @e amped have been organized correctly on the
“samples” sheet and the appropriate amplification worksheet tab.

The sheet will cal e the dilution factor necessary for the samples as well as the
amount of sar@ and THor irradiated water to add.

8. Save the !@ero sheet in the appropriate folder.

<

9. For @samples, copy all information directly from the aliquot request form.
P special as values into the “paste Ys” tab of the “RGAmpMacro X".

]QQ)nce all samples are added, click on the “YM1” tab.

The sheet will calculate the dilution factor necessary for the samples as well as the
amount of sample and Tr irradiated water to add.

11.  Save the macro sheet in the appropriate folder.
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C. Aliquot Request and Amp Sheets for HCN evidence and exemplar samples only
Aliquot request sheets have been created for evidence and exemplar submission.
1. Open the correct aliquot request sheet. The sheet can be found in

M:AFBIOLOGY_MAIN\AmMp Sheets\ALIQUOT REQUEST FORM
EVIDENCE or EXEMPLAR)

2. Fill out the next empty line. Type the case information in 3

3. Refer to the calculation in this section of the Manual to d Ine the volume of
extract to be aliquotted, based on DNA concentration a rget for amplification.
If you want to amp your sample at a condition dlﬁere@an normal (reamp high,
low/opt/high, etc.) indicate this in the “Sample Infor tion” section.

4, Save the sheet. X

5. The person that aliquots the sam WI|| ty @ initials and the date they
aliquot the samples in the last col son will email all analysts listed
on the sheet indicating that sa n aliquotted. It is up to the analyst to
fill out the extract tracking f |th t uotting information.

6. The rotation supervisor |§§pon5| r preparing amplification sheets,
determining when the les aliquotted and that information that is typed

onto the amp sheets
D. RG Amp Macro HI (High t|V|ty samples) for Paperwork preparation for
Amplification with Identlfll and 31

1. Open the currﬁt)/ersmn of the “RGAMP MACRO HI” Excel workbook and the
“RG summaty sheet” Excel files for samples ready to be amped. These files can

be found.if the “TEMPLATES IN USE” folder on the High Sensitivity Data
drive. G Summary Sheets are saved as the assay name in the “Rotorgene”
fol the FBiology Main drive.

2. edpy the information for samples and controls only from the “summary sheet” of

e “RG summary sheet” file including the tube label (if applicable), sample
Q name, Ct value, the calculated concentration, the target date, and the IA. Paste
special as values into the corresponding columns of the “RG value” sheet of the
“RG Amp macro” file. The standards and calibrators need not be copied.
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3. In the column entitled “type” enter the type of amplification according to the
following abbreviations:
a. “X” for exemplars
b. "\/” for evidence
4, Note whether any sample has a comma in its name. If not, add a after one

sample’s name so that the macro will work. Click the “Separ tion and
Sample Info” button to run the dilution macro. A window askiRg o you want
to replace the contents of the destination cell?” will appe@ k “OK”.

a. If the macro will not run, follow the instructions i box and select
tools, macro, security, and low. The file must osed and reopened.
b. The dilution macro will separate the dilution féc;t rs from the sample name

to facilitate the calculation of the neat con@ntration of the sample

5. Click the “Sort Samples” button\téu@l tf@e sorting macro.
oun

a. The sort macro will filter es a Ing to the following specifications

which differ dependin; on th@ t of template DNA.

I. The macro \&ate alues that are less thanLpg/

il. Values b*\ﬁe'en 1 nd 20 pgiL are sorted for LCN
amplifi?ﬂbn ntifiler for 31 cycles.

iii. All values gn@?t han 20 pd/ are sorted for HCN amplification
with Identi @ or 28 cycles.

iv. Note, fd\' mples with greater than 100 pg/pL and less than 124
pg/uL@e macro will indicate to add 5 pL of template DNA. (In

avoid pipetting less than 1 pL, slightly more than 500 pg
A will be added to the reaction.)
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b. The extraction negatives will be sorted independently so that they may be

inspected and placed at the top of the list with the associated samples
when setting up the amp sheets.

C. Samples will be sorted into groups for ID31 evidence and exemplar amp,
and ID28 evidence amp. Samples amplified with Identifiler f K%cycles
are amplified in triplicate concurrently whereas samples with
Identifiler for 28 cycles are amplified in duplicate in two ate

amplifications.
N

6. Select samples for amplification and copy and paste th@amples to the
appropriate column on the “samples” sheet. The s information is then
automatically populated into the amplification and run sheets. Samples may
also be added or deleted to or from the amp shegs as described below. For
example, samples with less than 4pg/uL or amp require supervisor
approval for LCN amplification, a pen pon the case, may not be
amplified. Refer to the ampllfl n gui s and the RG interpretation manual
to select samples and the rlat \tions to use for amplification
calculations. C\;&

To delete a sample ?& WQ
a. Go to the “sort® sh e RG AMP MACRO Hl file and locate the

columns relevant @ne amplification system and sample type.
b. Select the cell ant to the sample you would like to delete.
C. Select edlt a@mar contents.

d. Do not lete, always use the “clear contents” function.

Toaddas ple do the following:
a. C e tube label, sample name, Ct value, the calculated concentration,
arget date, and the IA from the “RG values revised” sheet in the “RG
P MACRO HI" file.
%)0 Paste special as values into the appropriate columns for the amplification
system of the “samples” sheet in the “RG AMP MACRO HI” file.
Q. Alternatively, a sample may be manually added by typing the sample
Q information into the appropriate column in the “samples” sheet.
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7. Select the appropriate amplification worksheet, verify the sample information and

calculations, and type the name of the amplification in cell B1 as follows:
montrdateyear.time for example, 011106.1000.

a. The sheet will automatically calculate the number of sample %are to be
amplified. This will populate cell B2 of the worksheet. i\

b. The sheet will also calculate the amount of reagents re , and the
dilution factor necessary for the samples. Verify the;i\ﬁ lations.

8. Save the sheet in the amplification sheets folder (asmh %ear.time) and
review.

9. Print the amplification sheet. Have the sheet rerwed by a supervisor prior to

set-up. 6 \O

E. RG Amp Macro PC (Property Cri ’e&ampl QPaperwork Preparation for
Amplification with Identifiler 28. e A\

samples ready to be amp e “RG summary sheet” is saved as the assay

name.

a. If a window op\r{g ating “...RGAmp MacroPC” contains macros.

Macros maqu in viruses...,” click “Enable Macros”.

b. If a win ns stating “Macros are disabled because the security level
is set ta, Hiph...,” do the following: Select Tools in the toolbar. Click
Macm"Security, and set the level to Low. The file must be closed and
re ed.

1. Open the “RGAmMp P(Q@nd the “RG summary sheet” Excel files for
iGN

sample information (without the standards or calibrators) from the

ary sheet” tab of the “RG summary sheet” file including the tube label,

ple name, Ct value, the calculated concentration, the target date, and the IA,
nd paste special as values into the corresponding columns of the “RG value”

Q sheet of the “RGAmMp MacroPC” file.

3. In the last column, entitled “Type”, enter a “V” for Evidence.

The decision to sort neat samples versus diluted samples can be done at this point.
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4. Check the sample names to ensure that commas are only located after the full

sample name and before the dilution value (i.e. FB01-1234 “bottle_swab”, 0.1).
Press Ctrl+R or click the “Split dilutions and sample info” button to run_the

dilution macro. A window asking “Do you want to replace the cont n(sv the
destination cell?” will appear. Click “OK”. P’\

The dilution macro will separate the dilution factors from th é@ples names to
facilitate the calculation of the neat concentration of the S.

If the macro does not sort, this may be because no s es containing dilutions

are available to sort. In this case, clear the DiIution'bQ mn and try sorting again.

a. The macro will filter and eliminate a es that are less than 20.0 pg/uL

for Identifiler 28. .
b. Samples will be sortédifto fo mns: Negative Controls, ID28
samples, ID28 Im&) te DSQ nd ID28 Negative.

For Identifiler 28 san% (P Crimes):
a. ALL samples will lified twice; once as an initial amplification and

the second time uplicate amplification.

Press Ctrl+G or click the “Sort san&lles" bu;%@gun the sample sorting macro.
I

If you have n@bne so already, select the samples that require
amplificatigiytow (i.e. amplifying neat sample versus diluted sample).

b. Copyand Paste Special as values all samples to be amplified from the
a riate columns on the “Sort” sheet to the associated columns on the

&}*@

Note: Extraction Negatives do not need to be duplicated.

%Qf there are more than 28 samples for amplification, the overflow samples will

spill into the highlighted area of the Samples sheet, prompting you to make a new
amplification sheet.
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10.  Once satisfied that all samples to be amplified have been organized on the
“Samples” sheet, check both the initial and duplicate amplification sheets for
errors.

All changes, except for the amount of extract submitted during low l(lyvgh
sample submission, should be made in the “Samples” sheet. &

Saving Amplification Sheets on the Network for Additional Sam J%\\
1. Once complete save each amp (initial and dup) in i}s\@\pective folder.

2. If any samples need to be submitted to amplification with a DNA amount other
than the optimal amount, the amount of DN itted can be adjusted by
changing the value in the DNA |n t plification sheet.

Please be aware once the conc on or dilution value is manually added
to the amplification shee t be able to calculate the volume of
e quantlflcatlon value.

DNA needed for am I| n fr
All other changes sh c Id b\ e in the “Samples” sheet.

F. Saving Amp Sheets to the@ﬂvork for Additional Samples

1. Amp sheets n@)e saved as independent sheets for subsequent sample additions
by right- cllcmg the corresponding tab and selecting “move or copy”. In this
window, t “(new book)” in the “to book” window and check “create a copy”.
Click Go to File — Save-As and save into the appropriate folder.

2. es may be manually typed into these sheets or copied and pasted special
re-quant sheets or consolidated from additional amp sheets of the same type
Q t the end of each Rotorgene run.

3. When a sheet is full the analyst may fill in the appropriate information (cells
shaded blue) and save the sheet as the time and date of the amp.

Revision History:
March 24, 2010 — Initial version of procedure.
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A. Preparing DNA aliquots for amplification (if applicable)
1. Follow applicable procedures for preparation for testing.
2.

For each sample to be amplified, label a new tube. Add DNA and i r&i;ted
water or TE* as specified by the amplification documentationant ;\

amplified with ldentifiler reagents should be prepared with irragh water. )

TABLE 1: Dilutions

Prepare dilutions for each sample, if necessary, accordir@able 1.

Amoun.of Irradiated

Dilution Amount of DNA
Template (uL) _{ water (uL)
0.25 3or(2)\ \U "~ 9or (6)
0.2 2 AN\ > 8
0.1 L2\Y M 18
0.05 N 38
0.04 @ (2) (NS 96 or (48)
0.02 aL(0Y~ 98 or (49)
0.01 % Q) 198
0.008 6\07(2) 496 or (248)
a. Centrifuge s@s at full speed briefly.
b. Label tube ropriately for dilutions. Add the correct amount of
irradiat@jger as specified by the amplification documentation and Table
1.
C. Pip$ﬁmple up and down several times to thoroughly mix sample.
d. S@ e sample aside until you are ready to aliquot it for amplification.
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B. Identifiler — Sample and Amplification Set-up

Samples and Controls

1. The target DNA template amount for Identifile28 cycles is 500 pg. '\(1/
Thetarget DNA template amount for Identifil#r31 cycles is 100 p

To cdculate the amount of template DNA and irradiated Wa,g.\'I ent) to add,
the following formulas are used. The sample concentra e RotorGene
quantitation value:

Target DNA Tempﬁﬁe Amount (pg)
DNA extract added (ML) = ----mmmmmmmmmmmmmmm oo oo oo

(sampl§oncentr® pg/uL)(dilution factor)

The volume of diluent to add ( ®= A extract added (uL)

For samples with RotorG@alu_e& g/uL aliquot 5 uL extract.

2. Y O
a. For an Identififer™ leamplification, make a 0.5 (1/2) dilution of
the ABI Positive ( 7) control at 100 pg/ pL (5 pL in 5 pL of

water). ,\g

This yiel s@ g/uL of which 5 pL or 250 pg will be used.

b. For aﬂ'l entifiler™ 31 cycle amplification, make a 0.2 (1/5) dilution of
Positive (A9947) control at 100 pg/pL (4 pLin 16pL of

00 This yields 20 pg/uL of which 5 pL or 100 pg will be used.
3005 uL of irradiated water will serve as an amplification negative control.
4, Arrange samples in precisely the positions they appear on the sheet.

5. Witness step. Have another analyst witness the sample set-up.
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Master Mix Preparation

1. Retrieve Identifile™ primers and reaction mix from the refrigerator and Taq
Gold from the freezer. Store in a Nalgene cooler, if desired. Record the lot
numbers of the reagents. '\

2. Vortex or pipet the reagents up and down several times. Cenjri reagents at
full speed briefly. Do not vortex TAQ GOLD. '\\

3. Consult the amplification documentation for the exact a\@nt of Identifiler
primers, reaction mix, and Tag Gold, to add. The of reagents for one
amplification reaction is listed in Table 2.

TABLE 2: Identifiler 0 PCR ampli%’ ation re @s for one sample

Reagent \ Per reaction
Primer mix .A\\e &’\(‘ 2.5 uL
Reaction mix o\ O 5uL

AmpliTaqg Gold DNA P /uL) 0.5puL

Mastermix total: 8 uL
DNA \ 5uL

Reagent and Sample Ali l@\

1. Vortex masterG_i). After vortexing, briefly centrifuge or tap master mix tube on

bench. Q’\'

2. Add 8 f the Identifiler] master mix to each tube that will be utilized,
ch g pipette tips and remixing master mix as needed.

3. &or to immediately adding each sample or control, pipet each sample or control

Q p and down several times to thoroughly mix. The final aqueous volume in the
PCR reaction mix tubes will be 13pL. After addition of the DNA, cap each
sample before proceeding to the next tube.

4, After all samples have been added, return DNA extracts to storage and take the
rack to the amplified DNA area for Thermal Cycling (continue to section D).
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An dternative method for amplification is to use a 96-well plate.

1. Positive Control
a. If only half a plate of samples are amplified, only one PE is necessary,
however, to encompass all of the injections required for a fu I te of
samples, amplify two or more PEs (10 pL in 10uL of Wateé

2. Sealing the Plate
a. If using a PCR plate, place a super pierce strong

&h top of the plate,

and place the plate in the plate adapter on the AR : e heat sealer.
b. Push the heat sealer on top of the plate for -%w ds.
C. Rotate the plate and reseal for 2 additional '
d. Label the plate with “A” for amplification a@ the date and time.

(A011104.1300) 6 (b@

C. Thermal Cycling — all amplificatio Q;ems 6\(\
1. Turn on the ABI 9700 ltgn\“n @r.

2. Choose the following *files,in ®&éer to amplify each system:
(&)
Identifiler 28 N7 Identifiler 31

user:hisens orca T‘ user:hisens or casewl
file: id28 ) file: id31
\J

3. The foIIov@lables list the conditions that should be included in each file. If the
files @ correct, bring this to the attention of the Quality Assurance Team and
asu or.

ﬁfiler PCR Conditions for the Applied Biosystems GeneAmp PCR
S

: tem 9700
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9700 The Identifiler file is as follows:
Identifiler 28 or 31 Soak at 95°C for 11 minutes

: Extend at 72°C @1/
60 minute incubation at 60 6\

Storage soak indefinitel @\1

user:hisensor casewk : Denature at 94°C for ﬂput
file: id28 or id31 28 or 31 Cycles Anneal at 59°C f inute

inute

11%

[

N\
9700 Instructions \O

1. Place the tubes in the tray m@e % slide the heated lid over the tubes,
and fasten the lid by pulll ard. Make sure you use a tray that

has a 9700 label. C)

2. Start the run by perfwﬁ ng t(ﬁowmg steps:

3. The main menu optig&? UN CREATE EDIT UTIL USER. To select an

option, press the F k ...Fb) directly under that menu option.

4, Verify that us 's@t to “casewk.” If it is not, select the USER option (F5) to

display the “S User Name” screen.

5. Use the&lar arrow pad to highlight “casewk.” Select the ACCEPT option

(F1).

égbct the RUN option (F1).

se the circular arrow pad to highlight the desired STR system. Select the
START option (F1). The “Select Method Options” screen will appear.

8. Verify that the reaction volume is setli8yL for Identifiler . The ramp speed is
set to 9600.
9. If all is correct, select the START option (F1).
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10. The run will start when the heated cover reaches 103°C. The screen will then

11.

QO

display a flow chart of the run conditions. A flashing line indicates the step being
performed, hold time is counted down. Cycle number is indicated at the top of
the screen, counting up.

Upon completion of the amplification, remove samples and pres ﬁbngP
button repeatedly until the “End of Run” screen is displayed. the EXIT
option (F5). Wipe any condensation from the heat block wi hﬁ mwipe and pull
the lid closed to prevent dust from collecting on the heat .~ Turn the
instrument off. Place the microtube rack used to set-u %samples for PCRin
the container of 10% bleach in the Post-Amp area. ®

After the amplification process, the samples are Qady to be loaded on the
fluorescent instruments. They may be stored@w appropriate refrigerator at 2-
8°C for a period of up to 6 month36 QD

<G .
NOTE: \4 6\(\
. & O |
Turn instruments off Ol\ hen ;@Aam Menu is displayed, otherwise there
*me

will be a “Power Fail the next time the instrument is turned on. If
this happens, it will p mp\{N o review the run history. Unless you have
reason to believe that th as indeed a power failure, this is not necessary.
Otherwise, press the %@ button repeatedly until the Main Menu appears.

In case of an ower failure, the 9700 thermal cycler will automatically
resume the rufy if the power outage did not last more than 18 hours. The history
file containgthe information at which stage of the cycling process the instrument
stopped. ’Qﬂsult the Quality Assurance Team on how to proceed.

%
&

O
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E. Amplification Troubleshooting

PROBLEM: No or only weak signal from both the positive control and the test samples
Q

Possible Cause Recommended Action l/

Mistake during the amplification set up such Prepare new samples and rep %pllflca
as not adding one of the components or not step ?1/
starting the thermal cycler

Thermal cycler defect or wrong program used Check instrumen@aﬁ; QA team, prepare
new samples and qu mplification step

on

PROBLEM: Positive control fails but sample sigral Ievel?g&

Possible Cause A Reg@ended Action

Mistake during the amplification set@ch Pr@e new samples and repeat amplificajion
as not adding enough of the pos

DNA q)®)

Positive control lot degraded <>\ Notify QA team to investigate lot number,
\ prepare new samples and repeat amplificafion
(\ step with a new lot of positive control

OG

PROBLEM: Presence @oexpected or additional peaks in the positive control

Possible Cause‘& Recommended Action
&
Contaminati other samples, Notify QA team to investigate the
contamin agents amplification reagents, prepare new sampl¢s

and repeat amplification step

Non-specific priming Notify QA team to check thermal cycler for
correct annealing settings, prepare new
samples and repeat amplification step
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PROBLEM: Strong signal from the positive controls, but no or below threshold signal
from DNA test sample

Possible Cause Recommended Action O
The amount of DNA was insufficient or the | Amplify a larger aliquot of the D Qaq}{ct
DNA is severely degraded

Concentrate the extracted DM@eing a

Microcon 100 ultrafiltratio M e as
described in the Microcc@ction

—h

Re-extract the sam&&ing a larger area (@
the stain or moregiological fluid to ensure
sufficient highyi@dJ&cular DNA is present

P D
A \ 4 A
Test sample contains PCR inhibitor (e.g.. J\\®Plif aller aliquot of the DNA extract
heme compounds, certain dyes) : qni; tential Tag Gold polymerase
C) N S

?‘ c Prify the extracted DNA using a Microcon
0

0 ultrafiltration device as described in thq

<>\ Microcon section
Re-extract the sample using a smaller area| of

O the stain to dilute potential Taq Gold
C) polymerase inhibitors

@Q Re-extract the samples using the organic

@ extraction procedure
A\

\J'
The decisio@which of the above approaches is the most promising should be made after
consult ith a supervisor.

Revision History:
March 24, 2010 — Initial version of procedure.
Juy 16, 2012 — Revised procedure to accommodate LIMS.
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A. Setting Up A 313&I Run
1. Go to the computer attached to the instrument.
2. If needed, press “CTRL-ALT-DEL” to login. '\(1/
3. User should be “Administrator”, password should be left blan Q
4. Click OK. '\
5. Open the 3130 Data Collection v3.0 software by dou@ﬁicking on the desktop

Icon or select Start > All Programs > AppliedBiosy > Data Collection >
Run 313l Data Collection v3.0 to display the S@ice Console

By default, all applications are off @lcate he red circles. As each
application activates, the re (off ge to yellow triangles (activating),
eventually progressing to greQ&squar n) when they are fully functional.

Instrument Service

Wiewer

all applications are running, tReundation Data Collectionwindow will
displayed at which time the Service Console window may be minimized.
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6. Check the number of injections on the capillary in the 8188age log and in the
Foundation Data Collectionwindow by clicking on the ga3130> instrument
name > Instrument Status. If the numbers are not the same, update the usage
log. If the number is 240, notify QA. Proceed only if the number of injecs
that will be running plus the usage number is <150. '\éll
)&

Foundation Data Collection Version 3.0 - Mo User is logged in

File Miew Service Tools ‘Wizards Help

& N all
=B GA nstrumert: 4
A strurerts M O Istrumerts » a3 300 » Crick > Istruthen Stetus
[DiResuts Group
B3 Database Manager Stalus Overview -
& By nstrumert ID:  Crick Array Serisl Number: 35801476
B Werager Instrume i rray Seril hnber
Fun(D. Array Length, % om
@ Protocol Manager
Tl Mochis Manager Plate N Array Usage: 12
) GHRun History System Status: e Polymer Type:  POP4
B ek
q ”C po— | S Stz - Sensor Valles- - [Bverls-
= EIE Sislus -
] TEeT— ~EP Wakege—— FEP Curent [13:45: 50 Systen Stacus: Idle
Elevert Log B == o 200 W | 8000 pA || |113:46:50 Requested to exit diagigstics state.
BBl spatia Fun Schertuk S s 150 1113:43: 45 syoten status: DffmiBE
® BBIRun Scheduler = o 1113:43:45 Reiuested chyenc diagostics state.
0 epileries Viewer Front Doors Eesal o 3:43:41 Systen Staruo Nle
BBl capinrray Viewer OvenDoor. == Clossd 43:41 Requestefl toexi MRiagnostics state.
Blspectral Viewsr Autosampler: == Return __ _ 3 Biamosric
%MWE‘CU“"”‘ Laser Power —| Lok Wenter into diamostics state.
service Loy
250 i 0
EW’IH *

T e
7. Check the usage lo d(g e wh@)e POP4 was last changed. Ifitis >7 days,

proceed with POP4 cllahge % art K. of this section) and then return to Step 9.
The POP4 does not need\Qb changed if it is'fruay.

8. Check the level of P &in the bottle to ensure there is enough for the run (~450

uL for 6 injections ull piston chamber is appnmdtely 200ul. If not
enough, proce@ POP4 change (See Part K. of this section) and then return to
Step 9.

N

Controlled versions of Department of Forensic Biology Manuals only exist electronically on the
Forensic Biology network. All printed versions are non-controlled copies.



FORENSIC BIOLOGY PROTOCOLS FOR FORENSIC STR ANALYSIS

IDENTIFILER ANALYSIS ON THE ABI 3130 xI GENETIC ANALYZER

DATE EFFECTIVE APPROVED BY PAGE
07-16-2012 EUGENE LIEN 3 OF 28

i

|

| ‘ PDP motor cover
1

b

N\

Capillary array tip
— Capillary array
Capillary array knob \

L /\ \ Double-tap fei ule:

i /] Array port \

/i‘ //7 — lnt@%xbe

)// 4
Jolymer supply tube =~ ———— —
—
=== //

/ Mounting

Polymer supply .

bottle cap with
hole

PDP motor

| 1
| 1

‘ | i

Syringe fitting ‘ ‘ 1
1

1

Water seal

iyl =1 e L ® é)\

Water trap

Mounting pin

Piston - —= i
Pump chamber

Pump block

Check valve

Buffer valve pin
Lower polymer block
Mounting pin

Overflow hole
Buffer fill-line
Polymer

supply bottle

Buffer jar (16 mL anode reservoir)

Electrode

o

T
o)

9. If it is the first run of h(&{/ on strument, proceed with steps 10-18. If a
run has already bee?Erfor e the instrument that day and the “buffer
changed” column dis Iayst\h ay’s date, skip to Part B of this section.

10. Close the instrument\(f;@and press the tray button on the outside of the
instrument to brin&@ utosampler to the forward position.

11.  Wait until the Qtjsampler has stopped moving and the light on the instrument
turns gree&ﬁpd then open the instrument doors

the0 of the lower pump block and dispose of the fluids.
13. QS'Mse, dry thoroughly, and then fill the “water” and “waste” reservoirs to the line
Q ith deionized water such as GIBEO

14. Make a batch of 1X buffer (45 ml Gib®water, 5 ml 10X buffer) in a 50 mL
conical tube. Record the lot number of the buffer, date of make, and your initials
on the side of the tube. Rinse and fill the “buffer” reservoir and anode jar with 1X
buffer to the lines.

12. Remé@e three plastic reservoirs in front of the sample tray and anode jar from
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15. Dry the outside and inside riof the reservoirs/septa and outside of the anode jar
using a Kimwipe and replace the septa strip snugly onto each reservoir.

16.  Place the reservoirs in the instrument in their respective positions, as shown

below:

Water Reservoir
(Waste)

Cathode reservoir
(1X running buffer)

D

1

Wate(rRFr;\e {1/

17.  Place the anode jar at the@ex oft @\/er pump block.

18. Close the instrume O

19. Record lot numbers for I38Q4 and buffer.
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B. Creating a Test Batch

3130xITest Batch Creation for HSC, Exemplar, and Property Crime Teams

Sample names and run names cannot be longer than 50 characters, and Gve in correct
3130 format: -_.(){}[]+" only. R

injections of Identifiler samples, Allelic Ladder should be positio, the first sample

Allelic Ladder(s) must be individually added to the test batch. Ift er‘X two or more
of that injection during the plate loading step. Q\

Ensure that the correct System is in the “Sys” column

Amplification Specification | Rupn Module &@3 Parameters
System/Cycle
Identifiler 28 Normal |4 K2 1 kV for 22 sec
High ‘e Q‘ 5 kV for 20 sec
O

Test batch plates should b@\ tlng the instrument, the year, and the
consecutive run number for For example: “Mendel09-026ID”

If samples on the test batc ing rerun, confirm that dilution (if applicable), suffix,
comments, or any other n@&ary information is present.

For rerun normal sa@s fill up the end of the injection with any normal reruns before
starting a new inje&'@n.

Rerun high&@es should have a separate injection from samples run under normal
conditions.

Usin&é LIMS drive, drag-and-drop the plate record from the LIMS Share folder to the
Q strument’s plate record folder.
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3130xl Test Batches For High Sensitivity Team

The negative controls may be set up in a separate injection from the samples, and injected
using “high” run parameters so that they only need to be run once. (1/

For ID31, samples with less than 20 pg amped may be injected high j %ﬂlately to
reduce the number of reruns necessary. (1/

For ID28, samples with less than 200 pg amped may be |nject\ rerun parameters
immediately as well.

Name the test batch as follows: Instrument name & date{Run foldéos example:
Athena042407_70-76. If the plate is bei reinject original plate name is recorded
underneath the new name. r&

Allelic Ladders and Positive Contr |II oc e first, second, ninth and tenth wells
of each injection. lItis mandato& the Iadder and Positive Control included
with each injection set for Ider(

1. In the “Sys.” column, cor@ﬂ that the appropriate letter forcthreect run or

rerun module codeis p@ t

Table 5: Identifilef Tajection Parameters for the High Sensitivity Team

Amplificatiokg'cle Specification Run Module | Parameters
PR Code
Identifilef\32 Low L 1 kV for 22 sec
\ Normal N 3 kV for 20 sec
\<: High H 6 kV for 30 sec
d
entifiler 28 Normal I 1 kV for 22 sec
Q High IR 5 KV for 20 sec
2 Proofread documentation, make corrections and re-save as necessary.

IMPORTANT : Remember that all names must consist of letters, numbers,
and only the following characters:- _. (}{}[]+" (no
spaces)
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C. Foundation Data Collection (Importing Plate Record)
1. Maximize the Foundation Data Collection window.
2. Click + to expand subfolders in the left tree panegaf 313&I". '\(1/

3. Click on ‘Plate Manager'. (19

4. In the Plate Manager window click oimiport... ” '\

5. Bro or the plate record in D:\AppliedBiosystems\Plate Recor@®uble
n the file or highlight it and click Open

%QA window will prompt the user that the plate record was successfully imported.
Click OK.
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Progress |E]
Status- -
1 plateis) to import...
Crick06-3130x1 Manual.plt.txt ——
/ Successfully imported. %
Dot imporing. . Q\
| 1af1 \
o

indo \H prompt the user where changes
on and resave the corrected Plate

le name.

If the Plate Record will not import
are needed. Go back to edit t cum

Record and Sample Sheet wifhithe s\a@s
Preparing and Running the D\Qam%@

1. Retrieve amplified saﬁpl S the thermal cycler or refrigerator. If needed,
retrieve a passing positivéontrol from a previous passing run.
2. If condensation is s@in the caps of the tubes, centrifuge tubes briefly.

Mastermix and Sam[(é@\?dition for Identifiler 28 for HSC, Exemplar, and
Property Crime Te&@§
preparation:

1 Mast Q
3

%)0 Prepare one mastermix for all samples, negative and positive controls, and
O allelic ladders as specified in Table 7.

(26.625 pL of HIDI + 0.375 pL of LIZ per sample)
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TABLE 7: Identifiler 28

# Samples + 2 HiDi Form LIZ500 Std
(26.6 pL per sample) | (0.375 pL per sample
.
16 480 uL AN v

32 906 uL \@q\b
48 1332 uL N

64 1758 ul \\) 25 uL
80 2184 uL N © 31U
96 2610 uL n\ 37 ul
112 C3036 U 43 uL
A uy u
128 -\ 348800 49 uL

NOTE: HiDi Formamide @hot be{ rozen

b. Obtain a reaf?n m@label the side with a sharpie. Place the plate in
an amplificatio plate base.

C. Aliquot 27 uLof rmix to each well.

forma Di, buffer or mastermix to all unused wells within that
|nject|

Adding @%Ies

a. &wrange amplified samples in a 96-well rack according to how they will be
00 loaded into the 96-well reaction plate. Sample order is as follows: A1, B1,
O Cl... A2, B2, C2...etc. Thus the plate is loaded in a columnar manner
Q where the first injection corresponds to wells A1-H2, the second A3-H4
and so on.

d. If an mpct@as less than 16 samples, add at least 12 uL of eitier dH

b. Witness step. Have another analyst witness the sample set-up.
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C. For sample sets being run at normal parameters: Aliquotdf jallelic
ladder.

d. For sample sets being run at normal parameters: Aliquot & fihe

positive control. '\(1/

e. Aliquot 3 pL of each sampleand negative contral Q

f. When adding PCR product, make sure to pipette \Jtion directly into
the mastermix and gently flush the pipette tip % down a few times to
mix it.

g. Skip to Part E (Denature/Chill) of this secth.

Mastermix and Sample Addition for Idemq\l_mr 28 fo‘bé'rqh Sensitivity Team:

: S
1. Arrange amplified samples '@QG-W k according to how they will be loaded

into the 96-well reaction . Sa rder is as follows: Al, B1, C1... A2, B2,
C2...etc. Thus the plat oade@ columnar manner where the first injection
corresponds to well 2, cond A3-H4 and so on.

2. Witness step. Have ano@sanalyst witness the sample set-up.

S

3. Obtain a reaction pﬁﬁ nd label the side with a sharpie. Place the plate in an
amplification tray QPthe plate base.

NOTE: Hi@ormamide cannot be re-frozen.

Mas@for 28 Cycles:
a. 0 repare one mastermix for all samples, negative and positive controls,
0 allelic ladders as specified in Table 8

QO I. Add 26.625 L of HIDI per sample
il. Add 0.375 pL of LIZ per sample
iii. Aliquot 27 pL of mastermix to each well

Controlled versions of Department of Forensic Biology Manuals only exist electronically on the
Forensic Biology network. All printed versions are non-controlled copies.



FORENSIC BIOLOGY PROTOCOLS FOR FORENSIC STR ANALYSIS

IDENTIFILER ANALYSIS ON THE ABI 3130 xI GENETIC ANALYZER

DATE EFFECTIVE APPROVED BY PAGE
07-16-2012 EUGENE LIEN 11 OF 28
b. If an injection has less than 16 samples, add 12ul of eith€D dbtiffer or

formamide/LIZ mix to all unused wells within that injection.

Add samples to the plate, adhering to the following guidelines:

NOTE: Multichannel pipettes may be used to load samples. If pj '(krom a
96 well PCR plate, pierce the seal. (1/

Q\

a. Aliquot 3 pL of each sampleand negative co r@\l the positive
control. I}\

5. Adding Samples for28 Cycles:

b. Aliquot 0.5 L of positive c trolor 1 ®1/2 dilution (4 uL positive
control in 4uL of water) |nt weII Ied “PEH”". Thisis the
positive for the “hlgh” in

C. Aliquot 0.7 uL of a@ladd fuII plate will be used, mix 6 pL of
ladder with 2.4 aliquot 1 pL per ladder well.

normal and the re arameters for each injection to account for
differences in Is\ts llelic ladder.

I. E Qﬁl\plate, add 3.5 pL of ladder to 3.5 pL of water, mix, and
djaliquot 1 pL of this dilution.
il. For a half plate, add 2 pL of ladder to 2 pL of water, mix and
Qaliquot 1 pL of this dilution.
@ A P2 pipet must be used to make 0.7 and 0.5 pL aliquots to avoid
& making dilutions and to conserve ladder.

d. Alternatively, 1 pL s uL of allelic ladder can be used for the

C) Skip to Part E (Denature/Chill) of this section.

QO
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TABLE 8: Identifiler 28 Samples for High Sensitivity Team

Injection Samples LIZ HIDI Allelic Positive
Parameters | and negs Ladder Control
I 3 uL 0.375 uL| 26.6 uL | 1.0 pL or] 3

(0.7 pL)* ’: !ﬁ
IR 3 uL 0.375 uL| 26.6 uL | 0.5 pL or| 5
(0.7 uL)* | O)

* Two amounts of allelic ladder, 1L and 0.51L, may be used for t CM’IBJ and the
rerun parameters to account for differences in lots of Iadder@ thplh.Oz\Zf'nch
is satisfactory for both parameters in most situations. Q\

Mastermix and Sample Addition for Identifiler 31 for HidR Sensitivity Team

1. Prepare pooled samplda@ENTlF@u @) \'
a. Centrifuge all tube&@ spe \iefly.

b. Label one 0.2 mL tub the sample name and “abc” to represent
the pooled s jectl r the corresponding sample set.

C. Take 5L of e sa pllcate after mixing by pipeting up and down,
and place each ali to the “abc” labeled tube.

d. Place each pool ple directly next to the third amplification replicate
labeled “c” of é&&a sample set.

2. Arrange amplif (&mples in a 96-well rack according to how they will be loaded
into the 96-we ction plate. Sample order is as follows: Al, B1, C1..., A2, B2,
C2...etc. the plate is loaded in a columnar manner where the first injection
corresp o wells A1-H2, the second A3-H4 and so on.

3. W@step. Have another analyst witness the sample set-up.

O

QO
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4. Obtain a reaction plate and label the side with a sharpie. Place the plate in an

amplification tray or the plate base.

NOTE: HiDi Formamide must not be re-frozen. (1/

0. Mastermix for 31 CYCLES:

a. Prepare the followinghastermix for samples, ad nega@ntrolas
specified in Table 8 Q
I. 44.6 uL of HIDI per sample \
il 0.375 pL of LIZ per sample Q
iii. Aliquot 45 pL of mastermix to eachsampteandnegative control

well
O
b. Prepare a separastermt Q alleli \dersand positive controls
i Add 14.6 pL ofﬂg{o 3 and PE
i Add 0.375 w@w Zp e& and PE
iii. Aliquot 15 f ma ix to each Allelic LadderandPositive
Contr

7. If an injection has less tha g)samples, add 12ul of eith# dtiffer or
formamide/LIZ mix to’% sed wells within that injection.

8. Add samples to tIB%te, adhering to the following guidelines:

NOTE: Mul ic@ml pipettes may be used to load samples. If pipetting from a
96 well P ate, pierce the seal.
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9. Adding Samples for Identifiler 31:
a. Aliquot 5 pL of each sample (including pooledand negative contral

b. Aliquot 1 pL of a 1/10 dilutionof positive controlinto each well %Ied
“PE”. (Make the 1/10 dilution by mixing 2 uL of Positive ['With
18 uL water). This is the positive for the “normal” injectj rameters.

C. Aliquot 1 pL of a 1/20 dilutionof positive controlin &é\ well labeled
“PEH". (Make the 1/20 dilution by mixing 2 uL o itive Control with
38 uL water). This is the positive control for t@gh” injection
parameters.

d. Aliquot 0.5 uL of allelic Iadd&to eacgélabeled “AL".

Alternatively, make a 1/2 dilutyon of | r and aliquot 1 uL per “AL”
well. Make this dilution

iXi ladder with 2 uL of water for 1-2
injections, 3 uL ladderith 3 u ater for 3-4 injections or 4 uL ladder
with 4 uL water fo&injee 1I0QS7” This is the allelic ladder for the

“normal” injectio{ ram

Alternatively, ma /10 dilution of ladder and aliquot 1 uL per “ALH”

well. Make this@* lon by mixing 1 uL of ladder with 2.3 uL of water for

1-2 injection L of ladder and 4.6 uL of water for 3-4 injections, or 3

uL of Iatij@/ h 6.9 uL water for 5-6 injections. This is the allelic ladder
[

e. Aliquot 0.3 uL gf aIEIiQder into each well labeled “ALH".

for “higR” ifjection parameters.
TABLE 9: 31 Cycle Samp r High Sensitivity Team
Injection Samplds\,~ LIZ for samples HIDI f?r Allelic | Positive Llf\Lfor HI'Iill_for
Parameters | and and negs SamPpies || adder | Control S S
R and negs And PEs | And PEs
- 1pL of
L O%)ML 0.375 pL 446 puL| 0.5pul 1/10 dil 0.375puL| 14.6 uL
< ;’ 1pL of
N 5puL 0.375 puL 446 uL| 0.5pul 1/10 dil 0.375puL| 14.6pL
1uL of
H 5puL 0.375 pL 446 uL| 0.3 pl 1/20 dil 0.375uL| 14.6 puL

10. Proceed to Part E (Denature/Chill) in this section.
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E. Denature/Chill - For All Systems After Sample Addition

1. Once all of the samples have been added to the plate, place a new 96-well septa
over the reaction plate and firmly press the septa into place. '\
2. Spin plate in centrifuge at 1000 RPM for one minute. (19

3. For Denature/Chill: '\\
©

a. 9700 Thermal Cycler Q

I. Place the plate on a 9700 thermaé)r cler (Make sure to keep the
thermal cycler lid off Qf the sam&ﬁ y).

il Select the “denat il pro@IO
iii. Make sure the v |s s fior Identifiler 28, and 50 pL

for Identifiler mor ne system is loaded on the same
plate, use t her
V. Press R het | cycler The program will denature

sampl inutes followed by a chill af@ (the plate
should |II for at least 5 min).
V. While the d@ ture/chill is occurring, the oven may be turned on.

b. Heat Block Q

I @e the plate on a 95°C heat block for 5 minutes.
5\I'3Iace the plate on a 4°C heat block for 5 minutes.

F. Turning the& on and Setting the Temperature

1. tree pane of the Data Collection v3.0 software clicdkAmnstrument >
13&! > instrument name > Manual Control

2. Under Manual ControlSend Defined Command For* click on Oven.
3. Under ‘Command Namé click on “Turn On/Off oven”.

4. Click on the Send Command button.
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Foundation Data Collection Version 3.0 = Mo User is logged in

SN view  Service Tools  wizards  Help

B H O N

= A Ga Instruments 4 -
nstrumerts = ge xl = Crick = Manusl Control
Resiits G B G Instrumert 313051 = Crick = | Control
F=lDstabase Manager
= Elgaz130x ;
[EElPiate Manager Send Defined Comman: o For: o

=
B Pratocal Manager
O fia Moclule Mana

= mRun History Command Name value Range

=l ﬂc ick [ v \

= [ERAnstrument Status
ESpst sl Run S wl'
& @ERun Schedulel
4

Control -

@)
O

5. Under ‘Command Namé cllclqgéet emperaturé and Under Value”
set it to 60.
6.  Click on the Send C%ggld EL@Q
7. Once denatured, spin the in centrifuge at 1000 RPM for one minute before

placingthe reaction pla the plate base. Securel#te pase and reaction
plate with the plate r

Controlled versions of Department of Forensic Biology Manuals only exist electronically on the
Forensic Biology network. All printed versions are non-controlled copies.



FORENSIC BIOLOGY PROTOCOLS FOR FORENSIC STR ANALYSIS

IDENTIFILER ANALYSIS ON THE ABI 3130 xI GENETIC ANALYZER

DATE EFFECTIVE APPROVED BY PAGE
07-16-2012 EUGENE LIEN 17 OF 28

The plate assembly components are assembled as follows:

Plate retainer

Septa

Sample plate

Plate base

G
O P

G. Placing the Plate onto the AEtosa ley (Linking and Unlinking Plate)

1. In the tree pane of th § dation Data Collection v3.0 software click on GA
Instrument > ga313§. nstrument name > Run Scheduler > Plate View

2. Push the tray Qﬁon the bottom left of the machine and wait for the
autosample;\tc') ove forward and stop at the forward position.

3. Open t%@)rs and place the tray onto the autosampler in the correct tray
posit@»A or B. There is only one orientation for the plate. (The notched end
f way from the user.)

4 ér{sure the plate assembly fits flat in the autosampler.

Y

When the plate is correctly positioned, the plate position indicator on the Plate
View window changes from gray to yellow. Close the instrument doors and allow
the autosampler to move back to the home position.
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\J \J

Linking/Unlinking the Plate R;% to I@
m

5. Type the exact plate na ; i Plate ID window and click “Search.” Or, click

the “Find All” button and ct the desired plate record.

NOTE: |Ifthe pla ’§ne is not typed in correctly, your plate will not be found.

Inste rompt to create a new plate will appear. Click “No” and
rety@e plate name correctly.

Click the position indicator corresponding to the plate position in the
instr‘% ." The plate position (A or B) displays in the link column.

If

O

The plate position indicator changes from yellow to green when linked correctly
and the green run button becomes active.

lates are being run, the order in which they are run is based on the order in
ch the plates were linked.
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Fle View ServiceTools Wizards Help

FEAER BN A

= AGA Instrumerts
[iResuts Growp

4
I GA Instrumerte > ga31 304 » Crick » Run Schedler > Plte View

|- Fin Plates Metching These Creria

Crickog-JPTestsheet2
Crick06-JPtestsheet
Crickns-Missy
Crick06-ProfilerLadder
CHEkDB-QCSen071306.F
CrickLaserTest
GENERIC

GENERIC2

GENERIC3
3

Proalieliclader
Spectial_F120un06
Spectal_F_071106
Spectal F_0711064
Spectal_65_071106

7. To unlink a plate record %\click the plate record to be unlinked and click

“Unlink”. K
N

H. Viewing the Run Schedt@

1. In the tree pane=6f the Foundation Data Collection software, click GA
Instrumer@gaBB&l > instrument name > Run Scheduler > Run View.

The@%column indicates the folder number(s) associated with each injection
(e% un_Einstein_2011-03-10-0018 or Run_ Venus_2006-07-13-00D).
: This RunID may not be indicative of the Run Collection folder depending
O)n results group used.

3. : Click on the run file to see the Plate Map or grid diagram of the plate on the right.
Check if the blue highlighted boxes correspond to the correct placement of the
samples in the injections.

NOTE: Before starting a run, check for air bubbles in the polymer blocks. If
present, click on the Wizards tool box on the top and seBuabble
Remove Wizard'. Follow the wizard until all bubbles are removed.
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Foundation Data Collection Version 3.0 - Mo User is lopsed in

File View Service Tools BUREGES Help

(T Install Array Wizard

e Changs Polymer Typs Wizard
& A Ga nstrumerts

[ Resuts Group 0x1 > Crick

[EElPiate Manage Uk

Byprotocol Mar

{aMocds Mars

Instrumient: Shutdown Wizard
Autosampler Calibration Wizard

& Qe P Cap ey Infa o
= - || Sensor Vaiues | | Events
Tl spatisl Run Schecti Laser; = 0ff EP Voltage—— ~EP Currert [16:26:12 Plate Crick06-3130x. Manusl has been linked to Rgy 0
&1 EIRun Scheduler [T 200 k¥ | p8000 pA || ||16:26:12 Run Crick 2006-08-24 16-26 0024 status hasqehange vo @flidated
EPiste View iy 150 5000 16:26: 12 Run_Crick_2006-08-24_16-26_0023 status has, ged o Validated
R View . = 7 i 16:26:12 Run_Crick_2006-03-24_16-26 0022 stat) tu Validated
B Capiliaries Viewsr e iz 16:26:12 System Status: Ready
Ecapinay viewer Oven Door. ==t Cloged L |16:26:12 The number of runs has changed to
R spectral Viewer Autosampler: == Refurn 16:26:05 System Status: Idle
anual Cartrol Laser Powsr— —Lassr Current— | [16:26: 05 Plate Crick06-3130x1_Manual fas h Llinked from Bay 0
Egervice Lo 250w wzu & |16:26:05 The number of runs Bas gE R
200 gu 116:25: 53 The number of runs has

ar wh are ready to start

ope

Click on green Rutbutton in the to
When the Processing Platd!al
plates...), click OK 0
To check the progress
Cap/ArrayViewer in

The Capillary Viewer all sh
view whereas the Cdprr

at once. \$

{C}\n cli n the Capillary Viewer

the Foundation Data Collection

iewer will show the raw data of all 16 ¢

IMPORTANT:

N
o)

00((\

QO

wer windows. During a run, do not leave these

open.
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The visible settings siould b€) EP voltage 15kV
EP current (no set value)

KO Laser Power Prerun 15 mW
\ Laser Power During run 15mwW
OQ Laser Current (no set value)
g% Oven temperature 60°C
Expected vﬂi re: EP current constant around 1201té 160
Q Laser current: 5.0A £ 1.0

It is @@practice to monitor the initial injections in order to detect problems.

%}éll

I/L IR N H

Q Oven Temp 60°C 60°C 60°C 60°C
Pre-Run Voltage 15.0 kV 15.0 kV 15.0 kV 15.0 kV
Pre-Run Time 180 sec 180 sec 180 sec 180 sec
Injection Voltage 1 kv 5 kV 3 kV 6 kV
Injection Time 22 sec 20 sec 20 sec 30 sec
Run Voltage 15 kV 15 kv 15 kv 15 kV
Run Time 1500 sec 1500 sec 1500 se¢ 1500 sqc
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Table 12
M MR
Oven Temp 60°C 60°C
Pre-Run Voltage 15.0 kV 15.0kV A~
Pre-Run Time 180 sec 180secp Iy
Injection Voltage 3kV 3kveN Y
Injection Time 10 sec 2Q6ac’
Run Voltage 15 kV A5V
Run Time 1500 sec (3500 sec
N
Converting Run for GeneScan Analysis '\Q

When a run is complete, it will automatically be place
folder, labeled with either thaate name-da .g. Ei
11) or instrument name, date and runID

to Section 9 for instructions on how. ta&onve

:/AppliedBio/Current Runs
11-0251D-015PPY-2011-03-
us_2006-07-13_0018). Proceed
6& data for GeneScan analysis.

J. Re-injecting Plates KO

1. Plates should be re- |E cted oon as possible, preferably the same day.

2. If a plate is being r x the same day on which it was originally
run, it does not reqt&a additional denature/chill step before being rerun.

3. Create a new Sesg tch and plate record using the original documentation as a
guide. Sel those samples that need to be rerun by re-assigning “Sys”. For
example, QQ n “IR” for an ID28 sample that needs to be re-run high.

NO'@%e Section 7 for information on which controls need to be run.

>
O
QO
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5. Follow the instructions for creating a test batch. Re-import the plate record.
6. Re-denature/chill the plate (if needed) as described in Part E.

B Microsoft Excel - HS3030207_57-60REINJECTIONS:

5] Ble Edt Yew Insert Format Iools Data  Window Help

DEHROSdRIVHE & 2n-F(9-

R s Eoe  Bimd

- B I U

NV

28 - 5
a B C D [ETFT S H] J [k
1 |SAMPLE SHEET: HS3030207_57-60 ANALYST: |JT \(L
2 |ORIGINAL PLATENAME:  HS3030107_46-56 WITNESS: MNfA \\
AComments: 6 kv 30 sec re-injections POP4: 0610014

4 BUFFER: 0611253
| 2N

7 | well | ssmpe ;“;:I Case Number—Descrw SYS | TYPE, RUN | 1A I Amplfication ‘Rejnjec! N
8 | A1 i01- | ALT TAllelic_Ladder 1 IR “AL 57 - M 0307 _47
9 | B1 102 [ PE1 [020507 1100PE1 IR "PE 57 - 507 1700 . HS3030107 47
10| C1 1023 [ ANT 020507 11004N1 IR s &7 - T oaosm HS3030107_47
11| D1 04 [ ANZ 920507 T100ANZ R s 57 =T ooa HS3030107 47
12| E1 105 [ AN3 020507 11004N3 R oS 57 - 7 11 H33030107 47
13| F1 1 06- [EN2T a Extraction Megative 012107_1630 a iR 57 1 ac %)dﬁ HS3030107 47
14| G1 | 07- [EN21 biExtraction Megative 012107 1630 b R SN 57 | QCAM e | HS3030107 47
15| H1 | 08 [EN2T c Extraction Negative 012107 1630 c 57 1 QCY ooz i | HS3030107 47
16 A2 |09 [ ALTH ‘Alleic_Ladder 1H e Al 58 Wff - o HS3030107_47
17| B2 . 10- [PETH ‘020507, 1100PE 1H N~ PE § 020507.1100  HS3030107_47
18| C2 | 11- [2712a Buc27_125pg_a & SRS SNOC 0205071100 ¢ HS3030107_47
18| D2 | 12 |2712h Buc2?_12.5pg b QOLINN R =4 s; QC 06071100 | HS3030107 47
20| EZ |13 [3712¢Bucd? 13 5pg ¢ 2 ¥ RS QC (mna7 110 | HS3030107_47
21| F2 114 |27 64 Buc2? 6.2500 a %

22| G715 |376b Buck? 635p0 b o Nt 57 1 QC o7 im0 | HS3030107 47
22 HZ 116 |27 6c BucZi 62500 t%am N g

24 A3 1 17- | A2 Allelic_Ladder 7\ 4 W ra A - E H53030107_49
25| B3 118 [ PE2 [020507 1100PE2 \ IR "PE | 58 - Toonsor o . HS3030107 49
26| C3 1 19- |273a Buc2? 3125pg_a [N IR S 58 | QC [owswiim0 | HS3030107 49
27| D% 120~ |27 3b Buc2i_3 13500 b AN

28| E3 i 21- |27 3¢ Buc2i 3125pg ¢ NS

29| F3 122 |37 1a,Bucdi 156p0 a o SNed RS 58 | QC [owmewriim | HS3030107 49
30| G3 {23 |27 1b Buc2? 1.56pg b \\' IR S | 58 | QC [ooosor.1io0 . HS3030107 49
31| H3 1 24- |37 1¢ [Buc2i_156p0 Comy N RS 58 | QC [ owewiimn | HS3030107 49
32| Ad s 25 TALIH “Allelc Ladder 90 IR AL 58 - o H33030107 49
33| B4 | 26 [PEZH 020507 1100FR2I IR TPE 58 - Toamsor im0 | HS3030107 49
34| C4 | 27- |2707a Bucig=® 7\%% IR | S | 58 | QC [omso71im0 | HS3030107_49
35| D4 | 28 |27070 Budd7 0 78pa) IR S 88 " QC [owswiimn | HS3030107 49
36| B4 | 29 |2707 ¢ BucSL 0 bpg ¢ IR 6 58 1 aC omswriimn | HS3030107 49
37| F4 | 30- |27 03 &BuUc2] T390 a

38| G4 |31 Buc27? 038pg b

9| H4 - 3 dng
o4 ML D3 LI D26 _Plate Record %,ID31¥_31305heet { Pre-Record 7 HS3030107 46-56 7

Daadu

K. Water W nd POP Change

Refe ection A for schematic of 3XBWhile proceeding with the water wash and
I@ ange procedure.

1. Remove a new bottle of POP4 from the refrigerator.

2. Select Wizards > Water Wash Wizard and follow the wizard.

3. When the “Fill Array” step has completed, remove the anode buffer jar, empty,

and fill with 1x TBE Buffer (~15 mL).
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4. Close instrument doors and wait for the steady green light.

5. Click “Finish.”

Cleanup Database Utility (QA Team) '\(1/

In the left hand panel, click on “GA Instruments” '\

Click on “Database Manager” Q

Click the “Cleanup Processed Plate” button. \

This will erase the database and reset the run nun@ 0. Therefore, the next
b

Open the Foundation Data Collection Windowof the 3130 softW\téI/Q

agrwnE

plate run after this process will be labeled run an er 1. Verify this information

for the usage log.
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TROUBLESHOOTING GUIDE

This section is provided as a guide. The decision on which of the recommended actions is the
most promising should be made after consultation with a supervisor. (1/

PROBLEM: Many artifacts in sample.
O
Possible Cause Recommended Action ?\\ v
Secondary structure present. Sample naot. Clean pump blo change
denatured properly. polymer to ref the urea
environment
Denatg{e'mﬁﬁll samples.

é@'

PROBLEM: Decreasing peak heights in @mpleé\(\

f'
Possible Cause ‘\K ~ O ecommended Action
Poor quality formamide or %mpl Realiguot samples with fresh HIDI.
environment very ionic.

S
&

PROBLEM: Individual injecti l@un at varying speeds. For example, the scan number where
the 100 bp size standard apgears differs significantly from one injection to another, usually

appearing earlier. \'
SO

Possible g@&) Recommended Action
Warm@}a:[ory temperatures. 1. Redefine size standard.

@Q 2. If this fails, reinject.
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PROBLEM: Loss of resolution of peaks.

Possible Cause

Recommended Action

Loss of resolution of peaks.

1. Clean pump block and changql/
polymer to refresh the urea r\
environment.

Denature chill samplb&\(ll

2.

>

PROBLEM: An off ladder peak appears to be a pull up, but it is m&actly the same basepair

as the true peak.

Possible Cause

n

@comdﬁd Action

1.
the green channel, the true
overblown and is split. KO

Pull up peaks appear i
the red channels.

In the yellow channel, t
negative peak at the
true peak, howe

peaks.

Matrix over-subtraction. Usuall

N

bl q
e ey

IS a
pairs of the
ediately to th
right and to thg\l' re off ladder

' Reduevoff ladder peaks as matrix ovel

S{ tion.
>

e

\AV
Z

PROBLEM: Pe@erblown and running as off ladder alleles.

L}

Recommended Action

amplified.

N
m@Ie Cause
e than the optimum amount of samg

l&. Rerun samples at lower injection
parameters.

2. Or rerun samples with less DNA.
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PROBLEM: Pull up peaks.

Possible Cause Recommended Action
Colors bleeding into other colors. Run a spectral. 0O
v
PROBLEM: Spikes in the electropherogram. \(1/
N

Possible Cause Recommended Ag@@

Crystals in the polymer solution due to th€hange the polw

polymer warming and congealing from

fluctuations in the room temperature.

O \"
PROBLEM: Spikes in electropherogram an,Q ifa (\
e\
Possible Cause C) ®ecommended Action
Arcing: water around the b?f'e? ch@ei'@lean chambers; beware of drops
accumulating around the septa.
O‘

PROBLEM: Split peaks. \

Possible Cause (' 1 Recommended Action

Lower pump bloclis T the process of | Clean the block.

burning out du e formation of a

bubble.

N

PROBLEM:d@easing number of spurious alleles.

Msible Cause Recommended Action

Extraneous DNA in reagents, 1. Stop laboratory work under

consumables, or instrument. advisement of technical leader.

2. Implement a major laboratory clean-
up.
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GENERAL PROBLEMS

Problems Recommended Action

1. Fatal Errors. 1. Close collection software. (1/
2. Restart collection software.

2. 313 not cooperating. 3. Restart Computer and\ ent.

3. Shutter problems. 4. Call Service. N

Revision History:
March 24, 2010 — Initial version of procedure.

March 29, 2011 — Revised Step H.2 and | due to a change in the Results Group.
July 16, 2012 — Revised procedure to accommodate LIMS.
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A. Converting Run for GeneScan Analysis

Prior to importing *.fsa files into GeneScan, the files must have been converted using the
HIDDyeBUtility conversion tool.

1. Make sure the run (injection) has completed. Q’\(L
2. On the desktop, click on the shortcut for the Rduviversion p;{x(r%.

F:Jﬂ \Q
HIDDyeBUtility.exe \Q

3. On the top of the RIVW¢onversion program windo(click on th€loose
Starting Directory” button.

4. Browse the Current Runs Fol cate?
folder) for your run folder(s) (&

e D drive, Applied Biosystems
us_2006-07-13_0018).

HEIE

HID DyeB Utility version 1.040 has s

Please select a starti:

v 2 »@EE

2006-07-13_0019
2006-07-13_0020
Un_Crick_2008-07-13_0021

File name atorDesktopiCurrent Runsifun_Crick_2005-07-13_§

Files of type:  [al Files

Pl
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5. Double click on your run folder(s) then hit Open. The run folder(s) are now

converted and are now ready to be analyze&glameScan.

B. Archiving Converted Data and Sample Sheets '\(1/

For the HSC, Exemplar, and Property Crime Teams: Q

1. When a run is finished, locate the run folders on the)3 ﬁ?ﬂéntal
computer. These folders are in the Current Rdolsler (or\ desktop) and
have previously been converted.

2. Insert a flash drive into the USB port of the mstru@ental computer.

3. Copy the run folder(s) onto the rive. tthe flash drive from the
instrumental computer and ta ver«t network computer.

4, The STR data folders (Io Data\CASEWORKre organized on
the network by |nstr r, and amplification system. Within these
folders they are org ification set (see Example #2 below).

On the network comput ate a new folder for each run and put it in the

appropriate location. hIS folder(s) with the file name according to your
sample sheet (e.g. s09-005ID, saved in

M:\STR_Data\ @ ORK\Stripes\2009\Identifiler).

Example #PAn Identifiler and a YM1 amplification set were run on Stripes with
the followi ample sheet name: Stripes09-0051D-003Y. Two run folders will
be cr with the following names: Stripes09-005ID and Stripes09-003Y

le #2Two Identifiler amplification sets were run on Stripes with the

wing sample sheet name: Stripes09-0061D. Two folders will be created
side this folder, with the folder names corresponding to each amplification set
as follows: Stripes09-006IDA and Stripes09-006IDB..

Copy the run folders from the flash drive into their corresponding amplification
set folders on the network. Once saved to the network, delete the files from the
flash drive.
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6. Proceed with GeneScan and Genotyper analysis.

For the High Sensitivity Team:

1.

When an injection is complete, the data will automatically be pla &:ke
D:/AppliedBio/Current Runsfolder, properly labeled with the i t name,
date and runiD (e.g. Run_Venus_2006-07-13_0018). '\\

After conversion of the data in each run folder, copy th vant run folders as
well as the sample sheets to a flash drive.

Transfer the run files from the flash drive to the akpropriate data drive on the

network. 6 \9
a. The run folders should’é@ored (ﬁ@network in the run folder of the

instrument on which were

b. The sample sh g&houl stored on the network in the sample sheets
folder of the i epT'oN=which they were run.

After confirming that the@s are on the network, delete the files from the flash
drive.

Proceed with (@@%n and Genotyper analysis.

Backup of Data Q

%)

All of the data, once loaded on the network drive, will be backed up in a process
by Dol T, d stored in archives on and off site of the OCME building.

QO

Revision History:
March 24, 2010 — Initial version of procedure.
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A. Access to GeneScan
1. Click on the GeneScan shortcut located on the desktop of the analysis station
computer.

(l/

2. Create a new GeneScan project by clicktiig—> New. A dialog bo
several icons will pop up. Click on the project icon.

(1/

Create Mew: Q

Project ﬁnal}rﬂs Slze E I'u'Iatnx .

Parameters Standa
@
N
 9pens.

D

% untitled - Analysis Contral

Brislyzs | [ Pt Rosuls P Gt
[E | St SeSndxd B

add sample Files 2]

Laokin: | = Run_Esther_2007.04-30_3 S e®msE-
\ [el]49-_ao7 01 [s]s5-_07_13
|eilso- Bo7 o3 [s)Se-_HO7_15

|sils1- co7 o5 |si)s7-_a0e 0z
[sl)se- o707 |)se-_pos 04
8)53- E07 09

|si)54- Fo7_11

Filename:  [43-_a07_01 Add

Files of type: [ Al Fieadable fles ["fsz]
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3. To add sample files to the open analysis control window, click on Project

the menu options and seléadd Sample Files

Casework and select the corresponding instrument’s folder. Find the*run folders
with the samples that you want to add to the project. Once you the
specific run folder, you will see icons representing each indivi mple, all

belonging to one injection. '\\

To add samples to a project, take the following action: Q

4. When theAdd Sample Filesdialog window appears, go to M: -STR_D%;;

If you want to... hen...

Select a single sample file Doubl @the file OR select the filg
,,6 and ¢Jgk’Add

Select all the sample files \A(‘ QAdd All
N
Add a continuous list of le fi@~ . Click the first sample that you war

—

K O to add.
E C) b. Press th&hift key and click the las]
.(\\ sample you want to add. Click Add

—

Add a discontinuo sfﬁéof samples | a. Click the first sample that you war
L@ to add

O b. Press th€ontrol key and then clicK
Q’\' on the other sample(s) you want to agid.
Click Add.

)
5. %@iinish when you have added all of the samples.

QO
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B.

Analysis Settings

The analysis should then be performed using the following predefined files:

Analysis Parameter)éla/

System Size Standard File
YM1 Ystr.szs YMl.g:sp\Q
Identifiler LIZ-250-340.szs LIZAnaIysis&a\a%eters.gsp

1. Identifiler Analysis Parameters

Do not change any of the settings except the rarﬂs
threshold for Orange (O), which

ﬂ LIZAnalysisParameters.gsp

—Analysiz Bange

" Full Range

{* Thiz Range [Data Points)
start: |psoo
Stop: F

— Size Call Fange
" Full Range ®
& This Rapngs g

— Data Processzing

Smooth Options
" Mone
& Light
' Heawy

: %nd Order Leagt Squdles
" 8rd Ordeg Least Sguate
" Cubic S|:Nnterpolation
i+ Local § erfi Methad

3Gl aI

ern Method

ﬂl

Pe’k Start

— Peak Detection
Peak Amplitude Threshalds

ine Window Size
Pts

Auta Analysis Only
Size Standard:

Folynomial D@

Peak @Slze

reshald far

Slope Threshald for
FPeak End

°

—
O

or the peak amplitude

may be low @ 25 rfu.
S
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2. YM1 Analysis Parameters

Do not change any of the settings except the range or the peak amplitude
threshold for Orange (O), which may be lowered to 25 rfu. (ﬁ/

SYM1.gsp Q
—Analpsizs Range ———————— —— Size CallBange ————————————— (L
" Full Fange i Full Range \
i Thiz Fange (D ata Paoints] * Thiz Range [Base Pairs) \
Stat: oo Min:  [1om Q
Stop: 200 RS W \

—— Data Processing —————— [ Size Calling Method ——————— \Q

2nd Order Least Squares

~
(__stn':h ptions = 3rd Order Least Squares K
& Light i~ Cubic Spline Interpolation O
. Heawy i* Local Southey Method N

Global S cuther ethad

— Peak Detection ———————
Peak Amplitude Thresholds

B- f5  wv: F5
e: s r: 5

A

Min. Peak Half Width: E F

Polynomial Degres b

Feak Window Size |1g p\

Slope Thraeshold for E_D Q
Peak Start

Slope Threshold for 0

Feak End

Onc correct parameters have been chosen, the samples can be analyzed by clicking
t lyzebutton.

When the samples are analyzed, the boxes will change from colored to dark grey in the
Analysis Control window. If a sample does not analyze, see Section D: Analysis
Troubleshooting.
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C. Analysis

To ensure that all the sizing results are correct, check the labeling of the size standard
peaks for each sample.

1. To view the analysis results, select Windofsam the main menu a E{ckn
Results Control.

2. The raw data can be seen in up to 8 display panels, by c@y\(ﬂ}/the # oftpanels
8. To view each color separately, check Quick TdeOn. \

3. 3. Select the first 8 size standard dye IalN y clicking on them and
then click Display Each sample standard will be%splayed in its own window.
To view all 8 standards, you must gcroll thro of the windows. Make sure
that all peaks are correctly Iabel?ontin ecking your size standard for the
entire tray by going back to tr%s ults ol window, clickingGear All
and selecting the next 8 sa 6\

IMPORTANT:  For A&QBO r he 250bp fragment in the Identifiler L1Z
Or Siz dard may not be labeled as 250. In Identifiler,
the 340bp f ent is also not labeled.

Identifiler LIZ Orange Size Standa KO
o~

S D T
? |
4
NS | I
| %) E
. : I ; J | T | | 0
(o i B | B9 E e
[ I |
@) o
yM1 sTRsEZ GS500
1 Orange Size Standard
246 48 300.00) 340.00 400.00
350,00
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Before proceeding with the Genotyper analysis, uderselect Save Project As. The project

will be named according to the Sample Sheet name. This file will save as a *.prj file in the run
folder.

D. Analysis Troubleshooting '\(1/

The error message for a failed analysis is: “Analysis failed on Dy B{&(Y, R. Repeat
the above choosing another scan range.” 3\

If the sample fails to be analyzed, examine the Raw Data. @&to highlight the sample
under the Sample File column theAnalysis Control windov%n go the Sample tool
bar and choose Raw DataAlternatively, click and highli {Qa sample and hit Ctrl+R or

double click on a sample and click on th? aw data ol on the bottom left hand side of

the Raw Datawindow that pops up. If thef€)is no nce of size standard peaks, the

sample fails. Note on the editing she {hat thi ple needs to be rerun. If peaks are
present take the following steps.

Raw Data Window: @ O
v\ O
B 07-LseStandariGRGOINEEEEY M & 12-LizSizeStandard11_D02_008fsa =101 x|
500 1000 1500 2000 2500 3000 3500 4000 4600 5000 5500 ennn 6500 TDﬂD 7500 SDﬂD \ Qn sm mm 1500 mnn 2500 ann an 4nnn ?Gnn ,ﬁmn Iﬁsnn ‘Bnm ‘Bsm ‘mm ‘7500 ‘Bnm ‘Bsm )
18000 | O 12000 _
16000 _| 16000 _|
. Good Raw D@ Bad Raw Data
12000 | 12000 |
10000 |
8000 _|
6000 _|
4000 |
il
[
W7 SEEmE: v
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1. Check the height of the size standard

a.

C.

2. Change the analysis parameters 6

a.
b.
C.

.\‘r
@)
QO

e.

Examine theRaw Datato check the peak height of the size standard
fragments. The peak height is indicated by the datapoint value_of the Y
located on the bottom of the Raw Data window, when the ¢ is placed
on top of the peak. See instructions and diagram above. U;\

In the Analysis Control window under th&arameter c&&klick and
highlight the parameter of the sample that needs justed and click
the small arrov@ on the right side of the cell and\@ct the predefi
parameter E1ZAnalysisParameterOrange25”.

N

Reanalyze samples. There should bean#he size standard column.

It is also possible, @ run @either to fast or to slow. The analysis

range may need tgb han xamine the Raw Data to see the scan
range. See i St‘{ fons lagram above.

Observe wher thes{ Ize standard is located in the sample by moving
the cursor to the . Take note of the datapoint value of ibeaked

on the bottom \ Raw Dataindow.

From t A@}I&,is Control windowgo to theParameter column, click

and hi%\t the parameter that needs to be adjusted and click on the
sm rrow/>on the right side of the cell and selecffibe New.

here an untitlecgnalysis parameter window will appear. Make sure
the default settings are correct as indicated above. WAmddysis
Range adjust the stantalue to approximately 25 bp less than the
datapoint value of the As indicated in step 2b. (eg. X:2400 adjust Start:
2375)

Exit out of the window by hittinfy X and click Save. Save the file in the
folder C:\AppliedBio\Shared\Analysis\Sizecaller\Paramsghat can only
be accessed through the desktop shortcut AppliedBio folder.
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NOTE: For Identifiler, if the last two orange size standard

Reanalyze samples. There should bean#he size standard column.

After reanalyzing the samples go back to the Parameter folder and drag the
parameter you created to the Archive Parameter Folddihe default
predefined analysis parameters indicated above should be t;\ y choice
in the drop down menu. Q

nd 500, are not
visible, change the size call range to “this range’, Sh* djust the
maximum to 450. At least the 100 bp to 450 b @e standards must be

apparent.
3. If the baseline of the size standard is noisy, raisthe RFU threshold of the red or
orange to above the noise level. 6 \
a. Alternatively, redefine @ze t ‘dIn theAnalysis Control
window under the Si’c\ anda n click and highlight the size
standard of the sa@. CI@ the small ar@mn the right side of the
cell and select DQ Ne e size standard peaks will appear and at the
appropriate p% typqgc)abel in the column (see above for correct
values). \
NOTE: For Id &g(?r LIZ runs do not define the 250 bp and the
340bp size s&ards.
b.

O
O
QQ'

by hithi and clickSave. Save the size standard file in the folder
C&%IiedBio\Shared\AnaIysis\SizecaIIer\SizeStandardEhat can only
ccessed through the desktop shortcut AppliedBio folder. Name the
ize standard whatever you wish. Select this size standard for the analysis
of all the failed samples.

When y@@are done defining the new size standard, exit out of the window

Reanalyze samples. There should bean4he size standard column
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d. After reanalyzing the samples go back to the SizeStandalcter and
drag the size standard you created to the Archive SizeStandards Folder
The default predefined size standards indicated above should be the only
choice in the drop down menu.

ATTENTION: all reanalysis results and parameter changes are automatic (ken
to the individual sample files, even if the changes to the project a saved.
Do not reanalyze casework data without a reason.

Revision History:
March 24, 2010 — Initial version of procedure.
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For 3130d instruments, multiple sets of amplifications can be run in one tray. If the
amplifications were done in different multiplex systems, it is necessary to perform the Genotyper
analysis separately using the appropriate template. For two amplifications in the same system it
is optional to process them together or separately.

l. YM1 '\(1/

Q
,\\‘1/

1. Open the Genotyper macro for the desired am I@on system by
clicking on the appropriate Genotyper shortcu@ he desktop of the

analysis station computer.

A. Importing Data and Allele Call Assignment

no

UnderFile>Import and selecFrom Geggh&an File If the Current

Runs folder does not alrea ppear@, e window, scroll to find it from
the pull-down menu an @lble lﬁkx n it. Double-click on the folder
containing the projec wai&a ed in GeneScan.

Click Add or do$ lick e project icon to add the project for

w

analysis. Wh e as been added, Eliukh.

B

Under View)Shonye/Lanes windowa list of the samples imported
from GeneSc ﬁ ysis can be seen. If samples need to be removed,
highlight the&& for these samples and selectfi©ut the Editmenu.

o

Under‘F(ejSave As save the Genotyper template to the user’s initials
and tkg'casework run file name. (Undéle select Save As)

&example: “Stars09-001Y JLS” for YM1 runs saved by “JLS.”

%)0 After importing the project and saving the Genotyper file, run the first
O Macro by pressing Ctrl+1 or double clickinkgzam'.

Q 7. The plot window will appear automatically when the macro is completed.
Check the results for the positive control. The plots will also display the
orange size standard.
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Table 1
Multiplex System Necessary LI1Z GS500 standard
peaks
YM1 9 fragments from 139-400 bp (1/
Table 2 YM1 Positive Control \(1/
DYS19 DYS389 | DYS389 | 'Q
Yellow label | 14 13 29 ON
DYS390 r\\-
Blue label 24 g
O
1 Yellow male positive control 6 \'
DYS19 DYS389I @ @

\ 6\0 DYS389ll AA

< , 368.55
1Blue male positive contro\

$

)

4
B

8. ﬁout an STR 3130 Control Review Worksheet indicating the status of
controls.

&) Under Analysi®Change labels, select size in bp, peak height and
Q cakegory name. Click Ok.
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10. Check all lanes. Labels for extra peaks can be manually deleted by
placing the cursor on the peak above the baseline and clicking.

Shortcut: If a label was mistakenly deleted, press Ctrlaidd the
allele name label will reappear. Ctrl+Z will only undo the Ias;\
action.

click down and draw a box around the desired r

Q

12. Under View>Zoom->Zoom In (selected arezﬁ\

11. To zoom into a desired region of an eIectrophe;o@\Nold the left mouse

Shortcut: Zoom in by holding down th @nouse click button
and dragging the cursor a the 0 zoom in on. Then, press
Ctrl+R or Ctrl+ + to zo@on t io

13. To revert to the ¢ sca ﬁge, gditov—>Zoom »>Zoom To. Set
the plot range tm& list bl able 3.Click OK.

Table 3 E . C)
System ange
YM1 % 120 - 410

4

Compa@@orange electropherograms with the other color lanes by:

a. ’\holding down the shift key and clicking on the orange “O” box in
Qothe upper left hand corner

0& under edigo to select +orange

&2 Fill out the Genotyper Editing Sheet for each Electrophoresis run
Q indicating the following:

a. no editing required
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b. sample(s) requiring manual removal of non allelic peaks. Refer to

STR Results Interpretation Section.

C. sample(s) requiring rerun and/or re-injection. Referto STR
Results Interpretation Section

Each sample listed on the Genotyper Editing Sheet mu ndlcated by
sample number. The reason for the edit must be indic ?ad'usmg a number
code and/or symbol.

15. After the editing has been finished, scroll thro@\(he plot window to
double-check.

N
B. Genotyper Table 6 (5,\'0

1. Press Gt+2 to creat 6\(\
2. Compare the saggﬂe inf |on in the table with the amplification and
rol

the 313& run / If an error is detected at this point it can be
corrected as fo lows:

a. Open th@@/lame window or “sample info box”

b. P e cursor in the sample info box and correct the text

X Under Main Ment>Analysis, select Clear Table to clear table

Select the appropriate colors by shift clicking on the dye buttons or
using edit.

C) e. Run Create Table Macragain

Q f. Continue to Step 4 and print according to the directions.
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C. Viewing and Printing Electropherograms
1. Controls

a. Under View-bye Lane Window and selectud and yeI@
all lanes containing controls including microcon co

b. To select multiple labels, press Ctrl while CIicFi\l’{\n the lanes

C. Go to Viewand open the Plot Window \Q

d. Under Analysis>» Change Labels and Jucgsze in bpand
category name

N
O
Click ok. Save. 6 é,\'
O .Q
e. Continue to S @Xl and @\ the controls according to the
directions. \é K

2. Evidence Sa%o C)OO

a. Under Vie@ye LaneWindow and select blue and yellow for
all lane ining casework samples

b. @% multiple labels, press Ctrl while clicking on the lanes
C. \Go to Viewand open the Plot Window

Under Analysis>Change Labels and selct size in bp, peak
height and @tegory name Click ok. Save.

OCJ e. Continue to Step 4 and print according to the directions.

Q 3. Exemplar Samples

a. Under View-Dye Lane Window and select dwand yellow for
all lanes containing casework samples
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b. To select multiple labels, press Ctrl while clicking on the lanes
C. Go to Viewand open the Plot Window

d. Under Analysis>Change Labels and dect sze in bp am

category name Click ok Save. Q
f. Continue to Step 4 and print according to the Qﬁ%ns.
2. Printing Electropherograms \Q
a. Make sure the file is named properly,'hxc ding initials.

b. Set Plot window zo%range ag @&Wﬂ in Table 4. The active

window will be prin 0 ope le or Plot as needed.

c.  Under File> P’QA) Pro % butto® Finishing tab>
Document,ghe P ers below.
rs:

Table 4 YMlﬁ paran]
) )

N Table Plot
Orientation \3 Portrait Portrait
Scale r\(\ 100% 2 per page 100% 2 per page
Zoo@\él n/a 120 - 410

bﬁ: The Genotyper printout for YM1 should have a standard format:

yellow lanes, then blue lanes. The table should have 2 columns
0@ for each locus. The controls are not needed in the table.

0 d. Click OK, OK.

c e. After the printing is finished, undigle, quit Genotyper. Click
save Make sure that the Genotyper file is saved in the
appropriatesCommon runs folder.
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f. Initial all Genotyper pages.
g. List rerun samples on the rerun sheet

h. Place rerun samples into the designated rerun crybo>i\(1/

I. Have a supervisor review the analyzed run

J- For Troubleshooting see the last Section &U lex Kit

Toubleshooting \
NO

I. Identifiler, 28 Cycles for High Copy Number

A.  Importing data and allele call as@nent N
1. Open the Identifiler ? “f;acro @4 king on the Genotyper shortcut on the

desktop of the an I8 stati mputer.

2. Unden:ileélr@ arg:chFrom GeneScan File If the Current
Runs folder does not ady appear in the window, scroll to find it from
the pull-down me d double-click on it. Double-click on the folder
containing the& t that was created in GeneScan.

3. ClickA uble-click on the project icon to add the project for
analysi en the project has been added, Eliukh.

4, U \/iew)Show Dye/Lanes window, a $it of the samples imported
GeneScan analysis can be seen. If samples need to be removed,
ghlight the lanes for these samples and selectfi©uat the Editmenu.

OE) After importing the project and saving the Genotyper file, run the first
Q Macro by pressin@rtl+9, or double click thdD 28: Identifiler 28
macro

6. UnderFile->Save As, save the Genotyper template as the casework run
file and initials. For example: “Kastle09-108ID JLS”
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7. The plot window will appear automatically when the macro is completed.

Check to make sure that the ladders match the allele sequence shown

below. Also check the results for the positive control. The plots will
display the orange size standard.

TABLE 5 IDENTIFILER™ POSITIVE CONTROL

NV

N
DES1179| D21511 | D7S820 | CSFLPQ()
Blue (6-FAM) | 13 30 10,11 | 10,8
’ sy
D3S1358| THO1 | D13S317 @{9339 D251338
Green(ViC) [14,15 | 893 | 11 NM112 | 1923
D19S433| VWA T@ D18S51
Yellow (NED) | 14, 15 618 I 15, 19
N
AMEL=\D5S838\Y FGA
A‘\‘ V
Red (PET) | XC 1\ | 23,24
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IDENTIFILER™ ALLELIC LADDER

0135317 0165539

THLNL Y
N 'é'ﬁ“{@\ P

0351358

T' _1

1000

0195433

|

ElwliEe]n
o] [2][14] [1e]
[i22] [152

1000

Amelagenin D52E818 L

amm (18] [20] [22] [24] [2¢] [28] [29) 22

" 51 22
o)

FGA

1000

C§S§

Table 6
O Multiplex System Necessary LIZ GS500 standard peaks
Q Identifiler™ 12 fragments from 75 - 450 bp
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8. Fill out an STR 3134 Control Review Worksheet indicating the status of
all controls.

9. Under Analysis» Change labels, select size in bp, peak height and
caegory name. Click Ok. '\

10. Check all lanes. Labels for extra peaks can be manua ted by
placing the cursor on the peak above the baseline aF{\ﬁl ing.

Shortcut: If a label is mistakenly deleted, press d the allele
name label will reappear. Ctrl+Z will only und last action.

11. To zoom into a desired region of an elect®©pherogram, hold the left mouse
click down draw a box aroubdthe des@ gion.

12. Under View>Zoom, sek&@oom lQ@ected area)
Wil

Shortcut: Zoom in@oldin& n the left mouse click button and
dragging the cu cro area to zoom in on. Then, press Ctrl+R or
Ctrl + + to zo o@egion. To zoom out in a stepwise fashion,
press Ctrl+-. \

13. To revert to thK}n ect scan range, go to ¥ wom ->Zoom To. Set
the plot rangQﬂ ge listed in Table 7.Click OK.

Table '(:)CD
Systém Range
ﬁ‘mner 90- 370

J
0®ompare the orange electropherograms with the other color lanes by

either:

QO a. holding down the shift key and clicking on the orange “O” box in
the upper left hand corner

b. under edigo to select +orange
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14. Fill out the Genotyper Editing Sheet for each Electrophoresis run to
indicate the following:

a. no editing required '\(1/

b. sample(s) requiring manual removal of non allelj ks. Referto
STR Results Interpretation Section. '\\

C. sample(s) requiring rerun and/or re-inject@Refer to STR
Results Interpretation Section.

Each sample listed on the Genot r Edltlng Sheet must be
indicated by sample gumber. ason for the edit must be
indicated using a n r co /or symbol.

15. After the editing has‘b{én flnls® scroll through the plot window to
double-check. \Q OK

B. Viewing and Prmtmg?&tro@ﬁrams

1. Controls
a. Under \'ga ye Lane Window and selectud, green, yellow,
red anQQ nge for all lanes containing the allelic ladder.

b. G)elect multiple labels, press Ctrl while clicking on the lanes
CQQ Go to Viewand open the Plot Window
@ Under Analysis>» Change Labels and selct sze in bp and
00 category name

QO Click ok. Save.

e. Repeat steps l1a - ¢ for all lanes containing controls including
microcon controls
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f. To select multiple labels, press Ctrl while clicking on the lanes
g. Go to Viewand open the Plot Window

h. Under Analysi»Change Labels and dect sze in bp, p KQ/
height and @tegory name Click ok. Save. &

g. Continue to Step 3 and print the controls acc &(}/{o the
directions. ?\

2. Evidence and Exemplar Samples Q\

a. Under View-bye Lane Window an% elect ldugreen, yellow,
red and orange for a&nes co g casework samples

b. To select multlp&@bel Ctrl while clicking on the lanes
C. Go to Vie pen ot Window
d. Under@yﬁgﬁwge Labels and dect sze in bp, peak
height ahd name. Click ok Save.
e. Contmq@ tep 3 and print according to the directions.
3. Printing El %pherograms

\Make sure the file is named properly, including initials.

Set Plot window zoom range as shown in Table 8. The active
0 window will be printed so open Table or Plot as needed.

QO
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C. Under File> Print - Properties buttof Finishing tal»>
Document, set the parameters below.

Table 8 Identifiler Print parameters:

Plot | y\(l/

Orientation Portrait (1/
100% 2 per page \

Scale ?\
Zoom range 90 - 370 g

d. Click OK, OK.

e. After the printing is |shed that all alleles in the ladder,
controls and samp, e la Manually enter the base pair size
if necessary an

f. Under file eno r. Cllclsave Make sure the Genotyper
file i |s rlaGDmmon runs folder.

Initial al Ge?&gg)er pages.

Q

List rerl}é’samples on the rerun sheet

=

@@erun samples into the designated rerun crybox
\Have a supervisor review the analyzed run

'
@ For Troubleshooting see Section V- Multiplex Kit

§ Troubleshooting

C. &énotyper Tables for Identifiler 28 samples

1. Genotyper Table

a. Select all relevant samples in the main window
b. Under Analysis, Clear table
C. Under Analysis: Change Labels select category name
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d. Under Table» Set up table. Labels —Options

e. Set the number of peaks per category to “6”. Next to “Text if >N”,
click on “Options”. Set the number of peaks to “6” text
to “Overflow” a’K

f. Click OK. Under Table. Append to table. Sav;.\\(ll

g. Click on the table window panel view. Q\Q

h. Under Edi® Select All, Copy. '\

2. I dentifiler 28 Profile Gener%n \9
a.  Goto M:\FBlQLS?_ @&QMS\STRS\D 28 Profile
Generation I&Q@ nd{ Into the Instructions tab. .
b. Refer to Q pecifi tructions on the first tab of that workbook
for cre% of the file table.

C. Save ID Zﬁhfile Generation table as casework run name and
initials. %{1 and store with the electropherogram.

3. The ta @Sbe saved in the appropriate folder containing the raw data
and th eScan project.

4. I@Qa supervisor review the analyzed run.

5.0 or Troubleshootingsee Section V- Multiplex Kit Troubleshooting
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IIl.  Identifiler — High Sensitivity Testing

A. Importing data and allele call assignment

1. Open the HS Identifiler 10% Macro by clicking on the Genot&{e};hortcut
on the desktop of the analysis station computer.

2. UnderFile->Import and selecErom GeneScan File If t %rrent
Runs folder does not already appear in the windo Il to find it from
the pull-down menu and double-click on it. Dou ick on the folder
containing the project that was created in Gen n.

3. Click Add or double-click on the project icdn to add the project for
analysis. When the projectgs been @ , Eliukh.

4, Under View> Show Dye es wi , adt of the samples that were
imported from Gene analysis\can be seen. If samples need to be
removed, highlighttheMane ese samples and seledtduthe
Edit menu. K

5.

QO

Macro by pressin 9, or double click the following according to the

After importingthe§r@t and saving the Genotyper file, run the first

macro: 56
a. I %entifiler 28
&)ﬂ@

b. \I'D 31: HS ldentifiler 10%.

6. 6@lﬁeﬂ:ile—)&ewe As save the Genotyper template as the plate record, the
n

60

folder and injection parameter. For example: Venus042507_25L.

The plot window will appear automatically when the macro is completed.
Check to make sure that the ladders match the allele sequence shown
below. Also check the results for the positive control. The plots will also
display the orange size standard.
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TABLE 9 IDENTIFILER™ POSITIVE CONTROL

D8S1179 | D21S11 | D7S820 | CSF1PO
Blue (6-FAM) | 13 30 10,11 | 10,12 "
D3S1358| THO1 | D13S317| D16S539 D};&;@k
Green (VIC) |14,15 | 893 | 11 11, 12‘(\\),'23
D19S433| VWA | TPOX D1§§5\\ v
Yellow (NED) |14,15 | 17,18 | 8 @9
AMEL |D5S818 | FGA r\ )
Red (PET) X 11 23, 24

DEs1179 @15100 D¥s820 CSF1PO
l K s
{0

1A
- £ L, __I'.,,._,IL

Bl K@) Bl o 9
D351358 THHQ\' D135317 D165539 D251338

o 2
; | Q \ 1 I| | i | Lo

't'a o \ affcz] G i "L*'ﬂ"é; = &8 B
D19S433 @Q VA TPOX D18%451 ”
Foog
TR S — s

ﬂmé = D55818 = FGA
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8. Fill out an STR 3134 Control Review Worksheet indicating the status of

10.

11.

12.

13.

>
O
QO

all controls.

Under Analysis» Changelabels, select size in bp, peak height and
caegory name. Click Ok. '\(1/

Check all lanes. Labels for extra peaks can be manuam ted by

placing the cursor on the peak above the baseline aF{\ﬁl ing.
Shortcut: If a label was mistakenly deleted, pres a#d the
allele name label will reappear. Ctrl+Z will onl o the last
action.

For samples that need to be viewed i @cate by color (31 cycles only)
under Views>Dye Lane S %g the fj xrecedence should be set to
Dye Color and the sch File\ e, both in ascending order.

To zoom into a d(ib@ regi Qm electropherogram, hold the left mouse
click down draw. X ar the desired region.
Under View)ZEom\s@t Zoom In (selected area)

Shortcut: ZoorngﬁQ/ holding down the left mouse click button and
dragging the% or across the area to zoom in on. Then, press Ctrl+R or
Ctrl + Z@@) in on that region. To zoom out in a stepwise fashion,
press Girl

T ert to the correct scan range, go to ¥&eom ->Zoom To. Set
lot range toange listed in Table 11. Click OK

Table 11
System Range
Identifiler 90- 370
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Compare the orange electropherograms with the other color lanes by
either:

a. holding down the shift key and clicking on the orange “Q” box in
the upper left hand corner '\

b. under edigo to select +orange

15. Fill out the Genotyper Editing Sheet for each Ele(@resis run to

indicate the following:
N

b. sample(s) requiring manual reg@of non allelic peaks. Refer to

a. no editing required

STR Results Interprétation SqCHON.

C. sample(s) reql ren@ﬁdor re-injection. Referto STR
atio ion .

Results Int

Each sample?&i orgﬁenotyper Editing Sheet must be indicated by
e

sample numbet. The tedson for the edit must be indicated using a number
code and/or symb@

16. After the edi@has been finished, scroll through the plot window to

double-&)@

B. Viewing an&ﬁnnting Electropherograms

1. ®@htrols
0 a. Under View>Dye Lane Window and selectusd, green, yellow,
C) red and orange for all lanes containing the allelic ladder.

Q b. To select multiple labels, press Ctrl while clicking on the lanes

C. Go to Viewand open the Plot Window
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d. Under Analysis>Change Labels and dect sze in bp and
category name Click ok. Save.

e. Repeat steps 1a - ¢ for all lanes containing controls |nclud|ng
microcon controls

f. To select multiple labels, press Ctrl while chckm@we lanes
g. Go to Viewand open the Plot Window

h. Under Analysi®>Change Labels and e in bp, peak
height and @tegory name Click ok

g. Continue to Step 3 print ti@rols according to the
directions. %
am \<‘

2. Evidence and Exem
a. Under Vi ye Window and select ldugreen, yellow,
red an lanes containing casework samples
To select Ie labels, press Ctrl while clicking on the lanes

C. Go to@rﬂnd open the Plot Window

@

n Analysis> Change Labels and dect sze in bp, peak
helgh and ategory name. Click ok Save.

To print the electropherograms for 31 cycle samples, select each
sample (triplicates (a, b, ¢) and pooled (abc)) and sort by Dye
0 Color, then File Name. Each sample will have to be printed
C) separately. Follow steps 2a - d.

Q f. Continue to Step 3 and print according to the directions.
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3. Printing Electropherograms
a. Make sure the file is named properly, including initials.

b. Set Plot window zoom range as shown below. The l«/})/vindow
will be printed so open Table or Plot as needed. Qa&

Plot '\b(l/
Orientation Portrait EQ
Scale 100% 2 per pagg, '

A

Zoom range 90-370 L
>
C. Under File> P{i% ropeles butto* Finishing tabk>

Document, W par rs above.

d. CIick%\,‘&e '®)

e. After the printingris finished, ensure that all alleles in the ladder,

controls mples are labeled. Manually enter the base pair size
if neces and initial and date.

N

f. :@)5 ile quit Genotyper. Cliclsave Make sure the Genotyper
J5 saved in the appropria@mmon runs folder.

QQQ Initial all Genotyper pages.

List rerun samples on the rerun sheet

OC) I. Place rerun samples into the designated rerun crybox
c J- Have a supervisor review the analyzed run
k. For Troubleshooting see Section V- Multiplex Kit

Troubleshooting
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C. Genotyper Tables

1. Identifiler 28 Profile Generation Table

a. Select all relevant samples in the main window '\(1/

b. Under Analysis. Clear table

C. Under Analysis» Change Labelsselect cate@‘}ﬂme

d. Under Table» Set up table- Labels -

e. Set the number of peaks per categqQry to “6”. Next to “Text if >N”,
click on “Options”. Set the num& f peaks to “6” and the text to
“Overflow” 6

f. Click OK. L@abli@end to table Save.
g. Click tﬁ ableq@ow panel view.

h. Under die% All, Copy.
2. Identifiler 31 F*téﬂe Generation Table
a. EB@ that all relevant samples are selected in the main window

b. Q’\Under Analysis» Clear table

2

& Under Analysis» Change Labels ensure only “category name” is
0 selected
0 d

Qo

Under Table» Set up table- Labels— Options
Set the number of peaks per category to “6”. Next to “Text if >N”,

click on “Options”. Set the number of peaks to “6” and the text to
“Overflow”

f. OK - OK - Table - Append to table
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g. View - Show Table Window

h. Edit - Select All- Edit - Copy

2. Open the Profile Generation spreadsheet macro found in
HIGHSENS\TEMPLATES IN USE\ANALYSIS\ID31 Profil@v ration

Sheet-STR. Click Don’t Update

3. Paste into cell A12 of “extra sheet” and delete rm@%n\aining the Allelic

Ladders. Q\

a. Starting at row 12, ensure that samp'&.are in the following order:

i: Sample info an%oci na(rré\'é

ii. Positive cont&)
iii. ~ Amp Negati * (\

iv. Extracti \&ati\@ld Microcon negatives (triple amps)

v. Samp gin Ja¥oW 25 (triple amp plus pooled).

vi. S mQ ripliﬁpand pooled samples should be consecutive.

b. Two rows are to-de skipped between each sample (three between
each contrérserted after row 25). Insert or delete rows if
necess

kipped, and the second sample is in rows 31-34, and so on.

If@@a%ple: the first sample is in row 25-28, then rows 29 and 30
e

C QAIternatively, sample info may be copy and pasted directly into the
@ appropriate rows in the “Copy Geno Triple” sheet of the Excel

0@ workbook.
&) Compilation of triple amplifications
Q a. On the “extra sheet”, Editselect all- copy
b. Paste into cell Al of the copy geno triple sheet. (The geno db

sheet is for double amplifications that would not be utilized for
casework.)

Controlled versions of Department of Forensic Biology Manuals only exist electronically on the
Forensic Biology network. All printed versions are non-controlled copies.



FORENSIC BIOLOGY PROTOCOLS FOR FORENSIC STR ANALYSIS

IDENTIFILER ™ AND YM1 — GENOTYPER ANALYSIS

DATE EFFECTIVE APPROVED BY PAGE
03-24-2010 EUGENE LIEN 25 OF 36
5. “NIKE” macros to filter and sort
a. Macro 4: Select the control and the “n” keys to filter sample
sheets 1-14.

b. Macro 4b: Select the control and the “i” keys to fil Q(Ie
sheets 15-29.

C. Profiles macro: Select the control and the p Qs to sort sample
sheets 1-14.

d. ProfilesB macro: Select the control a Q e” keys to sort sample

sheets 15-29. K
xO

6. Arrow to the right to the @chan. (b,
a. Each ampligc;ﬁé repli &shown in the white rows, and the
ite

composit e copfajinihg alleles that repeat in two of the three
amplifical.'QCé isin ow below the 3 amplifications.

b. The podled i jgﬁ%n is located beneath the composite profile.

C. Loci wikj(iq@e than 6 alleles will not be accurately reflected.
Howeq\ he word “overflow” will appear in the cell as a signal to
C @ e alleles on the electropherogram. Additional alleles may
@anually entered into the cell.

d. Q Print and store table with the electropherogram.

<

7. @he table must be saved in the appropriate folder containing the raw data
00 and the GeneScan project.

QQ Have a supervisor review the analyzed run.

9. For Troubleshootingsee Section V- Multiplex Kit Troubleshooting
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IV.  Re-injection Guidelines — YM1
A. YM1 Controls

1. Refer to the following procedure sin this manual before maWemsmn
to rerun/re-inject a control:

a. Genotyper Analysis Section Wultiplex Kit Tr?\{%hootlng

b. STR Results Interpretion Section V — Inte@atlon of Controls

2. If a complete injection fails, rerun with the sz!h\ %arameters

3. Rerun/ re-inject normal if t!gollowmg@ﬁes
a. Positive Contro @9
SN

b. Amplificati gaﬂ@{
C. Extrac?&\l @Pans

d. No size s{@ﬁrd

NOTE: All r@rs/ re-injections must be accompanied by a passing

(@ e control.

B. YM1 SampPgs'

1. @ normal if the following applies:

a. No orange size standard

QO b. New allele/Off-ladder allele

C. Overamplified single source samples (rfus >6000) with plateau
shaped or misshaped peaks, numerous labeled stutter peaks and
artifacts — remove all peaks and rerun with a dilution

Controlled versions of Department of Forensic Biology Manuals only exist electronically on the
Forensic Biology network. All printed versions are non-controlled copies.



FORENSIC BIOLOGY PROTOCOLS FOR FORENSIC STR ANALYSIS

IDENTIFILER ™ AND YM1 — GENOTYPER ANALYSIS

DATE EFFECTIVE APPROVED BY PAGE
03-24-2010 EUGENE LIEN 27 OF 36
d. Overamplified mixed samples (rfus >6000) — remove all peaks and

rerun with a dilution
2. Rerun with high parameters if there are peaks below threshold

NOTE: All reruns/ re-injections must be accompanied by@&s ing

positive control. (1/

V. Re-injection Guidelines — Identifiler, 28 Cycles Q'\
A. Identifiler 28 Controls Q\
1. Refer to the following sections before mal@g a decision to rerun/ re-inject

a control: 6 \O

a. Genotyper Analysis&@ion M\Q@ex Kit Troubleshooting
o <0
b. STR Results Ir@etio on V — Interpretation of Controls

2. If a complete?&tiorep rerun with the same parameters.
3. Rerun/ re-inject n | if the following applies:

a. Posit@)ntrol fails

b. mplification Negative fails

C.QQ’\TExtraction Negative fails

0& No size standard

C) NOTE: All reruns/ re-injections must be accompanied by a passing

QO positive control.
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B. Identifiler 28 Samples
1. Rerun normal if the following applies:
a. No orange size standard (1/
b.  New allele/ Off ladder allele Q\

C. Overamplified single source samples (rfus >70@ith plateau
shaped or misshaped peaks with numerou Jbe d stutter peaks
and artifacts — remove all peak and run w dilution

d. Overamplified mixed samples (rfus > —remove all peaks and
run with a dilution or follow steps in§ection 3 below.

2. Samples may be rerun @on t roved High Sensitivity CEs or
samples may be inject&thhigh se instruments initially if appropriate

a. All releva@ntro@st be re-injected at the high parameter

b. For mixed s mge& at these parameters, overblown peaks (>7000
RFUs) as s peaks from loci within the same basepair range in
the oth rs should be removed and deemed inconclusive.
Howegs ata from the other loci should be retained. Data from
b Jections may be used for interpretation. For consistency,

nfirm that the injections at different parameters generate

Qverlapping loci.
V. Re-injectio&@elines — Identifiler, 31 Cycles

A. @ iler 31 Controls

QQ Refer to the following sections before making a decision to rerun/ re-inject
a control:

a. Genotyper Analysis Section Wultiplex Kit Troubleshooting

b. STR Results Interpretation Section V — Interpretation of Controls
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2. If a complete injection fails, rerun with the same parameters.
3. Rerun/ re-inject normal if the following applies:
a. Positive Control fails '\(1/
b. Amplification Negative fails
W

C. Extraction Negative fails Q'\
d. No size standard Q\

NOTE: For reruns that are lower than th original injection, only a
positive control muBbe re-inj .

B. Identifiler 31 Samples

\
1. Rerun at the sam ctlortgqgneters if the following applies:

No or% zepdard

New aIIeIe ladder allele

2. Samples ma@'rerun with higher parameters if peaks are below threshold
[

nitially injected at a high parameter if appropriate

Samplegev@
NOTK'V | controls must be re-injected for all rerun conditions that are at
a r parameter

3. run at a lower injection parameter and/or with a dilution if the following

00 applies

shaped or misshaped peaks with numerous labeled stutter peaks

QO a. Overamplified single source samples (rfus >7000) with plateau

and artifacts
b. Overamplified mixed samples (rfus >7000)
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4. For Mixed samples run at more than one injection parameter or

concentration

a. Remove overblown peaks (>7000 RFUs) as well as peaks from
loci within the same basepair range in the other colors and deem
these loci inconclusive. (1/

b. Retain data from the other loci. '\

C. Data from both injections may be used for interp n. For
consistency, confirm that the injections at diff réQt rameters
generate overlapping loci. $\

VI.  Troubleshooting '\Q\Q

A. Genotyper Macro 1 produces an error message Qat reads: “Could not complete
your request because no dye/lane&re sele

1. Make sure the Iadde[ v@npos@@m the project.

Solution: If the lad as nafNimrported into the project, import the ladder
and rerun the m : O

2. Check the speﬁing f der” and the sample information in the
dye/lanes Windowo

Solution: Sp@brrectly and/or correct sample information. Then, rerun
the macgo.Q)

B. Genotyper Mé'cro 1 produces an error message that f€dd not complete
your req& ecause the labeled peak could not be found”.

This@sage indicates that the ladder cannot be matched to the defined
egories. There are three possibilities:
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1. There may be peaks in the ladder that are too low to be recognized by the
program.

Solution: Two options:

a. One: If another ladder in the run is more intense, a@r elete
the name of the first ladder in the Genotyper Dy window.
Then, rerurMacro 1. Now the macro will use é\ backup
ladder for the off-set calculation. \

b. Two: The minimum peak heightcan b @(ed for the off-set in
the categories window by: (;\

I. Under Vlew ow Cat @s Window In the “offset”

categories t t alle defined with a scaled peak

height of he high value is meant to
ter

elimin ackground

il. th| for the 313y clicking on the first
gor highlights.

Int talogue box locate the Minimum Peak Heigamd
o}éQ it to the appropriate value.

lick Add, and then click Replacerhen given the option.
This must be done for each locus. Do not use values less
\ than the instrument threshold.

@ DO NOT CHANGE THE MINIMUM PEAK HEIGHT
@ FOR ANY OTHER CATEGORY EXCEPT THE OFF-
D SET.
O After the macro is rerun, make sure the ladder begins with the
Q correct allele and that the first allele is not assigned to a stutter
which might precede the first peak.

Controlled versions of Department of Forensic Biology Manuals only exist electronically on the
Forensic Biology network. All printed versions are non-controlled copies.



FORENSIC BIOLOGY PROTOCOLS FOR FORENSIC STR ANALYSIS

IDENTIFILER ™ AND YM1 — GENOTYPER ANALYSIS

DATE EFFECTIVE APPROVED BY PAGE
03-24-2010 EUGENE LIEN 32 OF 36
2. The first ladder peak of each locus is outside of the pre-defined size range
window.

Solution: Expand the search window in the categories window by:

I. Under View- Show Categories Window. In the “off ({1/
categories the first allele is defined with a certairys@«/- 7bp.

il. Change the 7 to 10 or higher, by clicking o I%q\‘hst category
which highlights it. @

iii. In the dialogue box locate, the +/- bo@change the value

V. Click Add, and then elick Repla@sn given the option.

V. This can be dgra@ ea #\ that gave the error message.

N\
3. There are no pealé;@all in&x f the allelic ladders.
Solution: Re@l S@BQ with freshly prepared Allelic Ladders.

C.  Off Ladder (OL) a||e|e\r€}gas

1. A run wj @Qge number of samples may have a high incidence of OL
allele labels toward the end of the run. This is due to a shift during the

runé\'
tion: Try to reanalyze the run by using the second allelic ladder as
0 e off-set reference by:

C) I. removing the word “ladder” from the name of the first ladder in the

QO dye lane window.
il. This ladder will not be recognized by the macro program

iii. Rerun Macro l1and evaluate the results
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iv. Determine which one of both allelic ladders causes fewer “OL

D.

allele?” labels.

V. Complete the Genotyping process using this ladder. An
remaining samples displaying OL alleles have to be rféﬁ,

2. If all or most of the samples have “OL allele?” labels, it e that the
samples were automatically analyzed with an iII-deﬁ;\ e standard.

Solution: Redefine the size standard (see Gene\% analysis fot)3130
Reanalyze the run

Incorrect positive control type

The Genotyper has shifted aIIeI@qtlons g the category assignment to the
ladder.

Ensure that a sample m| id n@g

Check the ladder an@ke Q?e first assigned allele is assigned to the first real
peak and not to a stutter peaks=tvhich may precede it. If the stutter peak is
designated with the first name, the peak height must be raised in the
categories window in& to force the software to skip the stutter peak and start

with proper allele. Q

1. Detern@Cth)e height of the stutter peak by placing the cursor on the peak
in question (as if editing).

2. Information displayed on the top of the window refers to the peak
ere the cursor is located and contains the peak height. Make a note of
the peak height.

QQ» Under View- Show Categories Windowand highlight the first allele in

the offset category (e.g., 18 0.s.) of the polymorphism that needs to be
corrected.

4, In the dialogue box change the height for the minimum peak height to a
few points above the determined height of the stutter.
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5. Rerun the macro and then check to make sure everything is correct by

looking at the first allele in each locus in the ladder and by comparing the
result for the positive control.

E. Lining up unlabeled peaks '\(1/

1. In order to place samples next to each other for compag %urposes,
mark them by double clicking. i/

2. A black bullet appears in front of the lane numbé@

3. If this happens accidentally, a lane can be uﬁ& ked by either double
clicking on it again or, under Edit unmark K

4. To be able to align an unl éed aII th a labeled allele in the same

run, you must selectV ie
NOTE: Unsized peaks C \@ g according to size on the

electropherogram. omparing an unlabeled allele (unlabeled
because it is too Iow e &@ ut high enough to be detected visually) to a
r

labeled allele (e.qg., 